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PREFACE

This Preface provides supporting information for the Oracle Insurance Performance Insight Application Pack 
Installation Guide and includes the following topics:

• Summary

• Audience

• Documentation Accessibility

• Related Documents

• Conventions

Summary

You can find the latest copy of this document in OHC library which includes all the recent additions/revisions (if 
any) done till date.

Before you begin the installation, ensure that you have an access to the Oracle Support Portal with the required 
login credentials to quickly notify us of any issues at any stage. You can obtain the login credentials by contacting 
Oracle Support.

Audience

The Oracle Financial Services Analytical Applications (OFSAA) Oracle Insurance Performance Insight pack 
Installation and Configuration Guide is intended for Administrators, Business User, Strategists, and Data 
Analyst, who are responsible for installing and maintaining the application pack components. 

The document assumes you have experience in installing Enterprise components. Basic knowledge about the 
Oracle Insurance Performance Insight pack components, OFSAA Architecture, UNIX commands, Database 
concepts and Web Server/ Web Application Server is recommended.

Following are the expected preparations from the administrator before starting the actual installation:

• Awareness of the OFSAA Tier Architecture. For more information, see the Application Tiers section.

• Decision on the appropriate OFSAA Deployment Option. For more information, see the Recommended 
Deployment Options section.
Oracle Insurance Performance Insight Application Pack Installation and Configuration Guide - 8.0.7.0.0 1
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Related Documents

This section identifies additional documents related to OFSAA Infrastructure. You can access Oracle 
documentation online from Oracle Help Center (OHC).

• Oracle Insurance Performance Insight User Guide

Conventions

The following text conventions are used in this guide:

Abbreviations

Convention Meaning

boldface Boldface type indicates graphical user interface elements 
associated with an action, or terms defined in text or the 
glossary.

italic Italic type indicates book titles, emphasis, folder paths, or 
placeholder variables for which you supply particular values.

monospace monospace indicates commands within a paragraph, URLs, 
code in examples, text that appears on the screen, or text that 
you enter.

Filenames filenames indicate the file names within a pragraph.

Hyperlink Hyperlinks indicate the cross-references, external document 
links, and external website links.

Abbreviation Meaning

AIX Advanced Interactive eXecutive

BDP Big Data Processing

DBA Database Administrator

DDL Data Definition Language

DEFQ Data Entry Forms and Queries

DML Data Manipulation Language

EAR Enterprise Archive

EJB Enterprise JavaBean

ERM Enterprise Resource Management

FTP File Transfer Protocol

GUI Graphical User Interface
Oracle Insurance Performance Insight Application Pack Installation and Configuration Guide - 8.0.7.0.0 2
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HDFS Hadoop Distributed File System

HTTPS Hypertext Transfer Protocol Secure

J2C J2EE Connector

J2EE Java 2 Enterprise Edition

JDBC Java Database Connectivity

JDK Java Development Kit

JNDI Java Naming and Directory Interface

JRE Java Runtime Environment

JVM Java Virtual Machine

LDAP Lightweight Directory Access Protocol

LHS Left Hand Side

MFA Multi-Factor Authentication

MOS My Oracle Support

OFSAAI Oracle Financial Services Analytical 
Application Infrastructure

OHC Oracle Help Center

OLAP On-Line Analytical Processing

OLH Oracle Loader for Hadoop

ORAAH Oracle R Advanced Analytics for 
Hadoop

OS Operating System

RAM Random Access Memory

RDBMS Relational Database Management 
System

SFTP Secure File Transfer Protocol

SID System Identifier

SSL Secure Sockets Layer

TDE Transparent Data Encryption

TNS Transparent Network Substrate

URL Uniform Resource Locator

Abbreviation Meaning
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VM Virtual Machine

WAR Web Archive

XML Extensible Markup Language

Abbreviation Meaning
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CHAPTER 1 – ABOUT OFSAA AND OFSAA APPLICATION PACKS
This chapter includes the following topics:

• About Oracle Financial Services Analytical Applications (OFSAA)

• About Oracle Financial Services Analytical Applications (OFSAA) Pack

• About Oracle Insurance Performance Insight (OIPI) Application Pack

• About Oracle Financial Services Analytical Applications Infrastructure (OFS AAI)

About Oracle Financial Services Analytical Applications (OFSAA)

In today's turbulent markets, financial institutions require a better understanding of their risk-return, while 
strengthening competitive advantage and enhancing long-term customer value. Oracle Financial Services 
Analytical Applications (OFSAA) enable financial institutions to measure and meet risk adjusted performance 
objectives, cultivate a risk management culture through transparency, lower the costs of compliance and 
regulation, and improve insight into customer behavior. 

OFSAA uses industry-leading analytical methods, shared data model and applications architecture to enable 
integrated risk management, performance management, customer insight, and compliance management. 
OFSAA actively incorporates risk into decision making, enables to achieve a consistent view of performance, 
promote a transparent risk management culture, and provide pervasive intelligence.

Oracle Financial Services Analytical Applications delivers a comprehensive, integrated suite of financial 
services analytical applications for both banking and insurance domain.

About Oracle Financial Services Analytical Applications (OFSAA) 
Pack

OFSAA applications are packaged, and released as Application Packs starting from 8.0 release. An Application 
Pack is a group of OFSAA products packaged together in a single installer and addresses specific functional 
area via its products that are grouped together. Packaging applications in a group ensures simplified installation, 
maintenance, development and integration in an integrated deployment.
Oracle Insurance Performance Insight Application Pack Installation and Configuration Guide - 8.0.7.0.0 5



About OFSAA and OFSAA Application Packs
The following figure depicts the various application packs that are available across the OFSAA Banking and 
Insurance domains:
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About OFSAA and OFSAA Application Packs
About Oracle Insurance Performance Insight (OIPI) Application Pack

This application is a comprehensive business intelligence system created exclusively for the General Insurance/
Property and Casualty (P&C) insurance industry. OIPI provides a complete set of Web-based analytical and 
reporting components that enables you to generate, view, analyze, distribute, electronically store, and retrieve 
critical reports. It provides tools for data integration and includes customizable, pre-built dashboards and 
reports, a reporting data model, and user friendly functional subject areas for ad-hoc reporting. It enables you 
to actively plan, manage, and track key areas measuring organizational performance with pre-built reports, 
dashboards, and underlying data structures.

About Oracle Financial Services Analytical Applications 
Infrastructure (OFS AAI)

Oracle Financial Services Analytical Applications Infrastructure (OFS AAI) powers the Oracle Financial Services 
Analytical Applications family of products to perform the processing, categorizing, selection and manipulation of 
data and information needed to analyze, understand and report on specific performance, risk, compliance and 
customer insight issues by providing a strong foundation for the entire family of Oracle Financial Services 
Analytical Applications across the domains of Risk, Performance, Compliance and Customer Insight.

Components of OFSAAI

The OFSAA Infrastructure is comprised of a set of frameworks that operates on and with the Oracle Financial 
Services Analytical Applications Data Model and form the array of components within the Infrastructure.

The OFSAA Infrastructure components/ frameworks are installed in two layers; primarily the Metadata server 
and Infrastructure services run on one layer, and the UI and presentation logic runs on the other. The UI and 
presentation layer is deployed on any of the supported J2EE Servers.
Oracle Insurance Performance Insight Application Pack Installation and Configuration Guide - 8.0.7.0.0 7



About OFSAA and OFSAA Application Packs
The following figure depicts the various frameworks and capabilities that make up the OFSAA Infrastructure:

OFSAA Infrastructure High Availability

The current release of the OFSAA Infrastructure supports only "Single Instance" installation for the Infrastructure 
components. However, the High Availability (HA) for the Database Server and/ or the Web Application Server 
clustering and deployment are supported in this release.

This release supports Active-Passive model of implementation for OFSAAI components. For more information, 
see Configuration for High Availability- Best Practices Guide.
Oracle Insurance Performance Insight Application Pack Installation and Configuration Guide - 8.0.7.0.0 8
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About OFSAA and OFSAA Application Packs
About Data Security Configuration

Data Security refers to the protection of data against unauthorized access and data theft. OFSAA ensures Data 
Security with the following features:

• Multi-Factor Authentication

• Transparent Data Encryption (TDE)

• Data Redaction

• Key Management

• HTTPS

• Logging

For more details on the features in the previous list, see the relevant topics in this guide and the Data Security 
and Data Privacy section in the OFSAAI Administration Guide.
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Understanding Oracle Insurance Performance Insight Application Pack Installations
CHAPTER 2 – UNDERSTANDING ORACLE INSURANCE 
PERFORMANCE INSIGHT APPLICATION PACK INSTALLATIONS

This chapter includes the following topics:

• Installation Overview

• Hardware and Software Requirements

• Verifying the System Environment

• Understanding Installation Modes

Installation Overview

This release of the OIPI Application Pack bundles the upgrade patch set along with the base installer. Users/ 
Administrators who wish to install a new OIPI Application Pack 8.0.7.0.0 instance should download this installer. 
The following figure shows the order of procedures you will need to follow to install a new OIPI Pack 8.0.7.0.0 
instance.

This section gives an overview of the OIPI Applications Pack Installation. The following figure shows the order 
of procedures you need to follow:
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Understanding Oracle Insurance Performance Insight Application Pack Installations
The following table describes the tasks and their descriptions:

Tasks Details and Documentation

Verify Systems Environment To verify that your system meets the minimum necessary requirements for 

installing and hosting the OIPI Application Pack, see Verifying the System 
Environment.

Obtain the software To access and download the OIPI Application Pack, see Obtaining the 
Software.

Configure and Execute the Schema Creator 
Utility

For instructions on creating the database schemas, see Configuring and 
Executing the Schema Creator Utility.

Install OIPI Application Pack For instructions on Installing OIPI Application Pack, see Installing the OIPI 
Application Pack.

Configure OIPI Setup See Post Installation Configuration.
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Understanding Oracle Insurance Performance Insight Application Pack Installations
Deployment Topology

The following figure depicts the typical deployment topology implemented for OFSAA Applications:

Hardware and Software Requirements

This section describes the various Operating Systems, Database, Web Server, and Web Application Server 
versions, and other variant details on which this release of the OIPI Application Pack has been qualified. 

OIPI Application Pack installation can be performed on both Virtual and Physical servers.
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Understanding Oracle Insurance Performance Insight Application Pack Installations
Configurations Supported for Java 7

The following table shows the minimum hardware and software requirements for installing OIPI Application Pack 
(for Java 7):

Requirement Sub-Category Value

Operating System Oracle Linux / Red Hat Enterprise Linux 
(x86-64)

 Red Hat Enterprise Linux or Oracle Linux Server 
release 6 update 6 to latest update version

 Red Hat Enterprise Linux or Oracle Linux Server 
release 7 update 1 to latest update version

Oracle Solaris (SPARC)/ Solaris x86  Oracle Solaris v5.10 Update 11 and above - 64 bit

 Oracle Solaris v5.11 update 3 and above - 64 bit

IBM AIX (PowerPC)  AIX 6.1 (TL 09 and above) - 64 bit

 AIX 7.1 (TL 03 and above) - 64 bit

Shell KORN Shell (KSH)

Note:  

 If the OS is IBM AIX 6.1 and the file size limit for the AIX user on the target server is too small, 
configure the size parameter setting for "Large File Support". Follow these steps:

Change the file size limit for the user that initiates the transfer on the AIX system. To change 
the file size limit for a particular user, add or edit the fsize attribute for the user in the /etc/
security/limits file on the AIX system. Change the file size limit to unlimited (fsize = -1) or to a 
size equal to the size of the file being transferred. This may require an restart of the AIX server 
to pick up the new configuration. For more information, see IBM Support.

 If the operating system is RHEL, install the package lsb_release using one of the following 
commands by logging in as root user:

 yum install redhat-lsb-core

 yum install redhat-lsb

 To install this release on Oracle Solaris OS, refer to the following list for version specific 
information:

 Solaris 11 - Upgrade to Oracle Solaris 11.3 with SRU09 or higher. See https://
docs.oracle.com/cd/E60778_01/html/E60743/gouaw.html#scrolltoc to upgrade to SRU09 
if you have a lower SRU version. Additionally, install the required runtime libraries. For 
more information, see Installing Only the Runtime Libraries on Oracle Solaris 11. 

 Solaris 10 - Install the required OS patches. For more information, see Installing the 
Required Oracle Solaris 10 Patches. Additionally, install the required runtime libraries. For 
more information, see Installing Only the Runtime Libraries on Oracle Solaris 10.

Note: In an OFSAA instance where multiple OFSAA application packs have been installed/ 

deployed, it is mandatory to upgrade all OFSAA application packs to 8.0.4.0.0 release. You should 

start the upgrade of OFS AAAI<<your pack name>>pack, only after confirming that all of the 

application packs in your OFSAA instance are available for upgrade to 8.0.4.0.0 version. For 

information on availability of the required OFSAA Application Packs, see 2246606.1.
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Java Runtime 
Environment

Oracle Linux / Red Hat Enterprise Linux  Oracle Java Runtime Environment (JRE) 1.7.x - 64 
bit

IBM AIX IBM AIX Runtime, Java Technology JRE 1.7.x - 64 bit

Oracle Database 
Server and Client

 Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.3.0 +) - 64 bit RAC/ Non-
RAC with partitioning option

 Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.4.0 +) - 64 bit RAC/Non-RAC 
with partitioning option, Advanced Security Option**

 Oracle Database Server Enterprise Edition 12c Release 1 (12.1.0.1.0 +) - 64 bit RAC/ Non-
RAC with partitioning option, Advanced Security Option**

 Oracle Database Server Enterprise Edition 12C Release 2 (12.2.0.1.0 +) - 64 bit RAC/Non-
RAC with partitioning option, Advanced Security Option**

Note: ** See the "Additional Notes" section in the 806 Tech Matrix for details.

 Oracle Client 11g Release 2 (11.2.0.3.0+) - 64 bit

 Oracle Client 12c Release 1 (12.1.0.1.0+) - 64 bit

 Oracle 11g Release 2 (11.2.0.3+) JDBC driver (Oracle thin driver)

 Oracle 12C Release 1 (12.1.0.1+) JDBC driver (Oracle thin driver)

 Oracle R Distribution (ORD) version 3.2.0/3.3.0 (Optional)

 Oracle R Enterprise (Server) version 1.5 with ORD 3.2.0 and version 1.5.1 with ORD 3.3.0 
(Optional).

Note: Ensure that the following patches are applied:

 For Oracle DB Server 12.1.0.1 and 12.1.0.2, download the patches 27010930 and 
22205607 from My Oracle Support and apply them.

 For Oracle DB Server 11.2.0.4, download the patch 22205607 from My Oracle Support 
and apply.

ORAAH Technical Description (Optional)

Requirement Sub-Category Value
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OLAP Oracle Hyperion Essbase  V 11.1.2.1+ (Server and Client) with Oracle 11g 
Database

 V 11.1.2.3+ (Server and Client) with Oracle 12c 
Database

Note: Oracle Hyperion Essbase is required only if you are using the OLAP feature of OFSAAI.

Web Server/ Web 
Application Server

Oracle Linux / Red Hat Enterprise Linux 
/ IBM AIX Oracle Solaris

Oracle HTTP Server 11.1.1.1/ Apache HTTP Server 2.2.x/ 
IBM HTTP Server

 Oracle Weblogic Server  12.1.3+ with jersey 2.25

 Oracle WebLogic Server 12.2.x (64 bit)

 IBM WebSphere Application Server 8.5.5.9+ (Full 
Profile) with IBM Java Runtime - 64 bit

 Apache Tomcat version 8.0.21+ up to version 8.0.38 
(64 bit)

Note: OFS Inline Processing Engine does not support 

Tomcat Web Application Server.

Note: OFSAA Infrastructure web component deployment on Oracle WebLogic Server with Oracle 

JRockit is not supported.

Big Data (Optional) Cloudera Distribution Hadoop 5.3.3  CDH Version 5.3.3

 Hadoop-2.5.0+cdh5.3.3+844

 Hive-0.13.1+cdh5.3.3+350

 Sqoop1 V 1.4.5+cdh5.3.3+67

 Sqoop2 V 1.99.4+cdh5.3.3+23

 Oracle Loader For Hadoop (OLH) V 3.2

Cloudera Distribution Hadoop 5.4.4  CDH Version -5.4

 Hadoop-2.6.0+cdh5.4.4+597

 Hive V 1.1.0+cdh5.4.4+152

 Sqoop1 V 1.4.5+cdh5.4.4+101

 Sqoop2 V 1.99.5+cdh5.4.4+36

Cloudera Distribution Hadoop 5.8.4  CDH Version -5.8.4

 Hadoop-2.6.0+cdh5.8.4+1801

 Hive-1.1.0+cdh5.8.4+723

 Sqoop-1.4.6+cdh5.8.4+100

 Sqoop2-1.99.5+cdh5.8.4+42

Cloudera Hive Connectors Hive JDBC Connectors V 2.5.15 and V 2.5.18

Oracle R Advanced Analytics for 
Hadoop

Oracle R Advanced Analytics for Hadoop (ORAAH) 2.6.0/
2.7.0.

Hadoop Security Protocol  Kerberos R release 1.6.1

 Sentry-1.4.0

Requirement Sub-Category Value
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Desktop 
Requirements

Operating System Windows 7/8/10

Browser  Microsoft Internet Explorer Browser 11.x

 Chrome 57.x

 FireFox 52.x

Note: Turn off Pop-up blocker settings. For more 

information, see Internet Explorer Settings.

Office Tools  MS Office 2007/ 2010/ 2013/ 2016

 Adobe Acrobat Reader 10 and 11

Screen Resolution 1024*768 or 1280*1024

Other Software Directory Services OFSAAI is qualified on both OPEN LDAP 2.2.29+ and 
Oracle Internet Directory v 11.1.1.3.0. However, it can be 
integrated with other directory services software such as 
MS Active Directory.

Note: Configuration of Directory services software for OFSAAI installation is optional. For more 

information on configuration, see LDAP Configuration section in OFSAAI Administration Guide.

Open LDAP needs to be installed on MS Windows Server machine only.

AAI One-off patches Download the following one-off patches for the given bug 
numbers from http://support.oracle.com:

 27938294

 28079607

 28033582

Requirement Sub-Category Value
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Configurations Supported for Java 8

The following table shows the minimum hardware and software requirements for installing OIPI Application Pack 
(for Java 8):

Requirement Sub-Category Value

Operating System Oracle Linux / Red Hat Enterprise Linux 
(x86-64)

 Red Hat Enterprise Linux or Oracle Linux Server 
release 6 update 6 to latest update version

 Red Hat Enterprise Linux or Oracle Linux Server 
release 7 update 1 to latest update version

Oracle Solaris (SPARC)/ Solaris x86  Oracle Solaris v5.10 Update 11 and above - 64 bit

 Oracle Solaris v5.11 update 3 and above - 64 bit

IBM AIX (PowerPC)  AIX 6.1 (TL 09 and above) - 64 bit

 AIX 7.1 (TL 03 and above) - 64 bit

Shell KORN Shell (KSH)

Note:  

 If the OS is IBM AIX 6.1 and the file size limit for the AIX user on the target server is too small, 
configure the size parameter setting for "Large File Support". Follow these steps:

Change the file size limit for the user that initiates the transfer on the AIX system. To change 
the file size limit for a particular user, add or edit the fsize attribute for the user in the /etc/
security/limits file on the AIX system. Change the file size limit to unlimited (fsize = -1) or to a 
size equal to the size of the file being transferred. This may require an restart of the AIX server 
to pick up the new configuration. For more information, see IBM Support.

 If the operating system is RHEL, install the package lsb_release using one of the following 
commands by logging in as root user:

 yum install redhat-lsb-core

 yum install redhat-lsb

 To install this release on Oracle Solaris OS, refer to the following list for version specific 
information:

 Solaris 11 - Upgrade to Oracle Solaris 11.3 with SRU09 or higher. See https://
docs.oracle.com/cd/E60778_01/html/E60743/gouaw.html#scrolltoc to upgrade to SRU09 
if you have a lower SRU version. Additionally, install the required runtime libraries. For 
more information, see Installing Only the Runtime Libraries on Oracle Solaris 11. 

 Solaris 10 - Install the required OS patches. For more information, see Installing the 
Required Oracle Solaris 10 Patches. Additionally, install the required runtime libraries. For 
more information, see Installing Only the Runtime Libraries on Oracle Solaris 10.

Note: In an OFSAA instance where multiple OFSAA application packs have been installed/ 

deployed, it is mandatory to upgrade all OFSAA application packs to 8.0.4.0.0 release. You should 

start the upgrade of OFS AAAI<<your pack name>>pack, only after confirming that all of the 

application packs in your OFSAA instance are available for upgrade to 8.0.4.0.0 version. For 

information on availability of the required OFSAA Application Packs, see 2246606.1.
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Java Runtime 
Environment

Oracle Linux / Red Hat Enterprise 
Linux//IBM AIX

Oracle Solaris

 Oracle Java Runtime Environment (JRE) 1.7.x - 64 
bit

 Oracle Java Runtime Environment (JRE) 1.8.x - 64 
bit

IBM AIX IBM AIX Runtime, Java Technology JRE 1.8.x - 64 bit

Oracle Database 
Server and Client

 Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.3.0 +) - 64 bit RAC/ Non-
RAC with partitioning option

 Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.4.0 +) - 64 bit RAC/Non-RAC 
with partitioning option, Advanced Security Option**

 Oracle Database Server Enterprise Edition 12c Release 1 (12.1.0.1.0 +) - 64 bit RAC/ Non-
RAC with partitioning option, Advanced Security Option**

Note: See the "Additional Notes" section in the 806 Tech Matrix for details.

 Oracle Client 11g Release 2 (11.2.0.3.0+) - 64 bit

 Oracle Client 12c Release 1 (12.1.0.1.0+) - 64 bit

 Oracle 11g Release 2 (11.2.0.3+) JDBC driver (Oracle thin driver)

 Oracle 12C Release 1 (12.1.0.1+) JDBC driver (Oracle thin driver)

 Oracle R Distribution (ORD) version 3.2.0/3.3.0 (Optional)

 Oracle R Enterprise (Server) version 1.5 with ORD 3.2.0 and version 1.5.1 with ORD 3.3.0 
(Optional).

Note: 

Ensure that the following patches are applied:

 Oracle Server 12c, v12.1.0.1 - 17082699

 Oracle Server 12c, v12.1.0.2 - 19392604, 19649591

 For Oracle DB Server 12.1.0.1 and 12.1.0.2, download the patches 27010930 and 22205607 
from My Oracle Support and apply them. 

 For Oracle DB Server 11.2.0.4, download the patch 22205607 from My Oracle Support and 
apply.

Also for latest information, see http://support.oracle.com, 12.1.0.2 Bundle Patches for Engineered 
Systems and DB In-Memory - List of Fixes in each Bundle (Doc ID 1937782.1).

ORAAH Technical Description (Optional)

Requirement Sub-Category Value
Oracle Insurance Performance Insight Application Pack Installation and Configuration Guide - 8.0.7.0.0 18

https://docs.oracle.com/cd/E55339_01/homepage.htm
http://support.oracle.com


Understanding Oracle Insurance Performance Insight Application Pack Installations
OLAP Oracle Hyperion Essbase  V 11.1.2.1+ (Server and Client) with Oracle 11g 
Database

 V 11.1.2.3+ (Server and Client) with Oracle 12c 
Database

Note: Oracle Hyperion Essbase is required only if you are using the OLAP feature of OFSAAI.

Web Server/ Web 
Application Server

Oracle Linux / Red Hat Enterprise Linux 
/ IBM AIX

Oracle Solaris

Oracle HTTP Server 11.1.1.1/ Apache HTTP Server 2.2.x/ 
IBM HTTP Server

 Oracle Weblogic Server 12.1.3+ with jersey 2.25

 Oracle WebLogic Server 12.2.x - (64 bit)

 IBM WebSphere Application Server 8.5.5.9+ (Full 
Profile) with IBM Java Runtime - 64 bit

 Apache Tomcat version 8.0.21+ up to version 8.0.38 
- 64 bit

Note: OFS Inline Processing Engine does not support 

Tomcat Web Application Server.

Note: 

OFSAA Infrastructure web component deployment on Oracle WebLogic Server with Oracle JRockit 

is not supported.

For deployment on Oracle WebLogic Server 12.1.3+ (64 bit) with Java 8, download and install patch 
18729264 from http://support.oracle.com.

Requirement Sub-Category Value
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Big Data (Optional) Cloudera Distribution Hadoop 5.3.3  CDH Version 5.3.3

 Hadoop-2.5.0+cdh5.3.3+844

 Hive-0.13.1+cdh5.3.3+350

 Sqoop1 V 1.4.5+cdh5.3.3+67

 Sqoop2 V 1.99.4+cdh5.3.3+23

 Oracle Loader For Hadoop (OLH) V 3.2

Cloudera Distribution Hadoop -5.4.4  CDH Version -5.4

 Hadoop-2.6.0+cdh5.4.4+597

 Hive V 1.1.0+cdh5.4.4+152

 Sqoop1 V 1.4.5+cdh5.4.4+101

 Sqoop2 V 1.99.5+cdh5.4.4+36

Cloudera Distribution Hadoop 5.8.4  CDH Version -5.8.4

 Hadoop-2.6.0+cdh5.8.4+1801

 Hive-1.1.0+cdh5.8.4+723

 Sqoop-1.4.6+cdh5.8.4+100

 Sqoop2-1.99.5+cdh5.8.4+42

Cloudera Hive Connectors Hive JDBC Connectors V 2.5.15 and V 2.5.18

Oracle R Advanced Analytics for 
Hadoop

Oracle R Advanced Analytics for Hadoop (ORAAH) 2.6.0/
2.7.0.

Hadoop Security Protocol  Kerberos R release 1.6.1

 Sentry-1.4.0

Desktop 
Requirements

Operating System MS Windows 7/8/10

Browser  Microsoft Internet Explorer Browser 11.x

 Chrome 57.x

 FireFox 52.x

Note: Turn off Pop-up blocker settings. For more 

information, see Internet Explorer Settings.

Office Tools  MS Office 2007/ 2010/ 2013/ 2016

 Adobe Acrobat Reader 10 and 11

Screen Resolution 1024*768 or 1280*1024

Requirement Sub-Category Value
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Note: To upgrade an existing OFSAA 8.0.x Java 7 instance to Java 8, see Upgrading an Existing OFSAA 8.0.x 
Java 7 Instance to Java 8.

Other Software Directory Services OFSAAI is qualified on both OPEN LDAP 2.2.29+ and 
Oracle Internet Directory v 11.1.1.3.0. However, it can be 
integrated with other directory services software like MS 
Active Directory.

Note: Configuration of Directory services software for OFSAAI installation is optional. For more 

information on configuration, see LDAP Configuration section in OFSAAI Administration Guide.

Open LDAP needs to be installed on MS Windows Server machine only.

AAI One-off patches Download the following one-off patches for the given bug 
numbers from http://support.oracle.com:

 27938294

 28079607

 28033582

Requirement Sub-Category Value
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Recommended Software Combinations

OIPI Application Pack recommends the following software combinations for deployment:

Verifying the System Environment

To verify if your system environment meets the minimum requirements for the installation, a Pre-Install Check 
utility (Environment Check) is available within the Install Kit archive file. This utility can also be obtained 
separately by contacting Oracle Support.

Though the system environment verification is an integral and automated part of the installation of this software 
product, Oracle strongly recommends running this utility prior to beginning the installation as part of your 
organization's "Installation Readiness Verification Process".

Note: For more details on download and usage of this utility, see Oracle Financial Services Analytical 
Applications Infrastructure Environment Check Utility Guide given in the Related Documents section.

Operating System Database Web Application Server Web Server

Oracle Linux 5.3 up to 5.10/ 
6.0 and above

Oracle Database Oracle WebLogic Server/ 
Apache Tomcat Server

Oracle HTTP Server/ 
Apache HTTP Server

Oracle Solaris 5.10/ 5.11 Oracle Database Oracle WebLogic Server/ 
Apache Tomcat Server

Oracle HTTP Server/ 
Apache HTTP Server

IBM AIX 6.1 Oracle Database IBM WebSphere Application 
Server/ Apache Tomcat 
Server

IBM HTTP Server/ Apache 
HTTP Server
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Understanding Installation Modes

The following modes of installation are available for the OIPI Application Pack.

GUI Mode

This mode launches the product installation in a Graphical User Interface (GUI) Mode. You need to enter the 
required information on various panels within the UI in a user interaction format at various stages.

See GUI Mode Installation for details on configuration required for GUI Mode installation.

SILENT Mode

This mode mandates updating the installation configuration files with required details and performs installation 
in a "SILENT" non user interactive format.

See Silent Mode Installation for details on configuration required for SILENT Mode installation.
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CHAPTER 3 – PREPARING FOR INSTALLATION

This chapter provides necessary information to review before installing the OIPI Application Pack v8.0.7.0.0.

This chapter includes the following topics:

• Installer and Installation Prerequisites

• Obtaining the Software

• Common Installation Tasks
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Installer and Installation Prerequisites

The following table mentions the list of prerequisites required before beginning the installation for OIPI 
Application Pack. The Installer/ Environment Check utility notifies you if any requirements are not met.

Requirement Sub-Category Expected Value

Environment Settings Java Settings PATH in .profile to be set to include the Java Runtime Environment 
absolute path. The path should include Java version (Java 7 or 
Java 8) based on the configuration.

Note: Ensure the absolute path to JRE/bin is set at the beginning 

of PATH variable.

For example, PATH=/usr/java/jre1.6/bin:$ORACLE_HOME/
bin:$PATH

Ensure no SYMBOLIC links to JAVA installation is being set in the 
PATH variable.

Oracle Database 
Settings

Oracle Database Server

 TNS_ADMIN must be set in .profile file pointing to appropriate 
tnsnames.ora file.

 Enable Transparent Data Encryption (TDE) and/ or Data 
Redaction**

Note: For more information, see TDE, Data Redaction and the 

Corresponding Settings in OFSAA..

OFSAA Processing Server

 ORACLE_HOME must be set in .profile file pointing to 
appropriate Oracle Client installation.

 PATH in .profile must be set to include appropriate 
$ORACLE_HOME/bin path. 

 Ensure that an entry (with SID/ SERVICE NAME) is added in 
the tnsnames.ora file.

Oracle Essbase Settings ARBORPATH, ESSBASEPATH, HYPERION_HOME to be set in 
the .profile pointing to an appropriate Oracle Essbase Client 
installation.

Note: These settings are required only if you want to use Oracle 

Hyperion Essbase OLAP features.
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OS/ File System Settings File Descriptor Settings Greater than 15000

Note: The value specified here is the minimum value to be set for 

the Installation process to go forward. For other modules, this value 

may depend on the available resources and the number of 

processes executed in parallel.

Total Number of Process 
Settings

Greater than 4096

Note: The value specified here is the minimum value to be set for 

the Installation process to go forward. For other modules, this value 

may depend on the available resources and the number of 

processes executed in parallel.

Port Settings Default port numbers to be enabled on the system are 6500, 6501, 
6505, 6507, 6509, 6510, 6666, 9999, and 10101.

.profile permissions User to have 755 permission on the .profile file.

Installation Directory A directory where the product files will be installed/ copied.

Assign 755 permission on this directory. 

This directory needs to be set as FIC_HOME.

Temporary Directory Default temporary directory where installation files are stored for a 
short period of time to support faster installation.

 For installation on UNIX OS, you UNIX administrator must give 
you the required read-write permissions for the /tmp directory 
and disable the NOEXEC option.

 Configure adequate space on the /tmp directory. It is 
recommended that you allocate more than 10 GB of space.

Note: If NOEXEC is enabled, the extraction of files by the installer 

in to /tmp directory is prevented and the binaries will not execute in 

the directory, which will fail the installation.

Staging Area/ Metadata 
Repository

A directory to hold the application Metadata artifacts and 
additionally act as staging area for flat files. 

The directory should exist on the same system as the OFSAA 
Installation. This directory can be configured on different mount or 
under a different user profile.

Assign 775 permission on this directory.

Note: This directory is also referred to as FTPSHARE folder.

Download Directory A directory where the product installer files will be downloaded/ 
copied.

Set 755 permission on this directory.

OS Locale  Linux: en_US.utf8

 AIX: EN_US.UTF-8

 Solaris: en_US.UTF-8

To check the locale installed, execute the following command:

locale -a | grep -i 'en_US.utf'

Requirement Sub-Category Expected Value
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Following step is applicable only if existing OFSAA setup version is 8.0.5.x.x and Configuration and Atomic 
Schema(s) were restored from exported dumps of other environment:

Login to Configuration Schema and execute the following SQL statements: 

alter table AAI_AOM_APP_COMP_ATTR_MAPPING drop constraint AOM_APP_COMP_ATTR_PK drop index 

/

alter table AAI_AOM_APP_COMP_ATTR_MAPPING add constraint AOM_APP_COMP_ATTR_PK primary key 
(APP_COMP_ATTR_MAP_ID) 

/

Note: Ensure that the tablespace(s) used for the database user(s) is set to AUTOEXTEND ON.

Obtaining the Software

This release of OIPI Application Pack v8.0.7.0.0 is available for download in My Oracle Support (https://
support.oracle.com) as Patch 28152960. You need to have a valid Oracle account in order to download the 
software.

Database Settings Database Instance 
Settings

NLS_CHARACTERSET to be AL32UTF8

NLS_LENGTH_SEMANTICS to be BYTE

OPEN CURSORS limit to be greater than 1000

Web Application Server WebSphere/ WebLogic/ 
Tomcat

Web Application Server should be installed and profile /domain 
created.

You will be prompted to enter the WebSphere Profile path or 
WebLogic Domain path or Tomcat Deployment path during 
OFSAAI installation.

Note: See Configuring Web Server for WebSphere Profile 

Creation and WebLogic Domain Creation.

Web Server Apache HTTP Server/ 

Oracle HTTP Server/

IBM HTTP Server

This is an optional requirement.

HTTP Server Installation to be present. 

You will be required to enter the Web Server IP/ Hostname and Port 
details during installation.

Note: See Configuring Web Server for Web Server 
configuration.

Big Data (Optional) Cloudera CDH and 
Cloudera JDBC 
Connectors

This is an optional requirement and required if Oracle Financial 
Services - Big Data Processing license is enabled. For more 
information, see Installing Cloudera CDH.

Others (Optional) Oracle R/ Oracle R 
Enterprise

This is an optional requirement.

For more details, see Configuration for Oracle R Distribution 
and Oracle R Enterprise (ORE).

Requirement Sub-Category Expected Value
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Common Installation Tasks

The following are the common pre-installation activities that you need to carry out before installing the OIPI 
Application Pack.

This section includes the following topics:

• Configuration for GUI Mode Installation

• Identifying the Installation, Download and Metadata Repository Directories

• Downloading and Copying the OIPI Applications Pack Installer

• Copying and Extracting the Software

• Setting up the Web Server/ Web Application Server

• Installation of Oracle R Distribution (Optional)

Configuration for GUI Mode Installation

To install OIPI Application Pack in GUI mode, you need to ensure the below software and configurations are 
available:

• Install and configure any PC X Server software such as Open Text Exceed (formerly Hummingbird Exceed) 
on the user desktop system from which the installation is triggered.

• Configure DISPLAY variable.

• Ensure to set the DISPLAY variable on the system on which the OFSAA will be installed, to point to the user 
desktop system where the PC X Server software has been installed.

Syntax:

export DISPLAY=hostname:n.n1

where hostname is the IP Address/ Host Name of the user desktop system and n is the sequence number 
(usually 0).

For example, 10.11.12.13:0.0 or myhostname:0.0

Identifying the Installation, Download and Metadata Repository 
Directories

For installing any OFSAA Application Pack, the below folders/ directories required to be created.

• OFSAA Download Directory (Optional): Create a download directory and copy the OFSAA Application 
Pack Installer File (Archive). This is the directory where the downloaded installer/ patches can be copied.

• OFSAA Installation Directory (Mandatory): Create an installation directory. This is the directory where the 
installer installs or copies the product files. FIC_HOME variable to be set in the .profile file to point to the 
OFSAA Installation Directory.

• OFSAA Staging/ Metadata Repository Directory (Mandatory): Create a Staging/ Metadata Repository 
Directory. This is the directory where you should copy data loading files, save data extracts and so on. 
Additionally, this folder also maintains the OFSAA Metadata artifacts. This is commonly referred as 
"FTPSHARE". This directory must be created on the same host as the OFSAA Installation Directory 
mentioned in the previous point in this list.
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Note: Ensure that the user permission is set to 755 on the Installation and Download Directory and the user 
permission is set to 777 on the Staging Directory.

Downloading and Copying the OIPI Applications Pack Installer

To download and copy the OIPI Applications Pack Installer, follow these steps:

• This release of OIPI Application Pack v8.0.7.0.0 is available for download in MOS as Patch 29270845. You 
need to have a valid Oracle account in order to download the software.

• Copy the downloaded installer archive to the Download Directory (in Binary Mode) on the setup identified 
for OFSAA installation.

• Download the mandatory installer one-off patch 28398331 from http://support.oracle.com.

• 3.Log in to My Oracle Support, search for the 33663417 Mandatory Patch in the Patches & Updates Tab 
and download it. 

• ATTENTION: On the 10th of December 2021, Oracle released Security Alert CVE-2021-44228 in response 
to the disclosure of a new vulnerability affecting Apache Log4J prior to version 2.15. The application of the 
33663417 Mandatory Patch fixes the issue.

For details, see the My Oracle Support Doc ID 2827801.1.

Copying and Extracting the Software

Once you obtain the installer, copy the installer (in BINARY mode) to the system on which the OFSAA 
Infrastructure components will be installed.

Note: You must be logged in to the UNIX operating system as a non-root user.

1. Download the unzip utility (OS specific) unzip_<os>.Z and copy it in Binary mode to the directory that is 
included in your PATH variable. If you already have the unzip utility to extract the contents of the downloaded 
archive, skip to the next step.

2. Uncompress the unzip installer file using the command:

uncompress unzip_<os>.Z

Note: If you notice an error message "uncompress: not found [No such file or directory]", contact your 
UNIX administrator.

3. Give EXECUTE permission to the file using the command:

chmod 751 unzip_<os>

For example, chmod 751 unzip_sparc

4. Extract the contents of the OIPI Application Pack 8.0.7.0.0 installer archive to Download Directory using the 
following command:
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unzip OFS_IP_8.0.7.0.0_<OS>.zip

Extract and apply the patch 29270845. Refer to the Readme.txt file packaged with the patch for details on 
how to apply the patch.

Note: Do not rename the Application Pack installer folder name on extraction from the archive.

5. Give below permission to the installer folder. Navigate to the Download Directory and execute the 
command: 

chmod -R 750 OFS_IP_PACK

Setting up the Web Server/ Web Application Server

For more information to set up the environment based on your selected Web Server/ Web Application Server, 
see Configuring Web Server and Configuring Web Application Server.

Installation of Oracle R Distribution (Optional)

This is an optional step and required only if you intend to use Oracle R scripting in the Oracle Financial Services 
Enterprise Modeling Application or if the OFSAA Application that you have licensed uses this feature. For 
information on applications that use this feature, see the Tech Matrix.

The following is the instruction to install ORD and ORE:

Install Oracle R Distribution and Oracle R Enterprise (Server Components) on the Oracle Database server. See 
Oracle® R Enterprise Installation and Administration Guide for Windows, Linux, Solaris and AIX - Release 1.5 
at Oracle R Enterprise Documentation Library and Release 1.5.1 at Oracle R Enterprise Documentation Library.

Note: If you use ORE 1.5 or ORE 1.5.1, for Oracle Financial Services Enterprise Modeling, you must set the 
session time zone in 'R_HOME/etc/Rprofile.site' file on the database server, where R_HOME is the 
home directory of the R instance on which ORE server packages are installed. Alternatively, you can set 
session time zone in scripts registered within OFS EM by using the 'Sys.env(TZ=<time zone>)' R 
function.

No. Oracle R Enterprise Oracle R Advanced 
Analytics for Hadoop

Open source R or Oracle 
R Distribution

Oracle Database 
Enterprise Edition

1 1.5.1 2.7.1 3.3.0 11.2.0.4,

12.1.0.1,

12.1.0.2,

12.2.0.1

2 1.5.0 2.5.1,

2.6.0,

2.7.0

3.2.0 11.2.0.4,

12.1.0.1,

12.1.0.2
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Installing Cloudera CDH (Optional)

This is an optional step and required only if you intend to install OFSAA Big Data Processing. Follow these steps:

1. Install CDH v5.3.3, 5.4.4 or v5.8.4. For more information, see Cloudera 5.3.x Documentation, Cloudera 
5.4.x Documentation or Cloudera 5.8.x Documentation.
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CHAPTER 4 – INSTALLING OIPI APPLICATION PACK

This chapter describes the steps to be followed to install the OIPI application pack.

This chapter includes the following topics:

• About Schema Creator Utility

 Configuring Schema Creator Utility for RDBMS Installation

 Execution Modes in Schema Creator Utility

 Selecting Execution Options in Schema Creator Utility

• Configuring and Executing the Schema Creator Utility

 Prerequisites

 Configuring the Schema Creator Utility

 Executing the Schema Creator Utility

• Installing the OIPI Application Pack

 GUI Mode Installation

 Silent Mode Installation

 Verifying the Log File

About Schema Creator Utility

Creating database users/ schemas (RDBMS/ HIVE) is one of the primary steps in the complete OFSAA 
installation process. The Schema Creator utility facilitates you to quickly get started with the OFSAA 8.0 
installation by allowing easier and faster creation of database User(s)/ Schema(s) (RDBMS/ HIVE), assigning 
the necessary GRANT(s), creating the required entities in the schemas, and so on.

The schema creator utility should be configured and executed mandatorily every time prior to installation of any 
OFSAA Application Pack.

This section includes the following topics:

• Configuring Schema Creator Utility for RDBMS Installation

• Execution Modes in Schema Creator Utility

• Selecting Execution Options in Schema Creator Utility

Configuring Schema Creator Utility for RDBMS Installation

OIPI Application Pack specific schema details need to be filled in the OFS_IP_SCHEMA_IN.xml file before 
executing the Schema Creator Utility. For more information on the xml file, see Configuring 
OFS_IP_SCHEMA_IN.xml.

The following are the types of schemas that can be configured in the OFSAA:

• CONFIG - This schema holds the entities and other objects required for OFSAA setup configuration 
information.
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Note: There can be only one CONFIG schema per OFSAA instance.

• ATOMIC - This schema holds the data model entities. One ATOMIC schema is attached to one Information 
Domain.

Note: For some application packs, there can be multiple ATOMIC schemas per OFSAA Instance, but the 
Profitability Pack supports only one atomic schema per OFSAA instance.

• SANDBOX - Denotes the schema that contains the data for all Sandbox executions. One SANDBOX 
schema is attached to one Sandbox Information Domain. 

Note: This Schema type is not applicable for OFS Profitability Application Pack. There can be multiple 
SANDBOX schemas per OFSAA Instance and a Sandbox Information Domain can have only one 
SANDBOX schema.

• ADDON - Denotes any additional schema used by the OFSAA Applications. 

Note: This Schema type is not applicable for OIPI Application Pack.

Execution Modes in Schema Creator Utility

The Schema Configuration Utility supports the following modes of execution:

• Online Mode: In the Online mode, the utility connects to the database and executes the DDLs for Users, 
Objects and Grants. If you have the SYSDBA privileges you can execute the Schema Creator Utility in 
Online mode and thereby create the Users, Objects and Grants during the execution process.

To execute the utility in Online mode, you need to connect as "<User> AS SYSDBA".

• Offline Mode: In the Offline mode, the utility generates SQL script with all the required DDLs for Users, 
Objects and Grants. This script needs to be executed by the DBA on the appropriate database identified for 
OFSAA usage. If you do not have the SYSDBA privileges, you can execute the Schema Creator Utility in 
Offline mode and generate the script file that contains the Schemas, Objects and Grants, information. 
Subsequently, a SYSDBA user can execute the script file manually. 

To execute the utility in Offline mode:

1. Connect as any user with below grants (alternatively, you can also connect as a user with SYSDBA 
privileges):

SELECT ON DBA_ROLES

SELECT ON DBA_USERS

SELECT ON DBA_DIRECTORIES

SELECT ON DBA_TABLESPACES
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CREATE SESSION

For more details, see Executing the Schema Creator Utility in Offline Mode.

2. If there are any errors during the script execution, reconfigure the OFS_IP_SCHEMA_IN.XML file and execute 
the utility. This generates the scripts with corrected information. For more information, see Configuring 
OFS_IP_SCHEMA_IN.xml.

Note: Do not modify the OFS_IP_SCHEMA_OUT.XML file generated after the execution of this utility.

Selecting Execution Options in Schema Creator Utility

Depending on the option you choose to run the OFSAA Application Pack Installer, you need to choose the 
schema creator utility execution option. To run the OFSAA Application Pack installer in SILENT mode, it is 
mandatory to execute the schema creator utility with -s option. 

Note: If the schema creator utility is executed without the option -s, it is mandatory to run the OFSAA 
Application Pack Installer in GUI mode.

Configuring and Executing the Schema Creator Utility

This section includes the following topics:

• Prerequisites

• Configuring the Schema Creator Utility

• Executing the Schema Creator Utility

Prerequisites

The following prerequisites must be ensured before configuring the Schema Creator Utility:

• You must have the Oracle User ID/Password with SYSDBA privileges.

• You must have the JDBC Connection URL for RAC/Non RAC database.

• The HOSTNAME/IP of the server on which OFSAA is getting installed.

• For enabling Transparent Data Encryption (TDE) in your OFSAA instance during installation, perform the 
steps explained in TDE, Data Redaction and the Corresponding Settings in OFSAA.

• It is recommended to set the PGA_AGGREGATE_LIMIT database-parameter value sufficiently, when Oracle 
12c is installed

• You must add a TNS entry before the installation.

Note: The TNS Entry for an atomic schema should be without any special character, i.e '_'. If the atomic 
schema name is like 'DEV_ATOM', the TNS name should be like 'DEVATOM'.
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Configuring the Schema Creator Utility

To configure the Schema Creator Utility, follow these steps:

1. Log in to the system as non-root user.

2. Navigate to the following path: OFS_IP_PACK/schema_creator/conf.

3. Edit the OFS_IP_SCHEMA_IN.xml file in a text editor.

4. Configure the elements as described in the Configuring OFS_IP_SCHEMA_IN.xml.

5. Save the OFS_IP_SCHEMA_IN.xml file.

Note: On successful execution of the utility, the entered password in the OFS_IP_SCHEMA_IN.xml file is 
nullified.

Executing the Schema Creator Utility

This section includes the following topics:

• Executing the Schema Creator Utility in Online Mode

• Executing the Schema Creator Utility in Offline Mode

• Executing the Schema Creator Utility with -s option

• Executing the Schema Creator Utility for Subsequent Application Pack

• Verifying the Log File
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Executing the Schema Creator Utility in Online Mode

In Online Mode, the Schema Creator Utility will create all the Schemas, Schema Objects, Tablespaces, Grants, 
and Roles in the database during the execution process. 

1. To execute the Schema Creator Utility in Online Mode, follow these steps:

2. Log in to the system as non-root user.

3. Navigate to the following folder path: OFS_IP_PACK/schema_creator/bin/.

Execute the following command:

./osc.sh

4. The following message is displayed: You have chosen ONLINE mode. Triggering the utility in ONLINE mode 
will execute the DDLs directly on the Database. Do you wish to proceed? (Y/y or N/n).

5. Enter Y/y to proceed.

6. Enter the DB Username with SYSDBA Privileges. 

For example: SYS as SYSDBA.

7. Enter the User Password.

8. The console runs the initial validation checks and then displays the following message: 

You have chosen to install this Application Pack on <Name of the Atomic Schema > ATOMIC schema. Do 
you want to proceed? (Y/N).
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You have chosen to install this Application Pack on <Name of the Infodom>. Do you want to proceed? (Y/N).

9. Enter Y/y to start the schema creation.

Or

Enter N/n if you want to quit executing the schema creation. 

Note: On successful execution of schema creator utility, the console displays the following status 
message:

Schema Creator executed successfully. Please proceed with the installation.

See log file in OFS_IP_PACK/schema_creator/logs folder for execution status. If there are any errors, 
contact Oracle Support.

Executing the Schema Creator Utility in Offline Mode

In Offline Mode, the Schema Creator Utility will create an output in SQL file format. This script has to be executed 
manually by logging as database user with SYSDBA privileges. The SQL file will contain the scripts for creation 
of Schemas, Schema Objects, Tablespaces, Grants, and Roles.

Prerequisites:

• Database user with below privileges:

 SELECT ON DBA_ROLES

 SELECT ON DBA_USERS

 SELECT ON DBA_DIRECTORIES

 SELECT ON DBA_TABLESPACES
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 CREATE SESSION

Note: Explicit Grants to the user are required. Grants assigned through Roles are not supported.

To execute the schema creator utility in the offline mode, follow these steps:

1. Log in to the system as non-root user.

2. Navigate to the following path: OFS_IP_PACK/schema_creator/bin

3. Execute the osc.sh file using the following command:

./osc.sh -o

4. The following message is displayed: 

You have chosen OFFLINE mode. Triggering the utility in OFFLINE mode will generate the script. Do you 
wish to proceed? (Y/y or N/n).

5. Enter Y/y to proceed.

6. Enter the DB Username with SELECT privileges.

7. Enter the User Password.
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8. The console runs the initial validation checks and displays the following message:

You have chosen to install this Application Pack on <Name of the Atomic Schema > ATOMIC schema. Do 
you want to proceed? (Y/N).

You have chosen to install this Application Pack on <Name of the Infodom>. Do you want to proceed? (Y/N).

9. Enter Y/y to start the script generation. 

Or

Enter N/n if you want to quit the script generation.
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Note: On successful execution of schema creator utility, the console displays the following status 
message:

Schema Creator executed successfully. Please execute scratch/ofsaaapp/OFS_IP_PACK/
schema_creator/sysdba_output_scripts.sql before proceeding with the installation.

10. Navigate to the directory: OFS_IP_PACK/schema_creator. 

11. Login to SQLPLUS with a user having SYSDBA Privileges.

12. Execute the sysdba_output_scripts.sql file using the following command:

SQL>@sysdba_output_scripts.sql

Alternatively, you can copy the sysdba_output_scripts.sql file and SQLScripts folder to a remote server and 
execute sysdba_output_scripts.sql file, after providing appropriate execute permissions.

Note: See the log sysdba_output_scripts.log file for execution status. If there are any errors, contact 
Oracle Support. This log would be empty if there are no errors in the execution.

Executing the Schema Creator Utility with -s option

If you want to run the OFSAA Application Pack Installer in SILENT mode, it is mandatory to execute the schema 
creator utility with -s option.

To execute the utility with -s option, follow these steps:

1. Edit the file OFS_IP_PACK/schema_creator/conf/OFS_IP_SCHEMA_IN.xml in text editor.

2. Execute the utility with -s option.

For Example: ./osc.sh -s

Note: If the utility is executed without the -s option, it is mandatory to launch the OFSAA Application Pack 
Installer in GUI mode.

To execute the utility in OFFLINE mode with SILENT option, enter following command:

/osc.sh -o -s
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Executing the Schema Creator Utility for Subsequent Application Pack

While executing the schema creator utility for subsequent Application Pack, you can choose to install the pack 
either on the same Information Domain/Atomic Schema or on a new Information Domain/Atomic Schema. You 
can execute the Schema Creator Utility either in Online or Offline Mode.

Note: OIPI Application Pack can be installed on any Information Domain/ Atomic schema where any OFS 
Application Packs are installed other than OFS Behavior Detection Application Pack or OFS Compliance 
Regulatory Reporting Application Pack.

To execute the schema creator utility while installing OIPI Application Pack over an existing Application Pack, 
follow these steps:

1. Repeat the steps 1 to 9 from the Executing the Schema Creator Utility section.

Note: Ensure to use the same config schema user name as the previous Application Pack.

2. The utility identifies the Application Packs that are already installed on the current OFSAA setup and 
displays the following on console:

 Atomic schema of the Existing Application Pack

 Information Domain Name of the Existing Pack, and the

 List of Installed Application Packs Execute the ./osc.sh file.

3. Select the Atomic User, on which you want to install the Application Pack.

On successful execution or schema creator utility, the following message is displayed: Schemas Creation 
Completed.
Oracle Insurance Performance Insight Application Pack Installation and Configuration Guide - 8.0.7.0.0 41



Installing OIPI Application Pack
See the log file in OFS_IP_PACK/schema_creator/logs folder for execution status.

See the log sysdba_output_scripts.log file for execution status, if executed in offline mode. This log 
would be empty if there are no errors in the execution.

If there are any errors, contact Oracle Support.

Verifying the Log File

If schema creation is successful, the console would display an appropriate message. 

If the schema creation runs into errors, see the log files:

<<OFSOIPI Installer folder>>/<<OFS_IP_PACK>>/schema_creator/logs/ and 
<<OFS_IP>>_OSC_<timestamp>.log for further details.

You may contact Oracle support anytime for assistance.
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Installing the OIPI Application Pack

Follow the instructions in this section to install the OIPI Application Pack depending on the mode of installation.

This section includes the following topics:

• GUI Mode Installation

• Silent Mode Installation

• Verifying the Log File

GUI Mode Installation

GUI mode of installation is supported only on RDBMS database server. For HDFS support of installation, see 
section Silent Mode Installation.

Ensure that you have followed the steps as mentioned in the Configuration for GUI Mode Installation section 
prior to proceeding with the next steps.

1. Log in to the system as non-root user.

2. Identify a directory for installation and set the same in the user .profile file as below:

ORACLE_HOME=<oracle_installed_dir>

Export FIC_HOME

3. Execute the user .profile.

4. Navigate to path: OFS_IP_Pack.

5. Edit the OFS_IP_PACK/schema_creator/conf/OFS_IP_SCHEMA_IN.xml file to set the appropriate attribute 
values.

Note: See Configuring OFS_IP_SCHEMA_IN.xml file for details on configuring this XML file.

6. Execute the schema creator utility.

Note: This step is mandatory and should be executed before every OFSAA Application Pack installation. 
See Executing the Schema Creator Utility for more details.

7. Navigate to the path: OFS_OIPI_PACK/bin.

8. To install OIPI Application Pack on:

 For Java 6 and 7: Proceed with step 9.

 For Java 8: Edit the VerInfo.txt file to modify the value for property JAVA_VERSION to 1.8. Save the 
changes and proceed with step 9.

9. Execute ./setup.sh GUI in the console.
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Refer to the console for any errors during Pre-install checks.

10. The general License Agreement is displayed.
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11. Select I accept the terms if the License Agreement option.

12. Click Next to display the The Application Pack details.

13. Select the product to enable for which you have already obtained license.
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14. Click Next to display the License Agreement page.

15. Select I accept the terms if the License Agreement option.

16. Click Next.

17. Click Next to display the Manage Information Domain page.

18. Edit the Information Domain Name if it is a new Information domain and you wish to change the name of 
the information domain name.

The Information Domain Name is not editable in case of subsequent Application Pack installation on the 
same Information Domain.

Permissible length is 10 characters and only alphanumeric characters allowed. No special characters 
allowed.

19. Click Next to display the following window.
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20. Click Next to display the User Installation Directory window.

21. Enter the installation directory path. This is the directory you have set in the user .profile file in step 2.

22. Click Next to display the OFSAA Infrastructure Server Details window.

23. Enter the IP address or hostname of the OFSAAI server and Database server.
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24. Click Next to display the Web Application Server window.

25. Select the appropriate Web Application server type. The options are Tomcat, WebSphere, and WebLogic.

26. Click Next. Based on the selection, corresponding screens are displayed.

For Tomcat: The Absolute Tomcat Path window is displayed.

 Enter the Tomcat installation path (till /webapps) where OFSAAI will be deployed. 

For WebSphere: The WebSphere Setup Details window is displayed.

 Enter the installation path (up to the host name directory) of the WebSphere. The format is 
WebSphere path <WebSphere profile directory>/installedApps/ <NodeCellName>. 

For WebLogic: The Weblogic Home window is displayed.

 Enter the WebLogic home directory path.

 Enter the path of the Weblogic domain home directory.
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27. Click Next to display the OLAP Details window.

Enter 1 if you want to configure OFSAAI OLAP feature. By default, value 0 is displayed.

28. Click Next to display the Web Server Details window.
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 Select the Enable HTTPS check box to configure HTTPS.

 Enter Web Server (HTTP Server) Port, Web App Server (HTTP Server) IP address, context name for 
deployment and the local path to any folder on the Web Application Server (Tomcat/ Websphere/ 
Weblogic).

29. Click Next to display the Database Details window.

30. Enter Oracle SID/Service Name, JDBC URL, Configuration Schema User ID and Password, and Absolute 
Driver Path.

Note: Absolute Driver Path can be the path where Oracle DB client is installed or JDBC driver is installed. 
For example, /scratch/oracle/app/oracle/product/11.2.0/client_1/jdbc/lib
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31. Click Next to display the Ports Configuration window.

Enter Java Port, Native Port, Agent Port, ICC Server Port, and ICC Native Port. You can proceed with the 
default port values configured.

32. Click Next to display the Ports Configuration window.
Oracle Insurance Performance Insight Application Pack Installation and Configuration Guide - 8.0.7.0.0 51



Installing OIPI Application Pack
Enter OLAP Port, Message Server Port, Router Port, and AM Port.

33. Click Next and then select the File Transfer protocol.

Note: Ensure the system on which the OFSAA Infrastructure is being installed, has either FTP/ SFTP 
enabled.

Enter the port to be used for file transfer.
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34. Click Next to display the OFSAAI FTP/SFTP Details window.

35. Enter the path of the ftpshare directory and the User Id and password for OFSAAI Server.

Note: The transfer of data (files) between the OFSAAI Server and the Web Application Server happens 
over FTP/ SFTP. Ensure the necessary host configurations are made for a successful handshake.
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36. Click Next to display the Pre-Installation Summary window.

37. Click Next to display the Pre-Installation Summary window.

38. Click Install to display the Installing OFSAA Infrastructure window.
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Anytime during the installation you can click Cancel to stop the installation. Once completed, the Installation 
Summary screen is displayed.

The Summary screen displays the number of Fatal Errors, Errors, Debug Statements, Information, and 
Warnings along with the location of log files.

39. Click Next to display the Installation Complete window.
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Note: If the installation is successful with some warnings, you can navigate to the installation log for more 
details and address them.

40. Click Done. The following message is displayed: 

Please wait, pack_install is being configured for your system. This may take a moment.

41. After the pack installation is complete, the Solution Setup - Introduction window will be displayed.

42. In case GUI mode installation is failing with the error “Error : APP Pre-check failed” after AAI installation, 
execute the following steps:

a. Navigate to OFS_IP_PACK/OFS_IP/conf and edit the file default.properties, and provide values for the 
below variables:

 INFODOM_TYPE: ‘1’ if you want to create a new INFODOM, ‘0’ to use an existing INFODOM

 INFODOM_MANE: Name of the INFODOM. Ensure that the name you enter is in capital letters (upper 
case)

 AUTOMIC_DBNAME: Name of the Atomic schema

 INFODOM_DESC: Description for the INFODOM

b. Execute the script under OFS_IP_PACK/OFS_IP/bin:

./setup.sh WP GUI
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43. Click Next to display the Log mode window. Select the Log Mode.

44. Click Next to display the Segment creation window. Enter the log paths.
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45. Click Next to display the Pre-Infodom Creation Summary window.

46. Click Next to display the Infodom creation window.

Note: Permissible length for information domain is maximum 10 characters and only alphanumeric 
characters allowed. No special characters allowed.
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47. After creation of infodom, the Tablespace specification window will be displayed.

48. Click Next to display the Model Upload window.
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49. Select Yes and click Next to display the Model Type window.

50. Select Released Data Model and click Next. Model will get copied into ftpshare.

51. After Model is copied to ftpshare, the Model Review window will be displayed.
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Note: If Heap Memory Warning is displayed, then click on Back, and update your .profile entry with 
required heap memory size.

 Open a new session in Putty.

 Shutdown Reveleus server using $FIC_HOME/ficapp/common/FICServer/bin/ reveleusshutdown.sh.

 Update the X_ARGS_APP entry in .profile following example.

Example:

X_ARGS_APP="-Xms2g -Xmx18g -XX:+UseAdaptiveSizePolicy -XX:MaxPermSize=1024M -
XX:+UseParallelOldGC  -XX:+DisableExplicitGC"

 Run .profile.

 Start Reveleus using $FIC_HOME/ficapp/common/FICServer/bin/ reveleusstartup.sh.

 Proceed for model Upload by clicking on Next.

Pack-on-pack installation for Profitability pack, execute config/insert/indexes.sql as a post data model 
upload step.

The data model is getting uploaded. 

52. Click Next to display Oracle Business Intelligence Configuration screen.

The Pre-Setup Information screen requests for setup information. 

The following panel seeks input from the user on whether to create new ETL application/source pair or use 
an existing one. 

Choose a desired option.
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53. Click Next to continue.

54. Select New Application source and click Next. Staging details will be displayed:

55. After Creation, click Next to display the Installation Details Review window.
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56. Click Install. A Pop window will ask for the confirmation.

57. Click Yes to begin the installation. The installation progress will be in the Installation Progress window.

58. After Installation completion, Installation Completion window will be displayed.

59. Click Done. The Panel will go back to Main App Pack Installation window and the Installation Summary 
window will be displayed.
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60. Click Next to display the Installation Complete window.

61. Click Done. 

Note: The installation process continues on the console. Do not close the console until the installation 
process is complete.

Post Install Health checks are displayed:

62. Install the following mandatory one-off patches for the applications. Refer to the Readme available with the 
patch for further instructions on installing the patch.

 27938294

 28079607

 28033582

 22259561

 29002529

63. Before you run the run chart, run the following script to load policy data:

DELETE FROM DIM_POLICY WHERE N_POLICY_SKEY not in (0,-1)

/

DROP SEQUENCE SEQ_DIM_POLICY

/

CREATE SEQUENCE SEQ_DIM_POLICY

MINVALUE 1
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MAXVALUE 999999999999

START WITH 1

INCREMENT BY 1

/

COMMIT

/

64. Perform steps mentioned in the Post Installation Configuration section.

65. For enabling Transparent Data Encryption (TDE), see TDE, Data Redaction and the Corresponding Settings 
in OFSAA.

66. For enabling Data Redaction, see Data Redaction section under Data Security and Data Privacy chapter in 
OFS Analytical Applications Infrastructure Administration Guide 8.0.6.0.0.

67. For information on Data Protection Implementation, see Data Protection Implementation in OFSAA.
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Silent Mode Installation

Note: For Schema Creator Utility steps, see Executing the Schema Creator Utility.

1. Log in to the system as non-root user.

2. Identify a directory for installation and set the same in the user .profile file as below:

FIC_HOME=< OFSAA Installation Directory > export FIC_HOME

3. Execute the user .profile.

4. Pre-Installation XML/ File Populations:

Before Proceeding to SILENT Installer, we need to populate following files with pre-defined values.

 OFSAAI_InstallConfig.xml (Location: OFS_IP_PACK/OFS_AAI/conf). For more information, see 
Configuring OFSAAI_InstallConfig.xml File section.

Note: If value for HTTPS_ENABLE is set to 1, ensure you have a valid certificate available from a trusted 
CA and the same is configured on your web application server.

 SILENT.props File. (Location: OFS_IP_PACK/OFS_IP/conf)

Note: The file name will be SILENT.template in the installer and it has to be renamed as 
SILENT.props.

Do not install the new applications in the same segment if the pre-installed applications use run 
management.

Property Name Description of Property Permissible Values Comments

UPLOAD_MODEL whether you want to perform 
Model Upload

0 = No

1 = yes

Mandatory

MODEL_TYPE Released data model or 
Customized data model

0 = released

1 = customized

# Mandatory only in the case 
of uploading the data model

DATAMODEL the path for the customized 
data model

Not Applicable # Mandatory only in the case 
of uploading the customized 
data model

# Option selected for 
MODEL_TYPE=1

DM_DIRECTORY the file name for the 
customized data model

Not Applicable # Mandatory only in the case  
of uploading the customized 
data model

# Option selected for 
MODEL_TYPE=1
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Configuring Application Pack XML Files

OFS_IP_PACK.xml

The OFS_IP_PACK.xml file holds details on the various products that are packaged together in Profitability 
Application Pack.

This section details the various tags/ parameters available in the file and the values that need to be updated. 
Prior to installing the Profitability Application Pack in SILENT mode, it is mandatory to update this file.

Note: If you are installing in the GUI mode, then this file need not be updated.

Installation

1. Navigate to the following folder path: OFS_IP_Pack/bin/.

2. Execute the setup.sh file using the following command:

./setup.sh SILENT

3. The installer will proceed with Pre-Installation Checks.
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4. Enter the OFSAA Processing Tier FTP/SFTP password value, when prompted at the command prompt.

5. Enter the Password and Proceed. The process displays the OFSAA License. Enter: Y and Proceed.
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6. First AAI will be Installed.

7. After AAI is installed, the OIPI Application Pack installation begins.
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Note: Data Model Upload may take several hours to get complete. You can check the Logs in 
OFS_IP_PACK/OFS_IP/logs.
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8. Do not close the console until the installation is complete.
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9. Install the following mandatory one-off patches. Refer to the Readme available with the patch for further 
instructions on installing the patch.

 27938294

 28079607

 28033582

 22259561

 29002529

10. Perform the steps mentioned in Post Installation Configuration section.

11. For enabling Transparent Data Encryption (TDE), see TDE, Data Redaction and the Corresponding Settings 
in OFSAA.

12. For enabling Data Redaction, see Data Redaction section under Data Security and Data Privacy chapter in 
OFS Analytical Applications Infrastructure Administration Guide 8.0.6.0.0.
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13. For information on Data Protection Implementation, see Data Protection Implementation in OFSAA.

Verifying the Log File

See the following logs files for more information: 

• See the OFS_IP_installation.log located at OFS_IP_PACK/OFS_IP/logs folder for OIPI Application 
Pack installation log file.

• See the Pack_Install.log located at OFS_IP_PACK/logs/ folder for OIPI Application Pack installation log 
file.

• See the log file(s) located at OFS_IP_PACK/OFS_AAI/logs/ folder for Infrastructure installation log.

• See the OFSAAInfrastucture_Install.log located at $FIC_HOME folder for Infrastructure installation log.

Changes in .profile file for Solaris Operating System

For Solaris operating system, do the following changes in .profile file present in user's home directory.

1. For Solaris Sparc and X86 systems, append the path $FIC_DB_HOME/lib/libC++11/ to 
LD_LIBRARY_PATH variable in .profile file.

For example: 

LD_LIBRARY_PATH=$LD_LIBRARY_PATH:$FIC_DB_HOME/lib/libC++11

2. For Solaris Sparc, add the Oracle Developer Studio 12.5 installed path in the beginning of 
LD_LIBRARY_PATH variable in .profile file.

For example:

LD_LIBRARY_PATH=/opt/SunProd/studio12u5/developerstudio12.5/lib/compilers/CCgcc/lib/
sparcv9:$LD_LIBRARY_PATH
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CHAPTER 5 – POST INSTALLATION CONFIGURATION

After successfully installing the Oracle Financial Services Advanced Analytical Applications Infrastructure 
Application Pack, follow the post installation steps mentioned below.

This chapter includes the following topics:

• Configure Resource Reference

• Start/Stop OFSAA Infrastructure Services

• Add TNS entries in TNSNAMES.ORA file

• Configuring Web Server

• Configuring Work Manager in Web Application Servers

• Creating and Deploying EAR/WAR File

• Accessing the OFSAA Application

• OFSAA Landing Page

• User Group Mapping

• Create and Deploy the Application Pack Web Archive

• Patching Your OFS OIPI Pack Installation

Note: Ensure that to clear the application cache prior to the deployment of Application Pack Web Archive. This 
is applicable to all Web Servers (WebSphere, WebLogic, Tomcat). For more information, See Clearing 
Application Cache section.

Configure Resource Reference

Configure the resource reference in the Web Application Server configured for OFSAA Applications. See 
Configuring Resource Reference in Web Application Servers for details on configuring the resource reference 
in WebSphere, WebLogic, and Tomcat Application Servers. 
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Start/Stop OFSAA Infrastructure Services

Start the OFSAA Infrastructure Services prior to deployment or accessing the OFSAA Applications.

This chapter details on how to start and stop OFSAA Infrastructure services. This section includes the following 
sub-sections:

• Starting Infrastructure Services

• Starting Web Application Servers

Starting Infrastructure Services

Once the installation of Infrastructure has been completed successfully and the post-installation steps are 
completed, the servers must be started. Log on to each machine and run the .profile file. All servers mentioned 
must be started from the same shell encoding. The servers mentioned below are dependent on each other. It is 
mandatory to maintain the order in which the servers are started. Allow each of the servers to initialize 
completely before starting the next server.

1. On the machine in which Infrastructure Application components have been installed, navigate to 
$FIC_APP_HOME/common/FICServer/bin and execute the following command to start the Infrastructure 
Server.

./startofsaai.sh

Note: You can also start the Infrastructure Server by executing the command "nohup ./ startofsaai.sh &". 
Starting the process using "nohup" and "&" will return the command prompt without having to wait till the 
process completes. However, this command cannot be used when you are starting the server for the first 
time or starting after changing user password in the configuration database schema.You can also start the 
Infrastructure Server by executing the command "nohup ./ startofsaai.sh &". Starting the process using 
"nohup" and "&" will return the command prompt without having to wait till the process completes. However, 
this command cannot be used when you are starting the server after changing user password in the 
Configuration database schema.

2. Start ICC server:

 On the machine in which Infrastructure default Application components have been installed, navigate 
to $FIC_HOME/ficapp/icc/bin folder.

 Execute the command:

./iccserver.sh

Note: Only Infrastructure Default Application Server would hold ICC component.

3. Stopping Infrastructure Services:

 On the machine on which Infrastructure Database components have been installed, navigate to 
$FIC_DB_HOME/bin folder and execute the command to start "Agent server":

./agentstartup.sh

Or
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 Start Back-end services using the command:

nohup ./agentstartup.sh &

Note: This agent internally starts the Router, Message Server, OLAP data server and AM services.

Starting Web Application Servers

Start the Web Application Server depending on the type from the following table.

Stopping Infrastructure Services

To stop Infrastructure services:

1. On the machine in which Infrastructure Application components have been installed, navigate to 
$FIC_APP_HOME/common/FICServer/bin folder and execute the command:

./stopofsaai.sh

2. To stop ICC server, on the machine in which Infrastructure default Application components have been 
installed, navigate to $FIC_HOME/ficapp/icc/bin folder and execute the command:

./iccservershutdown.sh

Only Infrastructure Default Application Server would hold ICC component.

3. To stop Back-end server, on the machine in which Infrastructure database components have been installed, 
navigate to $FIC_DB_HOME/bin folder and execute the command:

./agentshutdown.sh

Start up Option Description

Starting WebSphere profile On the machine in which Web sphere is installed, navigate to 
[Webshpere_Install_Directory] /AppServer/<profiles>/<profile name>/bin and 
execute the command:

./startServer.sh server1

Starting WebLogic Domain On the machine in which WebLogic is installed navigate to <WebLogic Installation 
directory>/user_projects/domains/<domain name>/bin and execute the command: 
startWebLogic.sh -d64

Note: If WebLogic is already running, access the WebLogic Admin Console. Stop and 

start the application <context name>.ear.

Starting Tomcat Application On the machine in which Tomcat is installed, navigate to <Tomcat_Install_ Directory>/
bin and execute the command: 

./catalina.sh run
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Add TNS entries in TNSNAMES.ORA file

Add TNS entries in the tnsnames.ora file, for every schema created for the Application Pack:

To find the tnsname for the entries, follow these steps:

1. Login to the application using System Administrator privileges.

2. Navigate to System Configuration & Identity Management tab.

3. Click Administration and Configuration >> System Configuration >> Database Details.

4. Expand the drop-down list for Name to get the list of TNS entry names.

Alternatively, you can connect to the CONFIG schema and execute the below query:

select dbname from db_master where dbname !='CONFIG'

Configuring Web Server

This section includes the following topics:

• Configuring Web Server

• Configuring Web Application Server

Configuring Web Server

This step assumes an installation of a Web Server exists as per the prerequisites.

Refer the product specific Installation Guide/ Configuration Guide to install/ configure the Web Server. If an 
installation already exists, skip and proceed to the next step.

Note: Make a note of the IP Address/ Host-name and Port of the web server. This information is required during 
the installation process.

See Oracle Financial Services Analytical Applications Infrastructure Security Guide for additional 
information on securely configuring your Web Server.

Ensure to enable sticky session/ affinity session configuration on the web server. See the respective 
product specific Configuration Guide for more details. Additionally, you also need to enable the sticky 
session/ affinity session configuration at Load Balancer level if you have configured a Load Balancer in 
front of the web server(s).
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Configuring Web Application Server

This step assumes an installation of a web application server exists as per the prerequisites. To configure the 
Web Application Server for OFSAA Deployment refer the sections below. 

This section includes the following topics:

• Configuring WebSphere Application Server for Application Deployment

• Configuring WebLogic for Application Deployment

• Configuring Apache Tomcat Server for Application Deployment

Note: Make a note of the IP Address/ Host-name and Port of the web application server. This information is 
required during the installation process (required if Web Server is not configured).

Add umask 0027 in the .profile of the UNIX account which manages the WEB server to ensure restricted 
access permissions.

See Oracle Financial Services Analytical Applications Infrastructure Security Guide for additional 
information on securely configuring your Web Server.

Configuring WebSphere Application Server for Application Deployment

You can deploy multiple OFSAA applications on different profiles of a WebSphere application server. To create 
multiple WebSphere "Profiles" in a stand-alone server, use the command line option as explained below. A 
profile is the set of files that define the runtime environment. At least one profile must exist to run WebSphere 
Application Server.

This section includes the following topics:

• Creating a New Profile in WebSphere

• Managing IBM WebSphere SDK Java Technology Edition Versions

• Managing Applications in WebSphere

• Deleting WebSphere Profiles

• Configuring WebSphere Shared Library to Support Jersey 2x and Jackson 2.9x Libraries

• WebSphere HTTPS Configuration

• WebSphere Memory Settings

• Configuring WebSphere for REST Services Authorization

• Configuring Application Security in WebSphere

Creating a New Profile in WebSphere

The Profile is created in WebSphere through command line using the manageprofiles.sh which resides in 
<WebSphere Install directory>/AppServer/bin folder.

The command to create a profile without admin security through command line is as follows:
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"manageprofiles.sh -create -profileName <profile> -profilePath <profile_path> -
templatePath <template_path> -nodeName <node_name> -cellName <cell_name> -hostName 
<host_name>"
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Example:

$usr/home>./manageprofiles.sh -create -profileName mockaix -profilePath/websphere/
webs64/Appserver/profiles/mockaix -templatePath/websphere/webs64/Appserver/
profileTemplates/default -nodeName ipa020dorNode04 - cellName ipa020dorNode04Cell -
hostName ipa020dor

The command to create a profile with admin security through command line is as follows:

"manageprofiles.sh -create -profileName <profile> -profilePath <profile_path> -
templatePath <template_path> -nodeName <node_name> -cellName <cell_name> -hostName 
<host_name> -enableAdminSecurity true -adminUserName <Admin User Name> -adminPassword < 
Admin User Password> -samplespassword <sample User Password>"

Example:

$usr/home>./manageprofiles.sh -create -profileName mockaix -profilePath/websphere/
webs64/Appserver/profiles/mockaix -templatePath/websphere/webs64/Appserver/
profileTemplates/default -nodeName ipa020dorNode04 -cellName ipa020dorNode04Cell -
hostName ipa020dor -enableAdminSecurity true -adminUserName ofsaai -adminPassword ofsaai 
-samplespassword ofsaai"

Note: While using the manageprofiles.sh command to create a New Profile in WebSphere, you can also use 
"-validatePorts" to validate if the specified ports are not reserved or in use. Additionally, you can specify 
new ports with "-startingPort <base port>" which specifies the starting port number to generate and 
assign all ports for the profile. For more information on using these ports, see WebSphere 
manageprofiles command.

Managing IBM WebSphere SDK Java Technology Edition Versions

By default, WebSphere Application Server V8.5.5.X uses the Java 6.0 SDK. You must upgrade to Java 7.X SDK 
or JAVA 8.X SDK.

Prerequisites: Install the IBM WebSphere SDK Java Technology Edition Versions 1.7.X_64 or 1.8.X_64.

Perform the following steps to upgrade to Java 7.X SDK or JAVA 8.X SDK:

1. Enter the WebSphere URL in the format http://HOST_NAME:PORT_NUMBER/ibm/console (use https if 
SSL is enabled.). For example, http://192.168.1.0:9000/ibm/console.

2. Login with your administrator user ID and password.

3. From the LHS menu, click Servers to expand and view the menu.

4. Click Server Types to expand the menu further and then click WebSphere Enterprise Application 
Servers to view the Application servers window.

5. On Application servers window, click the required Application Server link. For example, server1 in the 
following illustration:
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6. Click Java SDKs link from Server Infrastructure to view the list of Java SDKs.
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7. Select either 1.7_64 or 1.8_64 based on the JVM version with which you plan to install OFSAA or have 
installed with.

8. Click Make Default button and save to master repository.

9. Restart the WebSphere Application Server to apply the changes to the IBM application profile.

Managing Applications in WebSphere

To manage the installed applications in WebSphere, do the following:

1. Open the administrator console using the following URL:

http://<ipaddress>:<Administrative Console Port>/ibm/console

Example: http://10.111.222.333:9003/ibm/console (https if SSL is enabled)

Note: Administrative Console Port value is available in serverindex.xml file within <WebSphere Profile 
Directory>/config/cells/<Node Cell>/nodes/<Node Name> directory.

The Integrated Solutions Console Login window is displayed.

2. Log on with the User ID provided with the admin rights.

3. From the LHS menu, expand the Applications > Application Type> WebSphere Enterprise 
Applications.
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The Enterprise Applications screen is displayed.

4. This Enterprise Applications screen helps you to:

 Install new application

 Un-install existing applications

 Start or Stop the installed applications
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Deleting WebSphere Profiles

To delete a WebSphere profile, do the following:

1. Select the check box adjacent to the required application and click Stop.

2. Stop the WebSphere profile to be deleted.

3. Navigate to WebSphere directory:

<WebSphere_Installation_Directory>/AppServer/bin/

4. Execute the command:

manageprofiles.sh -delete -profileName <profile_name>

5. Delete profile folder.

Example: <WebSphere_Installation_Directory>/AppServer/profiles/<profile_name>

6. Execute the command:

manageprofiles.sh -validateAndUpdateRegistry

Configuring WebSphere Shared Library to Support Jersey 2x and Jackson 2.9x 
Libraries

Perform the following configuration to set WebSphere shared library to support jersey 2x and Jackson 2.9x 
libraries. 

1. Click Environment from the menu on the left to expand and view the list. Click Shared Libraries to open 
the Shared Libraries window.
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2. Enter details as shown in the following: 

a. Name: Enter a unique identifiable name.

b. Description: Enter a valid description.

c. Classpath: Enter the absolute path where the JARs related to Jersey 2.x and Jackson 2.9x are copied. 
These jars are available in the <OFSAA_HOME>/utility/externallib/WEB-INF/lib directory after creation 
of the EAR file.

3. Select Use an isolated class loader for this library.

4. Click OK to save to master configuration. 

5. Select the application or module and map the shared libraries. Click OK. In the following illustration, ofsa is 
selected.

6. From the Shared Library Mapping window, move the required shared libraries from Available to Selected. 
In the following illustration, JERSEY2x is selected.
Oracle Insurance Performance Insight Application Pack Installation and Configuration Guide - 8.0.7.0.0 85



Post Installation Configuration
7. Click OK. 

8. Similarly, select the next application or module and repeat the procedure from steps 5 to 7.

9. Disable the built-in JAX-RS via JVM property. 

a. Go to WebSphere admin console in Servers > WebSphere Application Servers > yourServerName.

b. In Server Infrastructure section, go to Java and Process Management > Process definition > Java 
Virtual Machine > Custom properties.

c. Add the following property:

com.ibm.websphere.jaxrs.server.DisableIBMJAXRSEngine=true

10. Restart the application.

WebSphere HTTPS Configuration

Following are the steps for configuring an HTTPS Transport on WebSphere:

1. Create a profile using the Profile Creation Wizard in WebSphere.

2. Note down the https port specified during this process and use the same as servlet port or web server port 
during OFSAAI installation.

To enable https configuration on Infrastructure, assign value 1 to "HTTPS_ENABLE" in 
OFSAAI_InstallConfig.xml for SILENT mode OFSAAI installation.

WebSphere Memory Settings

To configure the WebSphere Memory Settings:

1. Navigate to Websphere applications server > Application servers > server1 > Process definition > Java 
Virtual Machine.

2. Change the memory setting for Java Heap:

 Initial heap size = 512

 Maximum heap size = 3072
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Configuring WebSphere for REST Services Authorization

Configure the following in WebSphere to enable REST API authorization by OFSAA:

1. Log on to WebSphere console with the User ID provided with the admin rights.

2. Expand Security menu in the LHS and click Global security > Web and SIP security > General settings.

3. De-select the Use available authentication data when an unprotected URI is accessed check box.

4. Click OK.

5. Click Save to save the changes to master configuration.
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Configuring Application Security in WebSphere

This is a mandatory security procedure for WebSphere to restrict the unauthorized access of configuration files 
in directories. For detailed information, see the Oracle Financial Services Analytical Applications Infrastructure 
Security Guide.

Configuring WebLogic for Application Deployment

You can deploy multiple Infrastructure applications on different domains of a stand-alone WebLogic application 
server. To create multiple WebLogic "Domains" in a stand-alone server you can use the Domain Creation 
wizard. A domain is the set of files that define the runtime environment. At least one domain must exist to run 
WebLogic Application Server.

Note: For deployment on Oracle WebLogic Server 12.1.3+ (64 bit) with Java 8, download and install patch 
18729264 from My Oracle Support.

This section includes the following topics:

• Creating Domain in WebLogic Server

• Delete Domain in WebLogic

• WebLogic Memory Settings

• Configuring WebLogic for REST Services Authorization

Creating Domain in WebLogic Server

To create a new domain using Configuration Wizard in WebLogic, do the following:

1. Navigate to the directory <WLS_HOME>/wlserver/common/bin and execute the command:

./config.sh
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The Configuration Type window of the Configuration Wizard is displayed.
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2. Select Create a new domain option and click Next to display the Templates window.
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3. Select the Create Domain Using Product Templates option and click Next to display the Administrator 
Account window.
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4. Enter the user name to be assigned to the administrator, the password and confirm the password. Click Next 
to display Domain Mode and JDK window is displayed.

5. Select from the following options:

 In the Domain Mode section, select the required mode (Development or Production).

 In the JDK section, select the required option. If you select Other JDK Location, click Browse, 
navigate to the JDK location, and select. 
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Click Next to display the Advanced Configuration window.
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6. Select Administration Server. A WebLogic Server domain must have an Administration Server. You can 
also select Manages Servers, Clusters and Machines and RDBMS Security Store, if required. Click Next 
to display the Administration Server window.

7. Enter Administration Server details such as the Server Name, Listen address, Listen Port, Enable SSL 
(for secure login using https, select this check box), and SSL listen port. 

Click Next to display the Configuration Summary window.

Note: Make a note of the Listen Port or SSL Listen Port value (for example: 7007), since the same has to 
be re-entered in the Servlet port field during Infrastructure installation.
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8. Verify the configuration details of the WebLogic domain and click Create.
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The Configuration Progress window is displayed with the status indication of the domain creation process.

9. Click Next when 100% of the activity is complete.
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The End of Configuration window is displayed

10. Click Finish. The domain server is created enabling the deployment of multiple Infrastructure applications 
on a single WebLogic.

Note: Note down the HTTPS port specified during this process and use the same as servlet port or web 
server port during OFSAAI Installation.

To enable https configuration on Infrastructure, assign value 1 to "HTTPS_ENABLE" in 
OFSAAI_InstallConfig.xml for silent mode OFSAAI installation

Add a java option entry -DUseSunHttpHandler=true in WLS_HOME/bin/ "setDomainEnv.sh" file 
(Required only if self signed certificate is used).

Delete Domain in WebLogic

1. Navigate to the following directory:

<WebLogic Installation directory>/user_projects/domains/<domain name>/bin

2. Execute stopWebLogic.sh to stop the Weblogic domain.

3. Delete the Weblogic domain.
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WebLogic Memory Settings

To configure the WebLogic Memory Settings:

1. Change the memory setting for Java Heap to -Xms512m -Xmx3072m in setDomainEnv.sh file, which resides 
in the folder <DOMAIN_HOME>/bin and in CommEnv.sh file which resides in the folder common/bin.

Edit this file for customizing memory settings and garbage collector settings depending on the available 
hardware configuration.

Example 1:

if [ "${JAVA_VENDOR}" = "Sun" ] ; then

WLS_MEM_ARGS_64BIT="-Xms512m -Xmx1024m"

export WLS_MEM_ARGS_64BIT

WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m"

export WLS_MEM_ARGS_32BIT

else

WLS_MEM_ARGS_64BIT="-Xms512m -Xmx1024m"

export WLS_MEM_ARGS_64BIT

WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m"

export WLS_MEM_ARGS_32BIT

• Example 2:

JAVA_VM=

MEM_ARGS="-Xms256m -Xmx1024m"

Configuring WebLogic for REST Services Authorization

To enable REST API authorization by OFSAA in WebLogic, perform the following steps:

1. Open the config.xml file located in the domain where OFSAA is deployed, that is <domain_home>/config/
config.xml

2. Add the following in the security-configuration tag:

<enforce-valid-basic-auth-credentials>false</enforce-valid-basic-auth-credentials>
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Configuring Apache Tomcat Server for Application Deployment

This section is applicable only when the Web Application Server type is Tomcat.

This section includes the following topics:

• Tomcat User Administration

• Configure Tomcat to use JAVA 64 bit Executables

• Configure Servlet Port

• SSL Port Configuration

• Apache Tomcat Memory Settings

• Configuring Tomcat for User Group Authorization and Data Mapping

• Uninstalling WAR Files in Tomcat

• Configuration for Axis API

• Additional Configurations for Tomcat

Tomcat User Administration

The Tomcat administration and manager application does not provide a default login. You are required to edit 
"$CATALINA_HOME/conf/tomcat-users.xml" as instructed below.

This file contains an XML tag <user> for each individual user, which will display the user name and password 
used by admin to log on to Tomcat, and the role names to which the admin user is associated with. For example, 
<user name="admin" password="admin" roles="standard-manager " />

1. Add the manager role to any one of the existing user name/ password combination as shown in the example 
above.

2. Use the same user-name/ password to which the manager role has been assigned to access the Tomcat 
Application Manager.

3. If the Tomcat server is already running, it requires a re-start after the above configuration is done.

Configure Tomcat to use JAVA 64 bit Executables

1. Navigate to the "$CATALINA_HOME/bin" folder.

2. Edit the setclasspath.sh as explained below:

3. Replace the following block of text:

# Set standard commands for invoking Java.

_RUNJAVA="$JRE_HOME"/bin/java

if [ "$os400" != "true" ]; then

_RUNJDB="$JAVA_HOME"/bin/jdb

With:

# Set standard commands for invoking Java.

_RUNJAVA="$JAVA_BIN"/java

if [ "$os400" != "true" ]; then

_RUNJDB="$JAVA_BIN"/jdb
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4. If the Tomcat server is already running, it requires a re-start after the above configuration is done.

Note: In case tomcat is installed under different Unix profile, set JAVA_BIN environment variable    in .profile 
to include the Java Runtime Environment absolute path.

For example:

export JAVA_BIN /usr/java6_64/jre/bin

export JAVA_BIN = /usr/java6_64/jre/bin//sparcv9 for Solaris Sparc.

Configure Servlet Port

The default servlet port configured for the Tomcat installation is 8080. Ignore this section if you need to use the 
default port.

If you need to use a different port number, you must first configure the port in the "server.xml" in the "conf" 
directory of Tomcat Installation directory. The following steps guide you through the configuration process:

1. Navigate to $CATALINA_HOME/conf. Open server.xml and locate the tag:

"Define a non-SSL HTTP/1.1 Connector on port 8080 "

2. Against this tag, a parameter is specified 'Connector port = "8080" '. Edit this value to the new port number 
that will be used during the installation process. 

3. Save your changes in server.xml.

Note: Make a note of the servlet port configured. This information is required during the installation of 
OFSAA Application Pack.

SSL Port Configuration

If you need to configure and access your OFSAA setup for HTTPS access, ensure that the following connect 
tag under "Define a SSL HTTP/1/1 Connector on port 8443" in "<Tomcat_installation_folder>/conf/
server.xml" file is uncommented for SSL Configuration. (By default, it is commented).

<Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true"

maxThreads="150" scheme="https" secure="true"

clientAuth="false" sslProtocol="TLS"

Note: Make a note of the servlet port configured. This information would be required during the installation 
of OFSAA Application Pack. To enable https configuration on Infrastructure, assign value 1 to 
"HTTPS_ENABLE" in OFSAAI_InstallConfig.xml for SILENT mode OFSAAI installation.

For more information related to SSL Configuration on Tomcat, see http://tomcat.apache.org/.
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Apache Tomcat Memory Settings

To configure the Apache Tomcat Memory Settings:

1. Locate the file catalina.sh which resides in the folder <CATALINA_HOME>/bin.

2. Edit this file for customizing the memory settings and garbage collector settings depending on the available 
hardware configuration.

3. Add the memory setting for Java Heap to -Xms512m -Xmx1024m.

Example:

if [ -z "$LOGGING_MANAGER" ]; then

JAVA_OPTS="$JAVA_OPTS -Xms512m -Xmx1024m

-Djava.util.logging.manager=org.apache.juli.ClassLoaderLogManager"

else

JAVA_OPTS="$JAVA_OPTS -Xms512m -Xmx1024m $LOGGING_MANAGER"

Fi

Configuring Tomcat for User Group Authorization and Data Mapping

Users with system authorization roles can access User Group Authorization. However, to make it available on 
Tomcat web server, you have to perform the following configuration steps:

1. Navigate to the $CATALINA_HOME/conf folder and open web.xml file.

2. Enter the following in the web.xml file.

<init-param>

<param-name>mappedfile</param-name>

<param-value>false</param-value>

</init-param>

3. Save and close the file.

Uninstalling WAR Files in Tomcat

To uninstall WAR files in tomcat, see Uninstalling WAR Files in Tomcat.

Configuration for Axis API

This step is optional and required only if the web application server used in Apache Tomcat. If you use any other 
web application server, skip and proceed to next step.

Copy the jaxrpc.jar from the <OFSAA Installation Directory>/axis-1_4/webapps/axis/WEB-INF/lib 
and place it in under <Tomcat Installation Directory>/lib and restart the Tomcat Server.

Additional Configurations for Tomcat

To stop generating static content with one print statement per input line, you need to configure the web.xml file.

To configure web.xml file, perform the following steps:

1. Navigate to tomcat/conf folder.
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2. Edit web.xml file as explained below:

Set the mapped file parameter to False in the servlet tag mentioned with

<servlet-name>jsp</servlet-name>.

<init-param>

<param-name>mappedfile</param-name>

<param-value>false</param-value>

</init-param>
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Configuring Work Manager in Web Application Servers

Process Modelling framework requires creation of Work Manager and mapping it to OFSAA instance. This 
configuration is required for WebSphere and WebLogic Web Application Server types.

This section covers the following topics:

• Configuring Work Manager in WebSphere Application Server

• Configuring Work Manager in WebLogic Application Server

Configuring Work Manager in WebSphere Application Server

This section is applicable only when the Web Application Server type is WebSphere.

This section covers the following topics:

• Creating Work Manager

• Mapping Work Manager to OFSAA WebSphere Instance

Creating Work Manager

1. Open the WebSphere admin console in the browser window: http://<ipaddress>:<administrative console 
port>/ibm/console. (https if SSL is enabled). The Login window is displayed.
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2. Login with the user id that has admin rights. 

3. From the LHS menu, expand Resources > Asynchronous beans and select Work Managers.

4. Select the required Scope from the drop-down list 

For example, Node=whf00aqnNode01, Server=server1.
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5. Click New in the Preferences section.

6. Enter the Name as 'wm' and JNDI name as 'wm/WorkManager ' in the respective fields. 

7. Enter the Thread pool properties.
Oracle Insurance Performance Insight Application Pack Installation and Configuration Guide - 8.0.7.0.0 105



Post Installation Configuration
8. Click Apply.

9. Click Save.

After creating work manager successfully, you have to map it to OFSAA instance.
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Mapping Work Manager to OFSAA WebSphere Instance

1. From the LHS menu, expand Applications > Application Types and select WebSphere enterprise 
applications.
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2. Click OFSAAI instance hyperlink.

3. Click Resource references link under References section.
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4. Click Browse corresponding to the Work Manager Resource Reference. The available resources are 
displayed.

5. Select the newly created Work Manager ('wm') and click Apply.
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6. Select the Work Manager ('wm/WorkManager') and click OK.

7. Click Save.
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Configuring Work Manager in WebLogic Application Server

This section is applicable only when the Web Application Server type is WebLogic.

1. Open the WebLogic admin console in the browser window: http://<ipaddress>:<administrative console 
port>/console. (https if SSL is enabled). The Welcome window is displayed.

2. Login with the user id that has admin rights.

3. From the Domain Structure menu in the LHS, expand Environment and select Work Managers. The 
Summary of Work Managers window is displayed.
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4. Click New to create a new work manager component.

5. Select Work Manager and click Next. 

6. Enter the Name as 'wm/WorkManager'.

7. Click Next.
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8. Select the required deployment target and click Finish. 
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Creating and Deploying EAR/WAR File

This section includes the following topics:

• Creating EAR/WAR File

• Deploying EAR/WAR File

Creating EAR/WAR File

To create EAR/WAR File, follow these steps:

1. Navigate to the $FIC_WEB_HOME directory on the OFSAA Installed server.

2. Execute  ./ant.sh to trigger the creation of EAR/ WAR file. 

3. On completion of the EAR files creation, the "BUILD SUCCESSFUL" and "Time taken" message is 
displayed and you will be returned to the prompt.

4. The EAR/ WAR file - <contextname>.ear/ .war - is created. 

Note: The <contextname> is the name given during installation.
This process overwrites any existing version of EAR file that exists in the path.
In case of OFSAA configured on Tomcat installation, <contextname>.war will be created.
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Deploying EAR/WAR File

This section includes the following topics:

• Deploying EAR/WAR Files on WebSphere

• Deploying EAR / WAR File on WebLogic

• Deploying WAR Files on Tomcat

Note: Ensure to clear the application cache prior to the deployment of Application Pack Web Archive. This is 
applicable to all Web Servers (WebSphere, WebLogic, and Tomcat). For more information, see Clearing 
Application Cache section.

Deploying EAR/WAR Files on WebSphere

To deploy WebSphere EAR/WAR File, follow these steps:

1. Start WebSphere Profile by navigating to the path "/<Websphere_Installation_Directory>/IBM/
WebSphere/AppServer/profiles/<Profile_Name>/bin/" and execute the command:

./startServer.sh server1

2. Open the WebSphere admin console in the browser window:

http://<ipaddress>:<administrative console port>/ibm/console. (https if SSL is enabled). The 
Login window is displayed.

3. Enter the user credentials with admin privileges and click Log In.
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4. From the LHS menu, select Applications and click New Application to display the New Application 
window.

5. Click New Enterprise Application to display the Preparing for the application installation window.

6. Select Remote File System and click Browse. Select the EAR file generated for OFSAA to upload and 
install. Click Next. 
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7. Select the Fast Path option and click Next to display the Install New Application window.
Oracle Insurance Performance Insight Application Pack Installation and Configuration Guide - 8.0.7.0.0 117



Post Installation Configuration
8. Enter the required information and click Next to display the Map Modules to Servers window.

9. Select the Web Application and click Next to display the Map Resource References to Resources 
window.

10. Map each resource defined in the application to a resource JNDI name defined earlier.

11. Click Modify Resource Authentication Method and specify the authentication method created earlier.

You can specify "config" for FICMASTER resource or "atomic" for atomic resource as the authentication 
method.
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12. Select the OFSAAI Web Application check box and click Next to display the Map Virtual hosts for Web 
Modules window.

13. Select the Web Application check box and click Next to display the Summary page.

14. Click Finish and deploy the Infrastructure Application on WebSphere.

15. On successful installation, a message is displayed. Click Save and save the master file configuration. The 
details are displayed in the Master File Configuration window.
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To start the application:

1. Expand Applications > Application Type > WebSphere enterprise applications to display the 
Enterprise Applications window.

2. Select the installed application and click Start.

Note: <profile name> is the profile name given while creating the WebSphere profile.
<cell name> is the cell name given during profile creation.
<contextname> is the context name given during installation.

Deploying EAR / WAR File on WebLogic

Following are the steps for deploying Infrastructure application that would be created during installation:

1. Navigate to the path <WebLogic Installation directory>/user_projects/domains/<domain name>/
bin in the machine in which WebLogic is installed.

2. Start WebLogic by executing the command:

./startWebLogic.sh -d64 file

3. Open the URL in the browser window: http://<ipaddress>:<admin server port>/console. (https if 
SSL is enabled). The Sign in window of the WebLogic Server Administration Console is displayed.

Note: Ensure that you have started Infrastructure Server by executing "./reveleusstartup.sh" as mentioned 
in Start Infrastructure section.

4. Log on to the WebLogic Server by entering the user credentials having privileges to deploy the EAR file.
Oracle Insurance Performance Insight Application Pack Installation and Configuration Guide - 8.0.7.0.0 120



Post Installation Configuration
5. From the Domain Structure LHS menu, click Deployments to display the Summary of Deployments 
window.

6. Click Install to display the Install Application Assistant window.

7. Select the Exploded EAR directory after browsing to the directory where it is saved and click Next.

Explode EAR File

To explode EAR, follow the below steps:

1. Create the "applications" folder under domain name. For example:

/Bea/user_projects/domains/ <Domain _name>/applications.

2. Create <context_name>.ear folder under "applications" folder. 

3. Copy the <$FIC_WEB_HOME/<context_name>.ear file to <WEBLOGIC_INSTALL_DIR>/Bea/user_projects/
domains/<DOMAIN_NAME>/applications/<context_name>.ear

4. Explode the <context_name>.ear file by executing the command:

jar -xvf <context_name>.ear

5. Delete the <context>.ear and <context>.war files (recently created) <WEBLOGIC_INSTALL_DIR>/Bea/
user_projects/domains/<DOMAIN_NAME>/applications/<context_name>.ear

6. Create a directory <context_name>.war under <WEBLOGIC_INSTALL_DIR>/Bea/user_projects/
domains/<DOMAIN_NAME>/applications/<context_name>.ear

7. Copy <$FIC_WEB_HOME/<context_name>.war file to <WEBLOGIC_INSTALL_DIR>/Bea/user_projects/
domains/<DOMAIN_NAME>/applications/<context_name>.ear/<context_name>.war

8. Explode the <context_name>.war file by executing the following command to get the directory structure:

jar -xvf <context_name>.war
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Install Application

To install the Application:

1. Open the Install Application Assistant.

2. Click Next.
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3. From the Choose targeting style section, select the Install this deployment as an application option and 
click Next to display the Optional Settings window.

4. Enter a Name for the deployment if required.

5. Under the Security section, select the DD only option to specify that only roles and policies that are defined 
in the deployment descriptors should be used.

6. Select the I will make the deployment available from the following location option under the Source 
accessibility section.
Oracle Insurance Performance Insight Application Pack Installation and Configuration Guide - 8.0.7.0.0 123



Post Installation Configuration
7. Click Next to continue and display the Deployment Summary window.
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8. Select the option Yes, take me to the deployment's configuration screen option and click Finish to 
display the Settings for <Deployment Name> window.

9. Review the general configuration details of the deployment. You can also update the configuration of the 
deployment in this window. In the Overview tab you can view the complete deployment configuration.

10. Click Save to update the changes, if any.

11. From the LHS menu, click Deployments to display the Summary of Deployments window.
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12. Select the newly deployed Infrastructure application and click Start > Servicing all requests. Ensure that 
the Infrastructure server is up and running.

13. The State of the deployed application is displayed as Active if started successfully.
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Deploying WAR Files on Tomcat

Before deploying the WAR files, ensure that the previously deployed applications of Infrastructure are 
uninstalled. See Uninstalling Previously Deployed WAR Files in Tomcat for the procedure to uninstall the 
previously deployed Infrastructure war files.

On the machine that hosts Tomcat, follow the below steps outlined to deploy Infrastructure application:

1. Copy the <context-name>.war from $FIC_WEB_HOME/<context-name.war> to <Tomcat Installation 
Directory>/webapps/ directory. 

2. Click Manager App. The Connect to dialog box is displayed.
Oracle Insurance Performance Insight Application Pack Installation and Configuration Guide - 8.0.7.0.0 127



Post Installation Configuration
3. Enter the User Id and Password that has admin rights and click OK. (For user creation in tomcat, see Tomcat 
User Administration. The Tomcat Web Application Manager window is displayed with the list of all the 
applications deployed.

4. In the Deploy section, enter the Context Path provided during the installation as "/<context-name>".

5. Enter the path where the <context-name>.war file resides (by default "$FIC_WEB_HOME/<context-
name.war>") in the WAR or Directory URL field and click Deploy.

6. On successful application deployment, a confirmation message is displayed. Start the Tomcat server. For 
more information, see Starting Infrastructure Services.
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Accessing the OFSAA Application

This section gives details about the steps to be performed to access OFSAA Application.

To access the OFSAA application:

1. From a your desktop, open the browser and enter the URL in below format:

<scheme>://<IP address/ hostname>:<port>/<context-name>/login.jsp

For example: https://111.222.333.444:5555/ofsaa/login.jsp

The OFSAA login window is displayed as below:

2. With installation of every OFSAA Application Pack, there are two seeded user profiles configured in the 
system:

 SYSADMN - System Administrator

 SYSAUTH - System Authorizer

Note: For SYSADMN and SYSAUTH, the default password is password0.

3. Login to the application using the "SYSADMN" User ID. (Note that, there is no "I" in the SYSADMN login 
USER ID). Enter the password that was provided during installation. On the first login, you will be prompted 
to change the password.
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OFSAA Landing Page

This section includes the following topics:

• OFSAA Landing Page for OIPI Administrator

• Enabling a Product within an Application Pack

OFSAA Landing Page for OIPI Administrator

On successful authentication, the OFSAA Landing Page is displayed. This is a common landing page for all 
users until a preferred application landing page is set by the user in his preferences.

The landing page includes multiple tabs and each tab has specific links to OFSAA Infrastructure and/or 
Application modules. The tabs and links are displayed based on the OFSAA Application accessed and the 
access roles mapped to the logged in user.

Each tab contains LHS Menu and RHS Menu. The LHS Menu holds link(s) to modules in a tree structure. The 
RHS Menu holds link(s) to modules in a navigational panel format.

The following tabs are available in the Landing Page:

• Applications tab

• Object Administration tab

• System Configuration & Identity Management tab

Applications tab

This tab lists the various OFSAA Applications that are installed in the OFSAA setup. The Select Application 
drop-down list displays the OFSAA Applications, based on the logged in user and mapped OFSAA Application 
User Group(s). Links to related modules within Applications and Infrastructure are grouped appropriately to 
maintain a unified experience.
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Object Administration tab

This tab lists the various OFSAA Information Domains created in the OFSAA setup. The Select Information 
Domain drop-down list displays the OFSAA Information Domains based on the logged in user and mapped 
OFSAA Application User Group(s). Links to modules that enable object traceability and migration of objects are 
grouped in this tab.

System Configuration & Identity Management tab

This tab lists the OFSAA Infrastructure System Configuration and Identity Management modules. These 
modules work across Applications/ Information Domains and hence there are no Application and Information 
Domain drop-down lists in this tab. Links to modules that allow the maintenance of setup installation and identity 
management tasks are grouped together in this tab.

Note: The navigation path differs from Application to Application. That is, based on the selected Application, 
the navigation varies.

For more details on how to operate on each tab, see OFSAAI User Guide available in OHC.

Enabling a Product within an Application Pack

You can also enable a product/ application within an application pack post installation at any point of time.

To enable a product through the application UI, follow these steps:

1. Login to the application as SYSADMN user or any user with System Administrator privileges.

2. Navigate to System Configurations & Identity Management tab, expand Administration and 
Configuration and select System Configuration.

3. Click Manage OFSAA Product License(s) to display the Manage OFSAA Product License(s) window is 
displayed.
Oracle Insurance Performance Insight Application Pack Installation and Configuration Guide - 8.0.7.0.0 131

https://docs.oracle.com/cd/E60058_01/homepage.htm


Post Installation Configuration
4. Select an Application pack to view the products in it. The products are displayed in the Products in the 
Application Pack grid.

5. Select the check box to enable a product within the Application Pack which is not enabled during installation.

6. Click VIEW LICENSE AGREEMENT to view the license information. The License Agreement section is 
displayed.

7. Select the option I ACCEPT THE LICENSE AGREEMENT and click ENABLE. A pop-up message 
confirmation is displayed showing that the product is enabled for the pack.

Note: To use the newly enabled product, you need to map your application users to the appropriate product 
specific User_Group(s) and subsequently, authorize the actions by logging in as System Authorizer.

For more information, see Mapping/Unmapping Users section in the Oracle Financial Services 
Analytical Applications Infrastructure User Guide 8.0. To identify the newly enabled product specific 
UserGroups/ Application Pack specific User_Groups, see the respective Application Pack specific 
Installation and Configuration Guide/ User Manual.
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User Group Mapping

Application specific User Group mappings:

• UGOIPIGIADMIN - for OIPAUSER

Additionally, the following user groups are introduced for GDPR compliance:

• Data Controller: This group has the privileges to maintain the PII list and Redaction policies against them. 
This group also has the privilege to ensure the Right to be Forgotten.

• Data Security Group: This group has the privileges to see the PII in un-redacted manner when the reports 
are accessed through OBIEE.
Oracle Insurance Performance Insight Application Pack Installation and Configuration Guide - 8.0.7.0.0 133



Post Installation Configuration
Create and Deploy the Application Pack Web Archive

On successful installation of the OFSAA Application Pack, the web archive file is automatically generated. 
However, you need to deploy the generated web archive file on the Web Application Server. 

For identifying the location of the generated web archive file and for generating and deploying the web archive 
file at any time later, see Creating EAR/WAR File and Deploying EAR/WAR File sections.

Note: See the Oracle Financial Services Forms Manager User Guide for instructions on Creating and 
Deploying the Forms Manager Web Archive.

Patching Your OFS OIPI Pack Installation

Oracle strongly recommends installing the latest available patch set so as to be up to date with the various 
releases of the OFSAA Infrastructure product.

See http://support.oracle.com for more information on latest releases.
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CHAPTER 6 – RPD/ CATALOG DEPLOYMENT AND MAP VIEW 
CONFIGURATION FOR OBIEE 11G

This chapter includes the following topics:

• Deploying OIPI Pack Dashboards and Analytics

• Mapview Configuration

Deploying OIPI Pack Dashboards and Analytics

This section covers the following topics:

• Installing OBIEE Server

• Installing OBIEE Windows Administration Client

• Deploying OIPI Pack Report Analytics

Installing OBIEE Server

To install Oracle Business Intelligence Enterprise Edition (OBIEE) server, see the Oracle Fusion Middle ware 
Installation Guide for Oracle Business Intelligence11g Release 1 (11.1.1.9.5). After installing Oracle Business 
Intelligence Enterprise Edition (OBIEE) server, get the Enterprise Manager URL, username, password, and 
OBIEE installed directory from the System Administrator.

Installing OBIEE Windows Administration Client

To install OBIEE repository administration client for Windows machine, see the Oracle® Fusion Middle ware 
Installation Guide for Oracle Business Intelligence11g Release 1 (11.1.1.9.0).
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Deploying OIPI Pack Report Analytics

To deploy Analytic Reports, follow these steps:

1. Copy OIPI9.rpd and OIPI.catalog files from /scratch/806user/FIC_HOME/OIPIGI/OBIEE/11.1.1.9.5 
of Web layer to windows machine where the OBIEE windows administration client is installed and deploy. 
For the more information on deployment, refer to your OBIEE 11g documentation.

2. Open the OIPI9.rpd file online with default password as Admin123.

3. Configure the Connection Pool details according to the atomic schema.

4. Click File menu and then click Save.

5. Click Yes on the pop-up message Do you want to check global consistency?

6. Click OK, on the pop-up message Consistency check didn't find any errors, warning or best practices 
violations.

Note: Warnings on consistency check can be ignored.
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Mapview Configuration

This section provides information on prerequisites, creating the mapviewer NAVTEQ data source, configuration 
edits and server starting which is required for viewing map based reports of IPA and RPA.

Note: This is just a sample configuration working on sample data provided by NAVTEQ.

This section covers the following topics:

• Prerequisites

• Creating the Mapviewer NAVTEQ Data source

• Loading FSI_LOCATION_MAP_COORD for viewing NAVTEQ Maps

Prerequisites

NAVTEQ database dump can be imported only into an Oracle 11g database. If you have no other option than 
using a 10g version, contact OBIEE/Mapviewer Product Management.

Creating the Mapviewer NAVTEQ Data source

Ensure that you have a connection to 11g Oracle database from the machine where your OBIEE platform is 
installed.

Create a NAVTEQ schema within that database for holding the NAVTEQ spatial data.

To create NAVTEQ schema, perform the steps as explained in the following section.

Downloading the Mapviewer NAVTEQ Database Dump

To download the Mapviewer NAVTEQ Database Dump, follow these steps:

1. Access the NAVTEQ Data Bundle for OBIEE from the ‘OBIEE 11.1.1.3 - Sample Application’:

http://www.oracle.com/technetwork/middleware/bi-foundation/obieesamplesarchive-2026956.html

2. Download and unzip the SampleApp_Navteq_dmp.zip file that contains an Oracle Database export file 
named:

obiee_navteq.dmp
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Creating NAVTEQ User

To create a NAVTEQ user, follow these steps:

1. Start a SQL*Plus session to the Oracle Database as a user with system or DBA privileges.

2. Run the following script:

create user obiee_navteq identified by obiee_navteq default tablespace users quota 
unlimited on users;

grant "connect" to obiee_navteq;

grant "resource" to obiee_navteq;

3. Once the script is executed, verify whether you can connect to the newly created user.

Note: The OBIEE_NAVTEQ user creation script defaults with the password obiee_navteq (same as user 
name) within the script. It is recommended that you keep this value unchanged to simplify configuration.

Importing the database dmp file

4. Import the Oracle Database export file - obiee_navteq.dmp into the obiee_navteq schema using the 
following import command, from the command line (Command Prompt in Windows):

c:\> imp obiee_navteq/obiee_navteq@connectString file=obiee_navteq.dmp FULL=Y

5. ConnectString is the connection string to your Oracle Database 11g where the user obiee_navteq was 
created in the step mentioned earlier. Wait for the import process to complete, once successfully completed, 
login on your DB as obiee_navteq/obiee_navteq and validate that you can view the schema tables and 
some data.

Inserting Extra Spatial Metadata

6. Start a SQL*Plus session to the Oracle Database and connect as user obiee_navteq. 

For example: c:\>sqlplus obiee_navteq/obiee_navteq@connectString

7. Run the following script:

INSERT INTO user_sdo_maps SELECT * FROM my_maps;

INSERT INTO user_sdo_themes SELECT * FROM my_themes;

INSERT INTO user_sdo_styles SELECT * FROM my_styles;

INSERT INTO user_sdo_cached_maps SELECT * FROM my_tile_cache;

Commit;

MapViewerConfig.xml Edits

1. Open the Mapviewer console using the following URL:

http://<ip address>:<port>/mapviewer

2. Click Admin.

3. Login with the username/password that you provided while installing the product.

4. Click Configuration. This opens the mapViewerConfig.xml on your setup.
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5. Make the following updates to the xml file.

<security_config> (Optional)

In the <security_config> property of this file, make the following changes:

a. Change the <proxy_enabled_hosts> property to the following: Substitute the hostname, IP address 
and port to the correct values on your setup.

<proxy_enabled_hosts>

http://<ip address>:<port>/mapviewer

http://<ip address>:<port>/, http://<ip address>:<port>/

http://<ip address>:<port>/mapviewer

</proxy_enabled_hosts>

b. Substitute any entries with these tags with the following property entries:

<disable_direct_info_request> true </disable_direct_info_request>

<disable_info_request> true </disable_info_request>

<disable_csf>true</disable_csf>

<enforce_security_role> true </enforce_security_role>

Predefined Data Sources

1. At the end of the file, in the section named Predefined Data Source, add the following data source entry.

2. Replace the IP address, SID, and port to the correct values of the database where the obiee_navteq 
schema has been created in the above steps.

<map_data_source name="OBIEE_NAVTEQ_SAMPLE"

jdbc_host="10.229.147.238" (use your db ip)

jdbc_sid="orcl" (use your db sid)

jdbc_port="1521" (use your db port)

jdbc_user="obiee_navteq"

jdbc_password="!obiee_navteq" (use your selected password if different from OOB)

jdbc_mode="thin"

number_of_mappers="3"

allow_jdbc_theme_based_foi="false" />

Note: Ensure that all tags have been closed correctly and also the above data source is not within the 
comments section (ensure that it is outside the comments section which is represented by <!-- .. -->).

3. Click Save and Restart button at the bottom of the file.

4. Once configuration.xml file is restarted, click Data Sources.

5. Verify whether you can view OBIEE_NAVTEQ_SAMPLE as an entry in data sources.

6. Select the radio button OBIEE_NAVTEQ_SAMPLE.

7. Login to Analytic screen > Administration.

8. Click Manage map Data.
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9. Click Import Layer and then choose OBIEE_COUNTRY. 

10. Choose Preview MAP as OBIEE_WORLD_MAP_FAST.

11. Same for OBIEE STATE.

12. Select Background Maps.

13. Use import Background maps and chosen OBIEE_WORLD_MAP_FAST.

14. Edit the same, add layer OBIEE COUNTRY and then OBIEE STATE. While choosing, chose the location 
OBIEE_WORLD_MAP for higher Zoom value.

15. Select the zoom level for country 0 and for country 2...15.

16. Navigate back to Layers tab.

17. Edit OBIEE COUNTRY, OBIEE STATE and OBIEE CITY by adding BI Key Columns:

For Country:

a. Choose Insurance Claims > Location Map > Country Description

b. Choose Insurance Policy > Location Map > Country Description

c. Choose Insurance Quotes > Location Map > Country Description

For State:

a. Choose Insurance Claims > Location Map > State Description

b. Choose Insurance Policy > Location Map > State Description

c. Choose Insurance Quotes > Location Map > State Description

For City:

a. Choose Insurance Claims > Location Map > City Description

b. Choose Insurance Policy > Location Map > City Description

c. Choose Insurance Quotes > Location Map > City Description
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Loading FSI_LOCATION_MAP_COORD for viewing NAVTEQ Maps

For NAVTEQ Maps to work, it requires the location data in our atomic schema to be in sync with the map 
Metadata in NAVTEQ schema. This is achieved through a new table FSI_LOCATION_MAP_COORD, the load 
process of which is described as follows.

Populate FSI_LOCATION_MAP_COORD based on DIM_LOCATION data itself, but description and codes should 
come from tables OBIEE_COUNTRY, OBIEE_STATE, OBIEE_CITY (from the DB schema configured for Maps, 
'OBIEE_NAVTEQ', for example in this case) respectively for Country, State and City, and n_location_skey should 
be the corresponding n_location_skey from DIM_LOCATION.

For Instance, let us consider the following data from DIM_LOCATION.

Now, to populate the following columns in FSI_LOCATION_MAP_COORD:

N_LOCATION_SKEY 1

V_LOCATION_CODE HAW

V_COUNTRY_CODE USA

V_COUNTRY_DESC United States

V_STATE_CODE HI

V_STATE_DESC Hawaii

V_CITY_CODE CITI1

V_CITY_DESC Honolulu

V_ZIP_CODE 96813

n_location_skey = 1

v_country_code = OBIEE_COUNTRY.ISO_COUNTRY_CODE USA

v_country_code_map = OBIEE_COUNTRY.ISO_COUNTRY_CODE USA

v_country_desc = OBIEE_COUNTRY.NAME United States

v_state_code = OBIEE_STATE.ISO_CTRY_CD_STATE_ABBRV USA_HI

v_state_code_map = OBIEE_STATE.ISO_CTRY_CD_STATE_ABBRV USA_HI

v_state_desc = OBIEE_STATE.STATE_NAME HAWAII

v_city_code = OBIEE_CITY.CTRY_CD3_STATE_ABBRV_CITY USA_HI_Honolulu

v_city_code_map = OBIEE_CITY.CTRY_CD3_STATE_ABBRV_CITY USA_HI_Honolulu

v_city_desc = OBIEE_CITY.CITY_NAME HONOLULU

v_zip_code = 96813
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CHAPTER 7 – RPD/ CATALOG DEPLOYMENT AND MAP 
CONFIGURATION FOR OBIEE12C

This chapter includes the following topics:

• Deploying OIPI Pack Dashboards and Analytics

• Mapview Configuration for OBIEE 12C

Deploying OIPI Pack Dashboards and Analytics

This section covers the following topics:

• Installing OBIEE Server

• Installing OBIEE Windows Administration Client

• Deploying OIPI Pack Report Analytics

Installing OBIEE Server

To install Oracle Business Intelligence Enterprise Edition (OBIEE) server, see the Oracle Fusion Middle ware 
Installation Guide for Oracle Business Intelligence Release 12.2.1.3.0. After installing Oracle Business 
Intelligence Enterprise Edition (OBIEE) server, get the Enterprise Manager URL, username, password, and 
OBIEE installed directory from the System Administrator.

Note: From the OFS OIPI Release 8.0.6.0.0 onwards, the OBIEE version 12.2.1.2.0 will not have support and 
enhancements. All the existing reports work same as the previous versions, but the new developments 
will not function in 12.2.1.2.0 version of OBIEE.

Once the OBIEE server is installed, it should be upgraded to the version as mentioned in the 
Environment section.

Installing OBIEE Windows Administration Client

To install OBIEE repository administration client for Windows machine, see the Oracle® Fusion Middle ware 
Installation Guide for Oracle Business Intelligence Release 12.2.1.3.0.
Oracle Insurance Performance Insight Application Pack Installation and Configuration Guide - 8.0.7.0.0 142



RPD/ Catalog Deployment and Map Configuration for OBIEE12c
Deploying OIPI Pack Report Analytics

To deploy Analytic Reports, follow these steps:

1. Copy OIPI.rpd and OIPI.catalog files from $FIC_HOME/OFSPMPACKBI/OBIEE/ 12.2.1.2.0/ of Web 
layer to windows machine where the OBIEE windows administration client is installed and deploy. For the 
more information on deployment, refer to your OBIEE 11g documentation.

2. Open the OIPI.rpd file online with default password as Admin123.

3. Configure the Connection Pool details according to the atomic schema.

4. Click File menu and then click Save.

5. Click Yes on the pop-up message Do you want to check global consistency?

6. Click OK, on the pop-up message Consistency check didn't find any errors, warning or best practices 
violations.

Note: Warnings on consistency check can be ignored.

Post Installation Changes in instanceconfig.xml File

Do the following changes in the instanceconfig.xml file as post installation changes:

1. Backup and edit the instanceconfig.xml file located at:

$ORACLE_HOME/user_projects/domains/bi/config/fmwconfig/biconfig/OBIPS

2. Save and exit the file.

3. Restart the presentation server for the changes to take effect.

Tag to be changed Changes

<Views> <Views> 

<Charts> 

<DefaultWebImageType>flash</DefaultWebImageType> 

</Charts> 

</Views>

<Security> <Security>

<CheckUrlFreshness>false</CheckUrlFreshness>

<EnableSavingContentWithHTML>true</
EnableSavingContentWithHTML>

</Security>
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Mapview Configuration for OBIEE 12C

This section provides information on prerequisites, creating the mapviewer mvdemo2 data source, configuration 
edits and server starting.

Note: This is just a sample configuration working on sample data provided by mvdemo2.

This section covers the following topics:

• Prerequisites

• Creating the Mapviewer mvdemo2 Data source

• Loading FSI_LOCATION_MAP_COORD for viewing mvdemo2 Maps

Prerequisites

The mvdemo2 database dump can be imported only into an Oracle 12c database. If you have no other option 
than using a 11g version, contact OBIEE/Mapviewer Product Management.

Creating the Mapviewer mvdemo2 Data source

Ensure that you have a connection to 12c Oracle database from the machine where your OBIEE platform is 
installed.

Create a mvdemo2 schema within that database for holding the mvdemo2 spatial data.

To create mvdemo2 schema, perform the steps as explained in the following section.

Downloading the Mapviewer mvdemo Database Dump

To download the Mapviewer mvdemo2 Database Dump, follow these steps:

1. Download MVDEMO Sample Data Set from the following location:

http://www.oracle.com/technetwork/middleware/mapviewer/downloads/index.html

2. Download and unzip the mvdemo_naturalearth.zip file that contains an Oracle Database export file named:

mvdemo_naturalearth.dmp

Creating mvdemo2 User

To create a mvdemo2 user, follow these steps:

1. Start a SQL*Plus session to the Oracle Database as a user with system or DBA privileges.

2. Run the following script:

create user mvdemo2 identified by mvdemo2 default tablespace users quota unlimited on 
users;

grant "connect" to mvdemo2;

grant "resource" to mvdemo2;
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3. Once the script is executed, verify whether you can connect to the newly created user.

Note: The mvdemo2 user creation script defaults with the password mvdemo2 (same as user name) within 
the script. It is recommended that you keep this value unchanged to simplify configuration.

Importing the database dmp file:

4. Import the Oracle Database export file - mvdemo_naturalearth.dmp into the mvdemo2 schema using the 
following import command, from the command line (Command Prompt in Windows):

c:\> imp mvdemo2/mvdemo2@connectString file=mvdemo_naturalearth.dmp FULL=Y

5. ConnectString is the connection string to your Oracle Database 12c where the user mvdemo2 was created 
in the step mentioned earlier. Wait for the import process to complete, once successfully completed, login 
on your DB as mvdemo2/mvdemo2 and validate that you can view the schema tables and some data.

Inserting Extra Spatial Metadata:

6. Start a SQL*Plus session to the Oracle Database and connect as user mvdemo2. 

For example: c:\>sqlplus mvdemo2/mvdemo2@connectString

7. Run the following script:

insert into user_sdo_styles select * from styles;

insert into user_sdo_themes select * from themes;

insert into user_sdo_maps select * from basemaps;

insert into user_sdo_cached_maps select * from tilelayers;

commit;

MapViewerConfig.xml Edits

1. Open the Mapviewer console using the following URL:

http://<ip address>:<port>/mapviewer

2. Click Admin.

3. Login with the username/password that you provided while installing the product.

4. Click Configuration. This opens the mapViewerConfig.xml on your setup.

5. In the section named Predefined Data Source, add the following data source entry:

Replace the IP address, SID, and port to the correct values of the database where the mvdemo2 schema 
has been created in the above steps.

<map_data_source name="mvdemo2"

jdbc_host="10.229.147.238" (use your db ip)

jdbc_sid="orcl" (use your db sid)

jdbc_port="1521" (use your db port)

jdbc_user="mvdemo2"

jdbc_password="!mvdemo2" (use your selected password if different from OOB)

jdbc_mode="thin"

number_of_mappers="3"
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allow_jdbc_theme_based_foi="false"

editable="false"

/>

Note: Ensure that all tags have been closed correctly and also the above data source is not within the 
comments section (ensure that it is outside the comments section which is represented by <!-- .. -->).

6. Click Save and Restart button at the bottom of the file.

7. Once configuration.xml file is restarted, click Data Sources.

8. Verify whether you can view mvdemo2 as an entry in data sources.

9. Login to Analytic screen > Administration.

10. Click Manage map Data.

11. Click Import Layer and then choose World_Countries.

12. Choose Preview MAP as ORACLE_MAPS.

13. Same for World_States_Provinces.

14. Choose Preview MAP as ORACLE_MAPS.

15. Select Background Maps.

16. Use import Background maps and chosen ORACLE_MAPS.

17. Edit the same, add layer World_Countries and then World_States_Provinces. While choosing, chose the 
location ORACLE_MAPS for higher Zoom value.

18. Select the zoom level for country 0 and for country 2...15.

19. Navigate back to Layers tab.

20. Edit World_Countries (select Name as the Layer Key) and World_States_Provinces (select State 
Province Name as the Layer Key) by adding BI Key Columns:

For Country:

a. Choose Insurance Claims > Location Map > Country Description

b. Choose Insurance Policy > Location Map > Country Description

c. Choose Insurance Quotes > Location Map > Country Description

For State:

a. Choose Insurance Claims > Location Map > State Description

b. Choose Insurance Policy > Location Map > State Description

c. Choose Insurance Quotes > Location Map > State Description

For City:

a. Choose Insurance Claims > Location Map > City Description

b. Choose Insurance Policy > Location Map > City Description

c. Choose Insurance Quotes > Location Map > City Description
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Loading FSI_LOCATION_MAP_COORD for viewing mvdemo2 Maps

For mvdemo2 Maps to work, it requires the location data in our atomic schema to be in sync with the map 
Metadata in mvdemo2 schema. This is achieved through a new table FSI_LOCATION_MAP_COORD, the load 
process of which is described as follows.

Populate FSI_LOCATION_MAP_COORD based on DIM_LOCATION data itself, but description and codes should 
come from tables OBIEE_COUNTRY, OBIEE_STATE, OBIEE_CITY (from the DB schema configured for Maps, 
'mvdemo2', for example in this case) respectively for Country, State and City, and n_location_skey should be 
the corresponding n_location_skey from DIM_LOCATION.

For Instance, let us consider the following data from DIM_LOCATION.

Now, to populate the following columns in FSI_LOCATION_MAP_COORD:

N_LOCATION_SKEY 1

V_LOCATION_CODE HAW

V_COUNTRY_CODE USA

V_COUNTRY_DESC United States

V_STATE_CODE HI

V_STATE_DESC Hawaii

V_CITY_CODE CITI1

V_CITY_DESC Honolulu

V_ZIP_CODE 96813

n_location_skey = 1

v_country_code = OBIEE_COUNTRY.ISO_COUNTRY_CODE USA

v_country_code_map = OBIEE_COUNTRY.ISO_COUNTRY_CODE USA

v_country_desc = OBIEE_COUNTRY.NAME United States

v_state_code = OBIEE_STATE.ISO_CTRY_CD_STATE_ABBRV USA_HI

v_state_code_map = OBIEE_STATE.ISO_CTRY_CD_STATE_ABBRV USA_HI

v_state_desc = OBIEE_STATE.STATE_NAME HAWAII

v_city_code = OBIEE_CITY.CTRY_CD3_STATE_ABBRV_CITY USA_HI_Honolulu

v_city_code_map = OBIEE_CITY.CTRY_CD3_STATE_ABBRV_CITY USA_HI_Honolulu

v_city_desc = OBIEE_CITY.CITY_NAME HONOLULU

v_zip_code = 96813
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CHAPTER 8 – FAQS AND ERROR DICTIONARY

This chapter consists of resolution to the frequently asked questions and error codes noticed during OFSAAI 
installation.

• Frequently Asked Questions

• Forms Framework FAQs

• Error Dictionary

OFSAAI installer performs all the prerequisite validation check during installation. Any errors encountered in the 
process is displayed with an appropriate Error Code. You can see the Error Dictionary to find the exact cause 
and resolution to rectify the error.This chapter includes the following topics:

Frequently Asked Questions

You can refer to the Frequently Asked Questions which has been developed with the interest to help you resolve 
some of the OFSAAI Installation and configuration issues. This intends to share the knowledge of problem 
resolution to a few of the known issues. This is not an official support document and just attempts to share the 
knowledge of problem resolution to a few of the known issues. 

This section includes the following topics:

• OFSAAI FAQs

• Application Pack 8.0.7.0.0 FAQs

OFSAAI FAQs

What are the different components that get installed during OFSAAI?

The different components of OFSAAI are illustrated in figure in the section Components of OFSAAI.

What are the different modes of OFSAAI installation?

OFSAAI can be installed in two modes, Silent Mode, and GUI mode.

Can the OFSAA Infrastructure components be installed on multi-tier?

No. OFSAA Infrastructure components (ficapp, ficweb, ficdb) cannot be installed on multi-tier. By default, 
they will be installed on single-tier. However, OFSAA Infrastructure can be deployed within the n-Tier 
architecture where the Database, Web Server and Web Application Server is installed on separate tiers.

Is JDK (Java Development Kit) required during installation of OFSAA? Can it be uninstalled after OFSAA 
installation?

JDK is not required during installation of OFSAA and only a run time is needed for details. Refer to Hardware 
and Software Requirements, Java Runtime Environment section.
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Is JRE required during installation of OFSAA? Can it be uninstalled after OFSAAI installation?

Only JRE (Java Runtime Environment) is required during installation of OFSAA and cannot be uninstalled 
as the JRE is used by the OFSAA system to work.

How do I know what is the Operating system, web servers and other software versions that OFSAA supports?

Refer to OFSAA Technology Stack Matrices.

What are the different files required to install OFSAAI?

To install OFSAAI, the following files are required:

 setup.sh.

 envCheck.sh

 preinstallcheck.sh

 VerInfo.txt

 OFSAAInfrastructure.bin

 validatedXMLinputs.jar

 MyResources_en_US.properties

 log4j.xml

 OFSAAI_PostInstallConfig.xml

 OFSAAI_InstallConfig.xml

 privileges_config_user.sql

 privileges_atomic_user.sql

 XML_Utility.jar

What should I do if I get the following error message during installation, "Execute Permission denied"?

Please check whether all the files provided for OFSAAI installation has execute permissions. 

To give execute permissions, navigate to the path OFSAAI_80000 and execute the command:

chmod 755

"Graphical installers are not."

If error resembles "Graphical installers are not supported by the VM. The console mode will be used 
instead..." then check whether any of the X-windows software has been installed.

Example: Hummingbird Exceed is started and configured to Graphical mode installation.

Note: Type 'xclock' from prompt and this should display clock in graphical mode.

"No Java virtual machine could be…"

If the error message reads "No Java virtual machine could be found from your PATH environment variable. 
You must install a VM prior to running this program", then

 Check whether "java path" is set in PATH variable. See the Installer and Installation Prerequisites 
section in this document.

 Check whether sufficient temporary space is available.
Oracle Insurance Performance Insight Application Pack Installation and Configuration Guide - 8.0.7.0.0 149



FAQs and Error Dictionary
 Ensure that the movement of OFSAAI Installer text files to the target system is done in the Text mode 
so that setup.sh file does not contain control line feed characters (^M).

What should I do if I get the following error message during installation, "OracleDriver Files Not Found, Please 
Choose the Right Path To Continue"?

Check whether the provided path for Oracle Driver files is correct and whether the user has permissions to 
access the files.

What should I do if I get the following error message during installation, "User must have CREATE TABLE, 
CREATE VIEW, CREATE TRIGGER, CREATE INDEX, CREATE SEQUENCE, CREATE PROCEDURE" even 
though the oracle schema user created has the mentioned privileges?

OFSAAI installer validates the database details provided during installation, so ensure:

 Whether the oracle schema user has the required set of privileges for successful installation.

 Whether the oracle schema user has been created with quota privileges on tablespace to create 
database objects.

 See the Installer and Installation Prerequisites section in this document.

Installation of OFSAAI was completed successfully! What next?

Post the successful completion of OFSAAI installation, one has to perform the Post Installation steps. See 
Post Installation Configuration. 

What is to be done when OFSAAI Installation is unsuccessful?

OFSAAI installer generates log file OFSAAInfrastructure_Install.log in the Infrastructure Installation 
Directory. There is also another log file created in the path configured in Log4j.xml. The logs of any of 
these reported, Warnings/Non Fatal Errors/Fatal Errors/Exceptions should be brought to the notice of 
the OFSAAI Customer Support. It is recommended not to proceed, until the reported problems are 
adequately addressed.

How do I completely uninstall OFSAAI?

OFSAAI can be completely uninstalled by performing the steps provided in Uninstalling OFSAA 
Infrastructure in the OFS AAAI Installation and Configuration Guide Release 8.0.6.0.0.

Can OFSAAI config and atomic schemas be on different databases?

OFSAAI requires both config and atomic schemas to be present on the same database instance.

How to grant privileges if a new information domain is created?

If you are creating a new information domain, provide a set of privileges (database permissions) to the new 
Atomic schema.

 Log into the database as sys and connect as sysdba user.

 Execute the file privileges_config_user.sql available under $FIC_HOME directory

 Enter the database schema for which you want to grant privileges.
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When should I run the MLS utility?

See the Multiple Language Support (MLS) Utility section in OFSAAI Administration Guide available on OHC.

Does OFSAAI support Oracle Linux versions other than 5.5?

OFSAAI supports the Oracle Linux versions from 5.5 up to 5.10 and also from 6.0 and above.

What should I do if I get the following error message on the UNIX System terminal while executing ./setup.sh, 
"Insert New Media. Please insert Disk1 or type its location"?

a. Login as root user on the Unix machine where OFSAAI is getting installed.

b. Navigate to the path /etc/security/. 

c. Edit the file limits.conf to add/edit a row for the UNIX user installing OFSAA:

<Unix User> soft nofile 9216

d. After saving the changes, log in as UNIX user with which OFSAAI is getting installed and execute the 
command:

ulimit -n

The command should return the value 9216.

How does one verify if the system environment is ready for OFSAAI installation?

To verify the system environment meets the minimum requirements for the installation, a Pre-Install Check 
utility is available within the Install Kit archive file. This utility can also be obtained separately by contacting 
Oracle Support.

See Verifying the System Environment section for additional information. 

How do I know if the installation is completed successfully?

The OFSAA Infrastructure installation performs a post install health check automatically on successful 
installation of the product. To rerun the post install verification at a later time, perform the following steps:

a. Navigate to the path $FIC_HOME (Product Installation Directory).

b. Execute the command:

./piverify.sh

What should one do if the installation in GUI mode is not invoked?

There are set of configuration steps required to be performed during the installation in GUI mode. Verify 
whether the steps mentioned under Configuration for GUI Mode Installation section are done correctly. 

What should one do if there are any exceptions or errors in installation and how to proceed?

a. Please backup the installation logs.

b. Share the backup logs with Oracle support.

What should I do if I get the following error message during OFSAAI installation on Solaris 11 system?

"Error: OFSAAI-1108

ORA-00604: error occurred at recursive SQL level 1

ORA-01882: timezone region not found"
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Or

"Time zone cannot be set as null or 'localtime' "

This happens if the time zone is not set, that is NULL or it is set as 'localtime'. Set the environment variable 
TZ to a valid time zone region in the .profile file. For example:

TZ=Asia/Calcutta

export TZ

What should I do if the installation process is abruptly terminated or aborted?

a. If the installation is abruptly terminated, then the installation process will be incomplete. To recover from 
this, follow the below steps:

b. Drop the DB objects in the config schema created by OFSAAI installation.

c. Open the .profile file and remove the entries made by the OFSAAI installation which are made between 
the comment statements, #Beginning of entries by OFSAA Infrastructure installation and #End of 
entries by OFSAA Infrastructure installation.

d. Delete the OFSAA install directory created by the OFSAAI installer.

e. Perform the OFSAAI installation again. 

Does OFSAA support any other web server types, other than the ones stated in tech matrix and installation 
guide?

No, all the supported softwares and versions are stated in the OFSAA Technology Stack Matrices.

What should one do if the database connection from connection pool throws an error 

"java.sql.SQLRecoverableException: IO Error: Connection reset"?

This happens while running several database intensive tasks in parallel. To correct this error, add the line 
securerandom.source=file:/dev/./urandom in the java.security configuration file available in $JAVA_HOME/
jre/lib/security/ path.

Note: This needs to be configured on all the machines or VMs where the OFSAAI components are 
installed.

If the issue is not resolved even with the above settings, check the MTU (Maximum Transmission Unit) 
settings on the Linux box. For details on MTU settings and updating them, contact your system 
Administrator.

What should I do when I get syntax errors/file not found error messages while invoking setup.sh file from my 
install archive?

This could mostly happen:

 When installer was not unzipped correctly or corrupted during unzip.

 setup.sh file which resides within the install archive was not transferred in ASCII or text mode, which 
could have corrupted the file.

To correct this, follow the steps:
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a. Copy the installer (in BINARY mode) to the system on which the OFSAA Infrastructure components will 
be installed.

b. Unzip the installer using the command:

unzip <OFSAAI_Installer>.zip

c. The corrupted setup.sh file would have introduced certain ^M characters into the file. You can remove 
^M characters from setup.sh file by following the below steps: 

i. Login to the server where the installer is copied. 

ii. Navigate to the directory OFSAAI_80000.

iii. Open the setup.sh file in the vi editor using the command: vi setup.sh.

iv. Inside vi editor in Esc mode, type: %s/^M//g

Note: To enter ^M, hold the CTRL key then press V and M in succession.

v. Save the setup.sh file by typing: wq! 

Does OFSAA support Oracle DB 11g Standard edition?

The OCI client and the jdbc driver does not change depending on whether it is a standard or enterprise 
edition. So, OFSAAI will work with standard edition as well.

We do not recommend standard edition because it will not scale and does not support partition pack, 
database security vault, or advanced analytics.

What should I do if I get the following error message while executing ./reveleusstartup.sh file on the UNIX 
System terminal "./reveleusstartup.sh: /java: Execute permission denied"?

 Ensure JAVA_BIN environment variable path is set on the "UNIX user" terminal from where the 
reveleusstartup.sh file is invoked.

 Ensure the .profile where the environment/ path settings are made has been executed successfully.

What happens when the OFSAAI Application Server does not proceed even after providing the system 
password?

Ensure that, the System Password provided when prompted should match with the "Oracle Configuration 
password" provided during installation. Also check whether the connection to the "configuration schema" 
can be established through sqlplus.

Although the OFSAAI installation has completed successfully, when OFSAAI servers are started, and the 
application URL is accessed, it gives an error message "the page cannot be found or displayed" or "Could not 
retrieve list of languages from Server. Please contact the system administrator". What should one do?

Ensure OFSAAI servers have been started and are running successfully. On the server start up parameters 
options, see the Starting Infrastructure Services section.

For more details on the issue, refer on to the Revappserver log in $FIC_APP_ HOME/common/FICServer/
logs directory or the Web Server log files.

Is it necessary to provide the specified grants to the Oracle schema user before installation? If yes, can it be 
revoked after completion of installation?
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The "Oracle schema" user requires the necessary grants specified before, during, and after the installation 
process. Grants provided should never be revoked as the application makes use of these grants all the time.

Can we have distributed OFSAAI Application Server for load balancing?

OFSAAI Application server can be scaled out/distributed across different JVM's (machines) based on the 
various services and Information Domains, in other words, Load balancing could be achieved with 
distribution of services.

Why do we need Ftpshare? Why is it needed on all the layers? Can we have ftpshare on another machine other 
than the machines where OFSAAI is installed?

Ftpshare is a Metadata Repository directory. All the Metadata related files used in Infrastructure are stored 
in the ftpshare directory. The ftpshare contains folders for each Information Domain, with each Information 
Domain folders holding Erwin, log, and scripts folder. The transfer of data among the Web, Application, and 
Database servers in Infrastructure takes place through FTP/SFTP.

You need to configure FTP/SFTP and enable communication between the servers by providing App server's 
FTP/SFTP credentials to the Web server and DB server users.

Yes, we can have ftpshare on another machine other than the machines where OFSAAI is installed.

Is it mandatory to provide the ftp/sftp password?

Yes, OFSAAI needs credentials of the user which has complete permissions on ftpshare directory, and 
should be able to independently login to the UNIX server.

What are the permissions required for FTPSHARE and when should I give them?

It is recommended to provide permissions on FTPSHARE in case of installations done across different 
machines or VMs (multi-tier installation).

In case of single tier installation, 770 permissions can be provided if the UNIX users of OFSAAI and web 
server belong to the same UNIX group.

And on any new file that is created in the 'ftpshare' folder of any installation layer should be granted specific/
explicit permission.

Port Change utility can be used to have the Port number modified, which are currently being used by the 
Infrastructure application. For more information, refer Changing IP/ Hostname, Ports, Deployed Paths of the 
OFSAA Instance section in OFS Analytical Applications Infrastructure Administration User Guide in OHC 
Documentation Library.

Are there any in-built system administration users within OFSAAI Application?

The three in-built system administration users are provided to configure and setup OFSAAI.

 SYSADMN 

 SYSAUTH

 GUEST 

Does OFSAAI Application support both FTP and SFTP?

OFSAAI supports both FTP and SFTP configuration.

Is it necessary to enable the FTP/SFTP services to use the OFSAAI?
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Yes, enabling of FTP/SFTP services and its ports is a prerequisite step towards using the OFSAAI.

OFSAAI Configuration: Unable to save the server details?

 Ensure the input User ID, Password, and Share Name are correct.

 Ensure FTP/SFTP services are enabled.

 Have a test FTP/SFTP connection made and confirm if they are successful.

What should I do if I get the following message while creating Information Domain, "Please create a database 
and then create the information domain"?

Information Domain is mapped to only one Database; and thus before the creation of Information Domain, 
at least one database details would need to exist.

What should I do if I get the following message during startup of back-end engine message server, 
"ConnectToDatabase: FatalError, could not connect to the DB server"?

 Verify whether connection to the "configuration schema" can be established through sqlplus.

 Verify "configuration schema" password is modified post installation.

 Ensure oracle database alias name created for oracle instance and oracle service name are same.

 On a multi tier Installation mode, ensure TNSNAME and SID are the same in both the Application and 
Database Layers.

What should I do if I get the following message during the startup of back-end engine message server, "Fatal 
Error, failed to get user ID from LibSmsConnect"?

Ensure Reveleus.sec file exist under the $FIC_HOME/conf directory where the Database components are 
installed.

Does OFSAAI Application support LDAP authentication?

OFSAAI supports LDAP configuration and authentication.

Does OFSAAI support multiple languages?

Yes, OFSAAI supports multiple languages.

Does OFSAAI provide any data back-up features?

OFSAAI does not have built-in back up facility. External Storage Infrastructure is recommended for back-up.

What kind of security features does the OFSAAI provides?

OFSAAI provides security at:

 Segment Level - Users can access only the segment they are mapped to.

 Application Level - Users can perform an operation only if mapped to appropriate role and functions.
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Does OFSAAI have the ability to enforce periodic password change?

OFSAAI provides configurable parameters to define number of days after which the user password would 
expire and then the user is forced to change the password after expiration period.

What is the password policy followed in OFSAAI?

OFSAAI enforces a minimum password length with a combination of Upper and Lower case characters and 
alpha-numeric strings.

Which version of Erwin Data Modeller does OFSAAI support?

The references to Data Modeler ERwin versions 70, 71, 72, 90, 92 and 96 are provided for the AAI 
framework to support these for backward compatibility. However, the data model-slices shipped with OFS 
AAAI 8.0.6.0.0 application packs are compatible with Erwin versions 9.5, 9.6, and 9.7.

Does OFSAAI provide the mechanism to upload Business Data model?

OFSAAI provides two mechanisms for business data model upload:

 Easy to use GUI based Model upload mechanism to upload the Business Data Model through Unified 
Metadata Manager --> Import Model.

 OFSAAI also provides a model upload utility "upload.sh" for uploading the business data model through 
the command line parameter by executing this shell script file under the path <FIC_HOME>/ficapp/
common/FICServer/bin.

See the section Run Model Upload Utility of the Oracle Financial Services Analytical Applications 
Infrastructure User Guide on OHC for details. 

How do I apply incremental change to the existing model when the Business Data model undergoes a change?

Modified data model can be uploaded into the system and OFSAAI has the ability to compare the changes 
within the data model with respect to the one already present in the system and enables propagation of 
incremental changes in a consistent manner.

What are the different types of uploading a business data Model? 

OFSAAI supports uploading of business data model from client desktop and also by picking up the data 
model from the server location.

Can the OFSAAI "Configuration Schema" password be modified post installation?

The OFSAAI Configuration Schema password can be modified post installation. OFSAAI application stores 
the password in the database and few configuration files, thus any changes to the Configuration Schema 
password will require updating in those files. For more information, see OFSAA Infrastructure Config 
Schema Password Modification.

Can the OFSAAI "Atomic Schema" password be modified?

The OFSAAI "Atomic Schema" password can be modified. OFSAAI application stores the atomic schema 
password in the database and few configuration files, thus any change to the atomic schema password 
would necessitate updating the password.

To change the Atomic Schema password, follow the steps:

 Login to OFSAA.
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 Navigate to System Configuration > Database Details window. Select the appropriate connection, 
provide the modified password and save.

 Navigate to Unified Metadata Manager > Technical Metadata> Data Integrator > Define Sources 
window. Update the appropriate Source details.

If you are using Apache Tomcat as Web server: 

 Update the <Context> -> Resource tag details in server.xml file from the $CATALINA_HOME/conf 
folder. (In case of Tomcat only Atomic <Resource> will exist). 

 Login to the WebSphere Administration Console from the left side menu.

 Navigate to Resources >JDBC >Data Sources. A list of data sources will be populated on the right side.

 Select the appropriate Data Source and edit the connection details. (In this case, both Config and 
Atomic data sources need to be modified).

If you are using WebLogic as Web server: 

 Login to the WebLogic Administration Console from the left side menu.

 Under Domain Structure list box, expand the appropriate Domain and navigate to Services > JDBC 
>Data Sources. A list of data sources will be populated on the right side.

 Select the appropriate Data Source and edit the connection details. (In this case, both Config and 
Atomic data sources need to be modified).

Restart the OFSAAI services

If the modified passwords are not updated, OFSAAI logs displays the message ORA-28000: the account is 
locked.

Does the upload of Business Data model depend on Java Memory?

Business data model upload through OFSAAI depends on the Java memory settings on the client and 
server machines. Java memory setting varies with the data model size and the available RAM. Contact 
OFSAAI support for more details.

Why do the Business Metadata Management screens (Business Processors screen) in User Interface, takes 
longer time to load than other screens?

The Log file in DynamicServices.xml which resides in $FIC_HOME/conf is continuously being updated/
refreshed to cache Metadata. This can be observed when you are starting reveleusstartup.sh and if any of 
the log file (Ex: SMSService.log) in DynamicServices.xml is being continuously refreshed for longer time.

By default, the Metadata Log file cache size is set to 1000. If the log is being updated beyond this limit, 
retrospectively the preceding entries are overwritten. For example, the 1001th entry is overwritten by 
deleting the first entry. This results in the application screen taking a longer time to load.

Increase the cache size limit in Dynamicservices.xml located at <FIC_HOME>/conf, depending on the 
currently logged count for the specific Metadata.

 Generate the Log report by executing the below query in config schema.

select count(1), t.metadata_name, m.dsn_id

from metadata_master m, metadata_type_master t 

where m.metadata_type = t.metadata_type

group by t.metadata_name, m.dsn_id
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 The above query returns a list of codes with their respective Metadata count. You can see 
"metadata_type_master" table to identify the Metadata name.

 View the log report to identify the Metadata which is being updated/refreshed beyond the specified 
cache size limit. Accordingly increase the cache size limit in Dynamicservices.xml depending on the 
currently logged count for the specific Metadata.

For example, if the "MEASURE_CACHE_SIZE" is set to 1000 and total measure reported in log is 1022, 
increase the limit to 2000 (approximately).

 Restart Reveleus/OFSAAI servers (Web and APP) and check the issue.

What should I do if I get OutOfMemoryError while deploying EAR file in WebSphere application server?

The Java memory needs to be increased in ejbdeploy.sh file which is present under <WebSphere Install 
directory>/AppServer/deploytool/itp. For example, 

$JAVA_CMD \

-Xbootclasspath/a:$ejbd_bootpath \ 

Xms256m -Xmx1024m \

What configurations should I ensure if my data model size is greater than 2GB?

In order to upload data model of size greater than 2GB in OFSAAI Unified Metadata Manager- Import Model, 
you need to configure the required model size in struts.xml file available in the path $FIC_WEB_HOME/
webroot/WEB-INF/classes.

Note: The size requirements have to be always specified in bytes.

For example, if you need to configure for model size of 2.5GB, then you can approximately set the max size 
to 3GB (3221225472 bytes) as indicated below, in order to avoid size constraints during model upload.

<constant name="struts.multipart.maxSize" value="3221225472"/>

After configuring struts.xml file, generate the application EAR/WAR file and redeploy the application onto 
your configured web application server. For more information on generating and deploying EAR / WAR file, 
see Creating EAR/WAR File and Deploying EAR/WAR File sections.

What should I do if my Hierarchy filter is not reflecting correctly after I make changes to the underlying 
Hierarchy?

In some cases, the Hierarchy Filters do not save the edits correctly if the underlying Hierarchy has been 
changed. This can occur in hierarchy maintenance, where you have moved a member to another hierarchy 
branch, and that member was explicitly selected in the Filter and is now a child of a node which is already 
selected in the Filter.

See the Support Note for the workaround.

How do you turn off unused information domains (infodoms) from cache?

Follow the below steps to turn off unused infodoms from cache:

 Navigate to $FIC_HOME/conf in the APP layer of your OFSAAI installation. 

 In the DynamicServices.xml file, identify the section for <Service code="20">. 
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 Modify the value of parameter CACHE_ON_STARTUP to 0 (default is 1). 

 Repeat the same in the WEB layer too. Generate the application EAR/WAR file and redeploy the 
application onto your configured web application server. For more information on generating and 
deploying EAR / WAR file, see Configuring Web Application Servers.

 Restart the OFSAAI Services (APP and WEB). For more information, see Start/Stop OFSAA 
Infrastructure Services.

Note: This setting will cache the Infodom Metadata only for the infodoms that get accessed upon user 
login. Infodoms which do not get accessed, will not be cached.

Sample code is pasted below: 

<SERVICE CODE="20" 

CLASS="com.iflex.fic.metadata.services.MetadataServiceProvider" NAME="BMD" 

SERVERID="DEFAULT" PATH=" " LOGGERNAME="UMMLOGGER" LOGGERLEVEL="10"> 

<PARAMETERS> 

<PARAMETER NAME="CACHE_ON_STARTUP" VALUE="0" /> 

<PARAMETER NAME="BACKUP_XML" VALUE="1" /> 

<PARAMETER NAME="MAX_BACKUP_XML" VALUE="2" /> 

<PARAMETER NAME="PC_NONBI_BI_SWITCH" VALUE="2048" /> 

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000" /> 

<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHYATTRIBUTE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="RDM_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="LOG_GET_METADATA" VALUE="false" /> 

<PARAMETER NAME="METADATA_PARALLEL_CACHING" VALUE="0" /> 

</PARAMETERS> 

</SERVICE>

Can I install an Application Pack on an existing Atomic schema/ Information Domain created manually?

No, you cannot install an Application Pack on existing Atomic schema/Information Domain created manually. 
Application Packs can be installed only on Atomic Schemas/Information Domain created using schema creator 
utility and/ or the Application Pack installer.
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What should I do if I get the following exception while trying to view the model outputs in Model Outputs screen, 
"Exception ->Local Path/STAGE/Output file name (No such file or directory)"?

Ensure you have created a folder "STAGE" under the path mentioned as "Local Path" in the web server details 
screen. This folder needs to be created under the local path on every node, in case of web application server 
clustering.

What should I do if I get the following exception during OFSAA services startup, "Exception in thread "main" 
java.lang.UnsatisfiedLinkError: net (Not a directory)"?

Ensure the JRE referred in .profile is not a symbolic link. Correct the path reference to point to a physical 
JRE installed.

What is the optimized memory settings required for "New" model upload?

The following table lists the optimized memory settings required for "New" model upload.

What is the resolution if I get the error - ORA 01792 maximum number of columns in a table or view is 1000 
during T2T execution?

You should apply the below patch set from Oracle. Applicable only for 12c.

https://support.oracle.com/epmos/faces/DocumentDisplay?id=1937782.1

Upload Options Size of Data Model XML File X_ARGS_APP ENV Variable in 
OFSAAI APP Layer

Pick from Server 106 MB “-Xms1024m -Xmx1024m

36 MB “-Xms2048m -Xmx2048m

815 MB “-Xms4096m -Xmx4096m

1243 MB “-Xms6144m -Xmx6144m

Model Upload Utility 106 MB “-Xms1024m -Xmx1024m"-
Xms2048m -Xmx2048m

336 MB “-Xms4096m -Xmx4096m

815 MB “-Xms4096m -Xmx4096m

1243 MB “-Xms6144m -Xmx6144m

Save New Erwin File In Server 106 MB “-Xms1024m -Xmx1024m

336 MB “-Xms2048m -Xmx2048m

“-Xms4096m -Xmx4096m

“-Xms6144m -Xmx6144m
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I did not enable OFS Inline Processing Engine Application license during the installation. However, I have 
enabled it post installation, using the Manage OFSAA Product License(s) in the Admin UI. Are there any other 
additional configurations that I need to do?

Yes. Follow the instructions explained in the OFS Inline Processing Engine Configuration Guide available 
on OHC.

I get an error when I try to build an Oracle OLAP cube. What should I do?

Execute the below grant on the appropriate ATOMIC schema 

grant olap_user to &database_username

How do you turn off unused Information Domains (Infodoms) from caching?

Follow these steps to turn off unused infodoms from caching:

 Navigate to $FIC_HOME/conf in the APP layer of your OFSAAI installation.

 In the DynamicServices.xml file, identify the section for <Service code="20">. 

 Modify the value of parameter CACHE_ON_STARTUP to 0 (default is 1). 

 Repeat the same in the WEB layer too. Generate the application EAR/WAR file and redeploy the 
application onto your configured web application server. For more information on generating and 
deploying EAR / WAR file, see Creating EAR/WAR File and Deploying EAR/WAR File sections.

 Restart the OFSAAI Services (APP and WEB). For more information, see the Start/Stop OFSAA 
Infrastructure Services section.

Note: This setting will cache the Infodom Metadata only for the infodoms that get accessed upon user 
login. Infodoms which do not get accessed, will not be cached. 

Sample code is pasted below: 

<SERVICE CODE="20" 

CLASS="com.iflex.fic.metadata.services.MetadataServiceProvider" NAME="BMD" 

SERVERID="DEFAULT" PATH=" " LOGGERNAME="UMMLOGGER" LOGGERLEVEL="10"> 

<PARAMETERS> 

<PARAMETER NAME="CACHE_ON_STARTUP" VALUE="0" /> 

<PARAMETER NAME="BACKUP_XML" VALUE="1" /> 

<PARAMETER NAME="MAX_BACKUP_XML" VALUE="2" /> 

<PARAMETER NAME="PC_NONBI_BI_SWITCH" VALUE="2048" /> 

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000" /> 

<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHYATTRIBUTE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000" />
Oracle Insurance Performance Insight Application Pack Installation and Configuration Guide - 8.0.7.0.0 161

https://docs.oracle.com/cd/E60058_01/ipe.htm


FAQs and Error Dictionary
<PARAMETER NAME="RDM_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="LOG_GET_METADATA" VALUE="false" /> 

<PARAMETER NAME="METADATA_PARALLEL_CACHING" VALUE="0" /> 

</PARAMETERS> 

</SERVICE>

“While creating an Excel Mapping, after specifying the excel worksheet, the target table, and mapping each 
column in the worksheet to a target table, I click SAVE and nothing happens. But when I click CANCEL, a 
message pops up informing me that all changes will be discarded", what is to be done.

Check if the excel mapping creation is done using I.E 8 with JRE 1.4 plug in enabled on machine. If so, 
upgrade the JRE plug in to 1.7+.

Can Multiple OFSAA Infrastructure instances share the same config schema?

No, only one OFSAA environment can be installed using one config schema.

Can Atomic schema be shared?

Yes, it can be shared between two OFSAA instances.

While setting a firewall, which ports should be opened for communication between the Web Server (Apache 
HTTP Server/ Oracle HTTP Server/ IBM HTTP Server) and the Web Application Server (WebSphere/ 
WebLogic/ Tomcat) for OFSAAI to operate properly?

The OFSAA Servlet port which is same as Web server port should be open. Also the web application port 
should be open.

Can I modify the NLS_LENGTH_SEMANTICS to BYTE from CHAR for the Database where older versions of 
OFSAA is Installed?

Yes, NLS_LENGTH_SEMANTICS can be modified to BYTE from CHAR if you are not intending to use multi 
language support.

Can I install already installed application in a different infodom?

No, it is not possible to install the same application in two different infodoms.

How can I configure the OFSAA application for High Availability?

OFSAA can have active-passive high availability. For more details, see the Configuration for High 
Availability- Best Practices Guide.

I want to configure OFSAA for High Availability that is WebLogic cluster on which OFSAA.ear is deployed and 
cluster OFSAAI processes (such as Reveleus etc) are running. Is this a supported configuration?

High Availability is available for WebLogic cluster and DB level as active-active, but is not available on the 
application side. OFSAA can have active-passive high availability. For more details, see Configuring 
OFSAA in Clustered Environment Guide.
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During OFSAA installation should I provide web application server's IP /Hostname and port or web server's IP/
Hostname and port, if the Apache HTTP Server/ Oracle HTTP Server/ IBM HTTP Server are configured?

If the web server is configured, you should enter the Web Server IP Address/Hostname and Port details 
during OFSAA installation. Here the Servlet port should be same as the Web Server port.

If Web Server is not configured, the Web Application Server's IP Address/ Hostname and Port is required 
during the installation process. Here the Servlet port should be same as the Web application Server port.

Is "ReveleusAdminConsoleAgent" applicable for OFSAAI 8.0.6.0.0 and higher versions?

No, ReveleusAdminConsoleAgent is not applicable starting OFSAAI 7.3.3.0.0. There is a change in the way 
agentservers are managed through AGENTSTARTUP.SH & AGENTSHUTDOWN.SH.

What should I do when the message server process does not open and I get the following error message, 
"CI18NProvider::CI18NProvider, Error, unable to connect to the config database"?

This error is displayed due to the following reasons:

 The Config Schema password is already expired.

 If the config schema password is going to expire soon and the message like "ORA-28002: the password 
will expire within 6 days" displays while connecting to config schema through sqlplus.

 The Config schema password is Modified.

To resolve the error, re-set the config schema password to the old password. Else, if the config schema 
password is modified to something else then follow the below steps:

 Delete the $FIC_HOME/conf/Reveleus.SEC file.

 Shutdown the OFSAAI App service: cd $FIC_APP_HOME/common/FICServer/bin ./stopofsaai.sh

 Shutdown the OFSAAI App service: cd $FIC_APP_HOME/common/FICServer/bin ./stopofsaai.sh

 Start the Infrastructure Server in foreground directly on the server or through XWindows software using 
the command: ./startofsaai.sh

 Enter System Password.

 Enter the new Config schema password. The service starts and initializes if it is able to successfully 
connect to the DB and generates the Reveleus.SEC file.

 Post successful startup of the service, if required, the Infrastructure server may be shut down and 
restarted in the background using nohup mode.

What is the mechanism of Log File sizing and backup?

OFSAAI Log files created under $FIC_APP_HOME/common/FICServer/logs & <OFSAAI_DEPLOYED_AREA>/
<CONTEXT.war>/logs is configurable in RevLog4jConfig.xml.

The default size of the log files (MaxFileSize) is set to max 5000kb & number of max backup log files 
(MaxBackupIndex) retained is set to 5, both of which are configurable. Increasing these parameters to a 
higher value should depend on the server HW configurations and may reduce the performance.

To configure the Logs file size on OFSAA Application server, follow these steps:

 Navigate to $FIC_HOME/conf where OFSAA is installed.

 Edit the following parameters in the file RevLog4jConfig.xml

<param name="file" : Enter the path where the Logs are to be generated.
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<param name="MaxFileSize" : Provide the required file size.

<param name="MaxBackupIndex" : Provide the required number of backup files to be 
created.

Example:

<appender name="REVSERVERAPPENDER" class="org.apache.log4j.RollingFileAppender">

<param name="file" value="$FIC_HOME/ficapp/common/FICServer/logs/RevAppserver.log"/
>

<param name="Append" value="true" />

<param name="MaxFileSize" value="5000kb" />

<param name="MaxBackupIndex" value="5" />

<layout class="org.apache.log4j.PatternLayout">

<param name="ConversionPattern" value="[REVELEUSLOG] %m%n"/>

</layout>

</appender>

To configure the Deployed area logs file, follow these steps:

 Navigate to <EAR/WAR Deploy area>/conf folder.

 Repeat step 2 from the above section.

Can we modify the Log file path?

Yes, Log file path is configurable, it can be configured in RevLog4jConfig.xml.default log file path (file) is set 
by the installer. This can be configured to another path.

Can I point the environment with HTTP enabled to HTTPS after installation and vice versa?

Follow these steps:

 Create SSL related certificates and import to respective servers.

 Enable SSL on a desired Port (example 9443) on your existing and already deployed web application 
servers.

 Replace the protocol as https and new ssl port (FIC_SERVLET_PORT) configured and in all the URLs 
specified on below files:

$FIC_HOME/ficapp/common/FICServer/conf/FICWeb.cfg and $FIC_HOME/ficweb/webroot/
conf/FICWeb.cfg

$FIC_HOME/ficapp/icc/conf/WSMREService.properties

$FIC_HOME/ficweb/webroot/conf/ModelExecution.properties

$FIC_HOME/ficdb/conf/MDBPublishExecution.properties

$FIC_HOME/ficdb/conf/ObjAppMap.properties

$FIC_HOME/utility/Migration/conf/WSMigration.properties

$FIC_HOME/utility/WSExecution/conf/WSExecution.properties

$FIC_HOME/EXEWebService/WebSphere/ROOT/WEB-INF/wsdl/EXEWebServiceImpl.wsdl

$FIC_HOME/EXEWebService/Tomcat/ROOT/WEB-INF/wsdl/EXEWebServiceImpl.wsdl

$FIC_HOME/EXEWebService/weblogic/ROOT/WEB-INF/wsdl/EXEWebServiceImpl.wsdl

 Replace XML attribute/Node values as specified on below files:

$FIC_HOME/ficweb/webroot/WEB-INF/web.xml
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FIC_WEBSERVER_PORT=9443

FIC_WEBPROTOCOL=https

$FIC_HOME/conf/LookUpServices.xml and $FIC_HOME/ficweb/webroot/conf/
LookUpServices.xml

PORT="9443" PROTOCOL="https:"

 Login to config schema and execute below SQL command to replace protocol and SSL port.

SQL> update configuration cn set cn.paramvalue='9443' where 
cn.paramname='SERVLET_ENGINE_PORT';

SQL> update configuration cn set 
cn.paramvalue=replace(cn.paramvalue,'http:','https:') where 
cn.paramname='FormsManagerCacheReload';

SQL> update web_server_info ws set ws.servletport='9443',ws.servletprotocol='https';

 Create EAR/WAR file and Re-Deploy.

What should I do if the sliced data model upload takes a long time to complete?

If the Metadata cache size is set to a lower value than the actual count of each Metadata type (hierarchy, 
dataset, dimension etc), then it gets into performance degrade issues. We have to increase the cache size 
for each Metadata type according to the count in the environment.

Following are the parameters in DynamicServices.xml to be configured depends on the Metadata count in 
your environment.

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000"/>

<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000"/>

<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000"/>

<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="3000"/>

<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000"/>

<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000"/>

<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000"/>

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000"/>

<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000"/>

Metadata count can be derived based on the following queries:

select count(1) from metadata_master where metadata_version=0 --- for all metadata

select count(1) from metadata_master where metadata_version=0 and metadata_type=1 -
-- for measure

select count(1) from metadata_master where metadata_version=0 and metadata_type=2 -
-- for Dimension

select count(1) from metadata_master where metadata_version=0 and metadata_type=3 -
-- for HCY

select count(1) from metadata_master where metadata_version=0 and metadata_type=4 -
-- for DATASET

select count(1) from metadata_master where metadata_version=0 and metadata_type=59 -
-- for BP's

select count(1) from metadata_master where metadata_version=0 and metadata_type=54 -
-- for Alias
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select count(1) from metadata_master where metadata_version=0 and metadata_type=5 -
-- for CUBES

select count(1) from metadata_master where metadata_version=0 and metadata_type=856 
--- for Derived Entity

For LDAP authentication, which server connects with the LDAP server, the Application server (where ofsaai is 
installed), or Web Application server (where EAR is deployed)?

For LDAP authentication, the Application server (ficapp) connects with the LDAP server.

The LDAP server in the setup listens on secure protocol ldaps (port 636). I have the root certificate of the LDAP 
server for SSL, and would like to know where to offload this certificate?

You need to import the certificate into the JDK/JVM used by Reveleus server in ficapp layer.

How to relocate FTPSHARE folder?

You can run the PortC.jar utility. For more details, refer Changing IP/ Host-name, Ports, Deployed Paths 
of the OFSAA Instance section in the OFSAAI Admin Guide available on OHC.

What should I do when an entity containing many attributes (>100 columns) is selected as Source entity and the 
Data Mapping (T2T definition) save operation takes longer than expected with the hourglass in the UI 
continuously rotating?

The workaround is:

 Locate the web server deployed area webroot/conf/excludeURLList.cfg file.

 Modify the following entries:

[SQLIA]./dataIntegrator/ to [ALL]./dataIntegrator/

[SQLIA]./ETLExtractionServlet to [ALL]./ETLExtractionServlet

 Save the changes and restart the web server.

 Re-save the definition.

Application Pack 8.0.7.0.0 FAQs

What is an Application pack?

An Application Pack is suite of products. For more information, see About Oracle Financial Services 
Analytical Applications (OFSAA) Pack.

Can I get a standalone installer for OFSAAI 8.0?

No. AAI is part of every application pack and installs automatically.

How does OFSAA 8.0 Application pack relate to OFSAA 7.x series?

8.0 is a new major release consolidating all products from OFSAA product suite.
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Can existing OFSAA 7.x customers upgrade to OFSAA 8.0 Application Pack? 

There is no upgrade path available. However, we will have migration kit / path for every product to 8.0 
application pack. Further details will be available with Oracle Support.

Does OFSAA 8.0 Application pack UPGRADE's automatically existing environments?

No. Refer Point 5. OFSAA 8.0 application pack has to be installed in an new environment and subsequently 
migration path / migration kit needs to be run to migrate from 7.x to 8.0. Please note we will have migration 
path only from the previously released version of OFSAA products.

Where can I download OFSAA 8.0 Application Pack?

You can download the OFSAAI 8.0 Application Pack from Oracle Software Delivery Cloud (OSDC).

What are the minimum system and software requirements for OFSAA 8.0 Application Pack?

See the installation guide section Hardware and Software Requirements section.

Is my environment compatible with OFSAA 8.0 Application Pack? 

Environment Check utility performs the task. It is part of install and can also be run separately.

Does OFSAA 8.0 Application Pack is support all Operating systems?

LINUX, AIX, SOLARIS 10, 11. See the Technology Matrix for the technology matrix that OFSAA suite 
products are/ will be qualified on.

How can I install OFSAA 8.0 Application Pack?

See the Oracle Financial Services Advanced Analytical Infrastructure Installation and Configuration Guide 
published in OHC for the application pack installers.

Does this installation require any Third party Software?

Oracle Financial Services Advanced Analytical Infrastructure Installation And Configuration Guide 
published in OHC lists the third party software that needs to be installed.

What languages are supported during OFSAA 8.0 Application Pack installation?

US English is the language supported.

What mode of installations OFSAA Application Pack supports? [i.e., Silent, GUI]

OFSAA Application Packs supports both, GUI and Silent Mode.

Does OFSAA 8.0 Application Pack support Multi tier Installations?

OFSAA 8.0 does single tier installation. For more information see the OFSAAI FAQs section.

Does this Application Pack validate all Prerequisites required for this installation i.e., Memory, Disk Space etc.?

Yes. The prerequisite checks are done by the respective application pack installer. 
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What happens if it aborts during installation of any application with in Application pack?

You must restore the system and re-trigger the installation.

Does this Application pack 'Rolls Back' if any of application installation fails due to errors?

Rollback of installation is not supported.

Does the Application pack installs all applications bundled?

All application pack file system files are installed but there is an option to enable the licensed products.

How can I re-install any of the Application Pack?

You can re-trigger if there is a failure.

Does Application pack allow enabling / disabling any of the applications installed?

Yes. You cannot disable once the product is enabled in an environment.

I have installed one application in an Application pack and can I install any of new applications within the 
Application pack later point of time?

No, installation of additional applications is not required. If you wish to add an application later, you can 
enable the application at that time.

How many OFSAA Infrastructures can be installed in a single server?

There is no issue in installing separate OFSAAI installations, each with their own PFT/FTP installations and 
separate associated database instances and separate Web Server installations on the same server as long 
as adequate memory is allocated for each instance and as long as each OFSAAI installation is installed 
using a separate UNIX user and profile. Care should be taken if running multiple OFSAAI installations on a 
single server. Adequate memory will be required for each installation as several OFSAAI processes (model 
upload, DEFQ services, etc) take significant amounts of memory. So it depends on your server memory.

Is it possible to Install OFSAA 8.0 Application pack on any one of the existing 'Infodom' where another OFSAA 
8.0 application is installed?

Yes. However, the Behavioral Detection Application Pack and Compliance Regulatory Reporting 
Application Pack are the exceptions. They need to be installed in a different INFODOM.

Can I select an Infodom in Application pack during installation?

Yes. You can select or change the required infodom. 

Can I install all Application Packs in a 'Single Infodom'?

Yes. But Behavioral Detection Application Pack and Compliance Regulatory Reporting Application Pack are 
the exceptions. They need to be installed in a different INFODOM.
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Is it possible to install applications on different Infodom within the Application pack? (That is if you want to install 
LRM & MR in two infodoms)

Applications within application pack have to be installed in the same information domain in the same 
environment.

How many Infodoms can be created over a single OFSAA Infrastructure of 8.0.1.0.0?

You can install only one infodom during installation. But after installation, you can create multiple infodoms.

Does 'Data Model' bundled is Application pack Specific or Specific to individual application?

A merged data model for all applications within the application pack is bundled and uploaded.

Is it possible to install OFS Enterprise Modeling in later point of time?

OFS Enterprise Modeling is a separate product and can be enabled as an option later from any application 
pack that bundles Enterprise Modeling.

Does Application pack create sandbox automatically for the required applications?

Yes, Sandbox creation is part of application install process.

Are upgrade Kits available for individual applications or the complete Application Pack?

Maintenance Level (ML) Release / Minor Release upgrades are available across all applications.

Can I upgrade AAI only?

Yes, you can upgrade AAI alone.

Can I upgrade one application within the Application Pack? (For example, I want to upgrade LRM in the Treasury 
Application pack, but not MR.)

No. Not possible Upgrade is applied across packs.

Is it possible to uninstall any Application from the Application pack?

No, it is not possible to uninstall any Application from the Application Pack.

Can I uninstall entire Application Pack?

No, you cannot uninstall the Application Pack.

Is it possible to uninstall only application and retain AAI in the installed environment?

No, you cannot uninstall only the application and retain AAI in the installed environment.

Can I uninstall entire Application Pack?

No, you cannot uninstall the Application Pack.

Is it possible to uninstall only application and retain AAI in the installed environment?

No, you cannot uninstall only the application and retain AAI in the installed environment.

Does Application Pack contain all Language Packs supported?
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Language Packs need to be installed on 8.0 application packs.

Can I install an Application Pack over another Application Pack (that is same infodom or different infodom)?

Yes, you can install an Application Pack over another Application Pack in the same information domain or 
different information domain. But Behavior Detection Application Pack and Compliance Regulatory 
Reporting Application Pack, Asset Liability Management Application Pack and Profitability Application Pack 
are the exceptions. They need to be installed in a different INFODOM.

Can I use an existing manually created schema as information domain for application pack installation?

No. Schemas required by OFSAA applications have to be created using Schema Creator Utility.

Does OFSAA 8.0 support on WebLogic 10.3.6 with Oracle 12c?

Yes, OFSAA 8.0 will support on WebLogic 10.3.6 with Oracle 12c. WebLogic 10.3.6 supports oracle 12c 
with some additional configurations. See the link http://docs.oracle.com/cd/E28280_01/web.1111/e13737/
ds_12cdriver.htm#JDBCA655 for additional configurations.

What should I do if I get the following error message while running the schema creator utility, "HostName in input 
xml is not matching with the local hostname"?

One possible reason could be the machine is configured for zonal partitioning. Ensure all the known IP 
Addresses of the machine are present in the /etc/hosts file.

What are the Java versions supported in OFS PFT Application Pack version 8.0.6.0.0?

OFS PFT Application Pack supports 1.7.x and 1.8.x.

Is this release of the OFS PFT Application Pack version 8.0.6.0.0 supported on Java 8? 

Yes. To install this release of the OFS PFT Application Pack version 8.0.6.0.0 on Java 8. For more 
information, refer to specific notes mentioned in the sections Installer and Installation Prerequisites, 
Configurations Supported for Java 8, Configuring the Schema Creator Utility, GUI Mode Installation, Silent 
Mode Installation.

What should I do when I get "[ERROR] - Error : APP Setup bin file failed." message during 
OFS_Application_PACK installation?

This is a generic error message that appears during application installation failure. You should check the 
installation log files for more information about what failed the installation.

However, if the message is displayed and the log files are not generated, it could be that it is a temp directory 
issue. The resolution is that your UNIX administrator has to disable the NOEXEC option. The installers 
extract the installation files into the /tmp directory, and if NOEXEC is enabled, execution of binaries will not 
happen in the directory and the installation fails. Re-run the installer after the configuration is changed. For 
detailed information, see the support note at 

https://support.oracle.com/epmos/faces/DocumentDisplay?id=2340045.1.
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Forms Framework FAQs

What should I do when I have large volume of data to be exported?

It is recommended to use BIP reports or OBIEE reports if you have to export large volume of data.

How do I export the columns added to the grid by Field Chooser option?

Perform Grid Export operation to export the columns added to the grid by Field Chooser option.

'Expand All/ Collapse All' button is not visible in the Hierarchy Browser window. What should I do?

Expand All/ Collapse All button is enabled only if the number of hierarchy nodes is less than 50. If it is more 
than that, it is considered as large hierarchy and the data will be fetched dynamically when you expand each 
node.

Error Dictionary

This contents of this section has been created with the interest to help you resolve the installation issues if any. 
There is a compilation of all the possible errors that might arise during the installation process with the possible 
cause and the resolution to quickly fix the issue and proceed further with the installation.

This section includes the following topics:

• Accessing Error Dictionary

• Error Code Dictionary

Accessing Error Dictionary

Instead of scrolling through the document to find the error code, you can use the pdf search functionality. In the 
"Find" dialog available in any of the Adobe Acrobat version that you are using to view the pdf document, follow 
the below instructions to quickly find the error resolution.

1. With the Installation pdf open, press Ctrl+F or select Edit > Find.

2. The Find dialog is displayed as indicated.

3. Enter the error code that is displayed on screen during Infrastructure installation.

4. Press Enter. The search results are displayed and highlighted as indicated below.

View the details of the issues, its cause, and resolution specific to the error code. Repeat the step to find an 
answer to any other errors that you notice during installation. If you are not able to resolve the issue even after 
following the steps provided in resolution, you can contact support.oracle.com along with log files and 
appropriate screen shots.
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Error Code Dictionary

Error Code Cause Resolution

OFSAAI-1001 Unix shell is not "korn" shell. Change the shell type to "korn". Use chsh UNIX 
command to change SHELL type.

Shell type can also be changed by specifying 
shell path for the Unix user in /etc/passwd file.

Note: chsh command is not available in Solaris 

OS.

OFSAAI-1002 No proper arguments are 
available.

Provide proper arguments. Invoke Setup.sh 
using either SILENT or GUI mode.

Example: ./Setup.sh SILENT or ./Setup.sh GUI

OFSAAI-1004 File .profile is not present in 
$HOME.

Create .profile in $HOME, i.e. in the home 
directory of user.

OFSAAI-1005 File OFSAAInfrastructure.bin is 
not present in current folder.

Copy OFSAAInfrastructure.bin into installation 
kit directory.

OFSAAI-1006 File CustReg.DAT is not present in 
current folder.

Copy CustReg.DAT into installation kit directory.

OFSAAI-1007 File OFSAAI_InstallConfig.xml is 
not present in current folder.

Copy OFSAAI_InstallConfig.xml into installation 
kit directory.

OFSAAI-1008 File validateXMLInputs.jar is not 
present in current folder.

Copy validateXMLInputs.jar into installation kit 
directory.

OFSAAI-1009 File log4j.xml is not present in 
current folder.

Copy log4j.xml into installation kit directory.

OFSAAI-1010 Unknown error occurred. Make sure to provide proper argument (SILENT 
or GUI) to the Setup.sh file.

OFSAAI-1011 XML validation failed. Check InfrastructurePreValidations.Log for more 
details.

OFSAAI-1012 Property file with locale name does 
not exist.

Copy MyResources_en_US.properties to the 
setup kit directory and keep en_US in LOCALE 
tag of OFSAAI_InstallConfig.xml.

OFSAAI-1013 File OFSAAI_InstallConfig.xml/
OFSAAI_PostInstallConfig.xml not 
found.

Copy OFSAAI_InstallConfig.xml/
OFSAAI_PostInstallConfig.xml to the setup kit 
directory.

OFSAAI-1014 XML node value is blank. Make sure all node values except 
SMTPSERVER, PROXYHOST, PROXYPORT, 
PROXYUSERNAME, PROXYPASSWORD, 
NONPROXYHOST, or RAC_URL are not blank.
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OFSAAI-1015 XML is not well formed. Execute the command dos2unix 
OFSAAI_InstallConfig.xml to convert plain text 
file from DOS/MAC format to UNIX format.

or 

Make sure that OFSAAI_InstallConfig.xml is 
valid. Try to open the file through Internet 
Explorer for a quick way to check validity. If it is 
not getting opened, create new 
OFSAAI_InstallConfig.xml using the 
XML_Utility.jar.

OFSAAI-1016 User installation directory contain 
blank spaces.

Provide an installation path that does not contain 
spaces. Check the tag USER_INSTALL_DIR in 
OFSAAI_InstallConfig.xml file. This path should 
not contain any spaces.

OFSAAI-1017 User installation directory is 
invalid.

Provide a valid installation path. Check if you are 
able to create the directory mentioned in 
USER_INSTALL_DIR tag value of 
OFSAAI_InstallConfig.xml file.

Error Code Cause Resolution
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APPENDIX A - INSTALLATION OF R AND ORACLE R 
ENTERPRISE (ORE)

This is an optional step and required only if you intend to use Term Structure Parameter Estimation functionality 
under Rate Management - Interest Rates, for computing term structure parameters. Both Funds Transfer Pricing 
and Asset Liability Management applications require term structure parameters for all monte carlo engine based 
calculations (OAS, VaR and EaR). 

Following are the prerequisites:

• Install R and Oracle R Enterprise Server on the Oracle Database server. See 

• https://docs.oracle.com/cd/E57012_01/doc.141/e57007.pdf

• ORE version supported - Oracle R Enterprise (Server) version 1.4.1

Dependencies

R code of the application requires dependent packages to be installed before the Reporting Line Forecast batch 
is executed. Usage of the predictive model requires installation of packages - tseries, lattice, and R Oracle.  
Verify that lattice and R Oracle are compatible with each other.

Package installation instructions can be found at:

http://cran.r-project.org/doc/manuals/r-release/R-admin.html#Installing-packages

Configuration for Oracle R Enterprise

Grant the RQADMIN role to atomic schema.

You can grant the rqadmin role in SQL*Plus by logging in to the database with DBA privileges and provide the 
following privilege to Atomic Schema:

RQADMIN by executing the command:

GRANT RQADMIN TO < atomic_schema>;

Configuration for Oracle R Distribution and Oracle R Enterprise 
(ORE)

This is an optional step. Skip and proceed with the next steps if OFS Enterprise Modeling Application with R 
scripting is not enabled during installation.

1. Install OFSAAIRunner Package. For more information, see Installing OFS AAAI Runner Package. If you 
have already installed OFSAAIRunner package (as part of a previous installation), uninstall it (For more 
information, see Uninstalling OFS AAAI Runner Package section), and reinstall the latest available 
OFSAAIRunner package.

2. Log in to the database with dba privileges and provide the following privilege to Configuration Schema:
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 RQADMIN by executing the command:

GRANT RQADMIN TO <config_schema>;

3. Log in to the database with dba privileges and provide the following privileges to Atomic Schema:

 CREATE MINING MODEL privilege (to execute the Data Mining models) by executing the command:

GRANT CREATE MINING MODEL TO <atomic_schema>;

Installing OFS AAAI Runner Package

OFSAAIRunner is an R package built by the OFS Enterprise Modeling Application. It is a prerequisite for 
executing models developed using R scripts. This package helps in:

• Initializing inputs

• Mapping framework variables to R objects

• Configuring possible outputs of the script

• Storing results back to the Database

OFSAAIRunner package (OFSAAIRunner_1.0.0.tar.gz) is available under $FIC_DB_HOME/lib.

Prerequisite

Oracle R & ORE should be installed on the Oracle Database server before installing OFSAAIRunner package.

Use the following procedure to install OFSAAIRunner package:

1. Log in to the OFSAA Server. Navigate to the folder $FIC_DB_HOME/lib.

2. Copy the file OFSAAIRunner_1.0.0.tar.gz in Binary mode to the Oracle Database Server.

3. Log in to the Oracle Database Server with the user using which Oracle Database Server installation is done.

4. Navigate to the directory where the file OFSAAIRunner_1.0.0.tar.gz is copied.

5. Install the package by executing the command:

ORE CMD INSTALL OFSAAIRunner_1.0.0.tar.gz

Successful installation is indicated in the installation log as:

* DONE (OFSAAIRunner)

Making packages.html ... done

Note: The OFSAAIRunner package is installed in /usr/lib64/R/library.

6. Navigate to the directory $ORACLE_HOME/R/library and check whether OFSAAIRunner package is listed 
there by executing the command:

ls -l
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Uninstalling OFSAAIRunner Package

Use the following procedure to uninstall the OFSAAIRunner package:

1. Log in to the Oracle Database Server with the same username, using which Oracle Database Server 
installation is done.

2. Enter ORE in command prompt and execute the command:

#ORE

3. Enter the following command to save workspace image:

>remove.packages("OFSAAIRunner")

4. Enter y when prompted to save the workspace image.

q()

5. Navigate to the directory $ORACLE_HOME/R/library and verify the package is not listed there by executing 
the command:

6. Save workspace image? [y/n/c]: y

ls -l

Configurations for ORE Execution

Follow this step:

1. Add a TNS entry in tnsnames.ora file with tns name same as that of value set for ORACLE_SID in database 
server.

Note: For RAC database, follow the aforementioned configuration in all machines.

Configuring Tomcat

To stop generating static content with one print statement per input line, you need to configure the web.xml file.

To configure web.xml file, perform the following steps:

1. Navigate to tomcat/conf directory.

2. Edit web.xml file as follows:

Set the mapped file parameter to False in the servlet tag mentioned with

<servlet-name>jsp</servlet-name>.

<init-param>

<param-name>mappedfile</param-name>

<param-value>false</param-value>

</init-param>
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APPENDIX A - FTP WEB SERVICE CONFIGURATION

The following installation activity describes how to setup FTP web services to support the Breakage Charge 
Economic Loss calculation. The calculation logic is the same as the FTP Adjustment Rule Breakage Charge 
calculation. This FTP Economic Loss Web Service is now independent of EXEWebService. Note, other FTP 
web services are installed automatically and require no further setup.

Approach

The FTP Web services are designed as a wrapper which will call the FTP Engine for the calculation of Economic 
Loss. The FTP Web Service is available in its own context and has a specific WSDL for that context.

Architecture
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Prerequisites

• For WebLogic and WebSphere, Data source should be present with JNDI name as jdbc/FTPWS.

• For Tomcat a separate context entry should be present in server.xml file.

Log4j configuration

log4j.properties file is already present inside WEB-INF/classed folder of the war file. Logs will be generated 
inside $root_directory_of_war/logs/webservice.log file. 

Setup Environment Variable - ofsaaws.properties

ofsaaws.properties file is available in WEB-INF/classes folder. Specify the cpp_component name. Place the 
component libbcservices.so under /ficdb/lib/libFSGBU. Add the library location to LD_LIBRARY_PATH.

If Web-services are deployed in an environment other than where OFSAA is deployed, then copy /ficdb/lib/
libFSGBU to web-services environment and set in LIBRARY path.

 cpp_component= libbcservices.so(libbcservices.o) - for AIX

 cpp_component=bcservices - for Solaris 

 cpp_component=bcservices - for Linux

Creating FTPWebServiceAXIS.war

1. Go to the server path in which the application is running.

For Example: $FIC_HOME/FTPWebService

2. Run "ant.sh" in this folder. FTPWebServiceAXIS.war will be created in the same folder.

Deploying FTPWebServiceAXIS.war

For Tomcat:

1. Copy the FTPWebServiceAXIS.war file to the webapps folder of apache tomcat directory.

2. Go to conf folder of apache tomcat and add a separate context entry in server.xml file with resource name 
as jdbc/FTPWS.

Example:

<Context path="/FTPWebServiceAXIS" docBase="/<Tomcat_webapps> /FTPWebServiceAXIS" 
debug="0" reloadable="false" crossContext="true">

<Resource auth="Container"

name="jdbc/FTPWS"

type="javax.sql.DataSource

driverClassName="oracle.jdbc.driver.OracleDriver

username="username"

password="password" url="jdbc:oracle:thin:@db-ip:dp-port:dbname"
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maxActive="100"

maxIdle="30"

maxWait="10000"

removeAbandoned="true" 

removeAbandonedTimeout="60"

logAbandoned="true"/>

</Context>

3. Restart the server. 

For Weblogic and WebSphere:

1. Deploy FTPWebServiceAXIS.war from admin console.

2. Create data source for database connection with JNDI name as jdbc/FTPWS.

3. WSDL is present at following URL.

http://ipaddress:port/FTPWebServiceAXIS/services/OFSAAFTPService?wsdl

Additional Steps for Configuring the FTP Ad hoc Pricing Web Services

Ad hoc pricing web-services (getpricing) are deployed along with OFSAA FTP. Configuring these web services 
require some minor configuration after installation, steps are mentioned below:

1. Go to $FIC_HOME/ficweb/webroot/WEB-INF/classes.

2. Open ofsaaws.properties, replace <infodom name> and <userid>(with admin access) and save it.

3. Open ofsaawsClient.properties, give OFSAA URL.

4. Rebuild the war and deploy.

URL patterns for ad hoc web-services are:

http://<ip>:<port>/<context>/services/DailyQueriesService?wsdl

http://<ip>:<port>/<context>/services/ PricingService?wsdl

Note: See the Oracle Financial Services Funds Transfer Pricing User Guide for usage of the FTP Ad hoc 
Pricing Web Services.
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APPENDIX A - ADDITIONAL CONFIGURATION

The following topics provide detailed module specific post installation configurations.

This appendix includes the following topics:

• Configuring FTP/SFTP

• Configuration for Dimension and Hierarchy Management

• Configure Infrastructure Server Memory

• Internet Explorer Settings

• Retrieving Patch Information

• OLAP Data Server Configuration

• Changing IP/ Host name, Ports, Deployed Paths of the OFSAA Instance

• OFSAAI Setup Information Fetching Tool

• Encryption Changer

• Infrastructure LDAP Configuration

• Configure OFSAAI Web Services

• Deploy OFSAAI Web Services

• Configuration to Enable Parallel Execution of DML Statements

• Configure Message Details in Forms Designer

• Clearing Application Cache

• Configuring Password Changes

• Configuring Java Virtual Machine

• Configure Internal Service (Document Upload/ Download)
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Configuring FTP/SFTP

This section details about the configurations required for FTP/SFTP.

Adding FTP/SFTP Configuration for File Transfer

In OFSAA, certain modules require transfer of files from the web application server to the OFSAA server over 
SSH.

Follow these steps to ensure the OFSAA server recognizes the web application server during file transfers.

1. Login to the web application server.

2. Type sftp <user>@<OFSAA Server>

3. Specify Yes when prompted for permission.

Are you sure you want to continue connecting (Yes/No)?

4. This will add an entry into the "known_hosts" file.

5. A confirmation message is displayed:

Permanently added <OFSAA Server> RSA) to the list of known hosts.

Setting Up SFTP Private Key

Log in to OFSAA Unix user using Putty tool, where you plan for installation and generate a pair of authentication 
keys using the ssh-keygen command. If required, set passphrase. Otherwise OFSAAI_SFTP_PASSPHRASE tag in 
the OFSAAI_InstallConfig.xml file should be set to NA.

To generate private key, enter the commands as shown:

ofsaapp@OFSASERVER:~> ssh-keygen -t rsa

Generating public/private rsa key pair.

Enter file in which to save the key (/home/ofsaapp/.ssh/id_rsa):

Created directory '/home/ofsaapp/.ssh'.

Enter passphrase (empty for no passphrase):

Enter same passphrase again:

Your identification has been saved in /home/ofsaapp/.ssh/id_rsa.

Your public key has been saved in /home/ofsaapp/.ssh/id_rsa.pub.

The key fingerprint is:

3e:4f:05:79:3a:9f:96:7c:3b:ad:e9:58:37:bc:37:e4

ofsaapp@OFSASERVER:~> cat /home/ofsaapp/.ssh/id_rsa.pub >> /home/ofsaapp/.ssh/
authorized_keys

In case, you are generating SFTP Private key for Hive server, append the content of /home/ofsaapp/.ssh/
id_rsa.pub to Hiveserver authorized_keys file located at $HOME_DIR_HIVE/.ssh folder.

Ensure the following permissions exist for the given folders:

• Permission of .ssh should be 700

• Permission of .ssh/authorized_keys should be 640

• Permission of .ssh/id_rsa should be 400

• Permission of Unix user created should be 755
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Configuration for Dimension and Hierarchy Management

These configuration changes are applicable when Dimension Management features provided in OFSAAI are 
used. You can open AMHMConfig.properties file present in the $FIC_WEB_HOME/webroot/conf directory to set 
the properties for the following:

This section includes the following topics:

• Configure Member Deletion

• Configure Attribute Default Date Format

• Configure Members Reverse Population

• Configure Hierarchy Reverse Population

• Configure Maximum Levels allowed in Hierarchies

• Configure Node Limit for a Hierarchy Tree

Configuration for Dimension and Hierarchy Management has to be done only after the application/solution 
installation is done. The properties specific to Information Domain are:

• $INFODOM$=<Name of the Information Domain>

• $DIMENSION_ID$=<Dimension ID for which the property to be set>

Configure Member Deletion

This property should be set to allow the user to delete the Members for the Dimension.

Value Code Example

# Member Deletion Configuration - 
VALUE- Y/N

MEMBER_DEL-$INFODOM$-
$DIMENSION_ID$=$VALUE$

MEMBER_DEL-ORAFUSION-1=Y
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Configure Attribute Default Date Format

This property should be set to display the Default Date Format for Date type Attribute in Attributes window.

Configure Members Reverse Population

This property should be set for reverse population of Members for the Dimensions in required Information 
Domains.

Configure Hierarchy Reverse Population

This property should be set for reverse population of Hierarchies for the Dimensions in required Information 
Domains.

Configure Maximum Levels allowed in Hierarchies

This property is required to set the maximum levels allowed to build the Hierarchies tree structure.

Hierarchies greater than 15 levels are not supported within OFSAA EPM applications (ALM, FTP, PFT, and HM). 
If the hierarchy data contains more than 15 levels, OFSA_IDT_ROLLUP will not be populated. The number of 
hierarchy levels allowed for OFSAA EPM key dimensions must be less than or equal to 15.

• If the Hierarchy Reverse Population setting is set to "Y" and more than 15 levels exist in the data, then the 
following alert is displayed "The number of levels exceeds the limit". 

• If the maximum level allowed setting is set greater than 15 and Hierarchy Reverse Population is set to "Y", 
then following error is displayed "Error occurred in Reverse Populating the hierarchy".

Value Code Example

# Attribute Default Date Format - 
DB_DATE_FORMAT:DD-MON-YYYY

ATTR_DEF_DATE_FORMAT-
$INFODOM$=$DB_DATE_FORMAT$

ATTR_DEF_DATE_FORMAT-
ORAFUSION=DD/MON/YYYY

Value Code Example

# Members Reverse population - 
VALUE- Y/N

MEMBER_REVERSE_POP-
$INFODOM$-
$DIMENSION_ID$=$VALUE$

MEMBER_REVERSE_POP-
ORAFUSION-1=Y

Value Code Example

#Hierarchy Reverse population - 
VALUE- Y/N

HIERARCHY_REVERSE_POP-
$INFODOM$-
$DIMENSION_ID$=$VALUE$

HIERARCHY_REVERSE_POP-
ORAFUSION-1=Y

Value Code Example

#Hierarchy Maximum level allowed for 
the hierarchy in particular Information 
Domain - VALUE - Integer number

MAX_DEPTH-$INFODOM$=$VALUE$ MAX_DEPTH-FUSION=15
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Configure Node Limit for a Hierarchy Tree

This property is required to display the Hierarchy as a small or a large hierarchy. If the tree node limit exceeds 
the set limit, the Hierarchies are treated as large Hierarchy.

Configure Infrastructure Server Memory

The memory settings for Infrastructure Application Server, Tomcat, WebSphere, and WebLogic can be edited 
for customizing memory settings and garbage collector settings depending on the available hardware 
configuration as explained below. These settings are base minimum and has to be incremented considering the 
deployment metrics into account. The increments are usually handled in multiples of 128mb for heap and 64mb 
for stack.

Infrastructure Application Server Memory Settings

You can configure the Infrastructure Application Memory settings as follows:

1. Locate .profile file.

2. Edit X_ARGS field in this file for customizing memory settings and garbage collector settings depends on 
the hardware configuration.

This has a default value X_ARGS="-Xms200m"

X_ARGS=" "$X_ARGS" $DELIM -Xmx2048m"

Note: Modify X_ARGS_APP variable in the .profile file to customize Java Memory Settings for Model 
Upload based on the Data Model size.

For Run and Rule executions, the following value is recommended:
X_ARGS_RNEXE="-Xms1g -Xmx1g
XX:+UseAdaptiveSizePolicy -XX:MaxPermSize=512M -XX:+UseParallelOldGC -XX:+DisableExplicitGC"

X_ARGS_RLEXE="-Xms1g -Xmx1g -XX:+UseAdaptiveSizePolicy -XX:MaxPermSize=512M 
XX:+UseParallelOldGC -XX:+DisableExplicitGC"

Value Code Example

#Tree node limit for the hierarchy - 
Values is Integer number

TREE_NODE_LIMIT=$VALUE$ TREE_NODE_LIMIT=30
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Internet Explorer Settings

Note: OFSAAI supports only default zoom setting in Internet Explorer, that is, 100%. Cookies should be 
enabled.

The following browser settings have to be specified at every client machine prior to accessing the Infrastructure 
application:

1. Open Internet Explorer. Select Tools > Internet Options. The Internet Options window is displayed.

2. Click the Settings button. The Settings window is displayed.

3. Select the option Every time I Visit the webpage and click OK.

4. In the Internet Options window, select the Security tab and select the Internet option under Select a zone 
to view or change the security settings.
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5. Click Default Level under Security level for this zone.

6. Click OK to save.
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7. In the Internet Options window, select the Privacy tab and select the Turn on Pop-up Blocker option 
under Pop-up Blocker settings.

8. Click Settings. The Pop-up Blocker Settings window is displayed.

9. Enter the URL of the OFSAA Application in the Address of Website to Allow: field.

10. Click Add. The OFSAA URL is displayed in the Allowed Sites section.

11. Click Close.

12. Click OK in the Internet Options window.

Retrieving Patch Information

To identify the list of patches installed on your OFSAA setup, follow these steps:

1. Login to the OFSAA application as a user with Object AdminAdvanced Role.

2. Navigate to Object Administration tab, expand Utilities and click Patch Information.

3. The window displays the list of patches installed on the OFSAA setup across Applications/ Platform.
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OLAP Data Server Configuration

This section is applicable if you are using the OLAP feature of OFSAAI.

The following parameters must be set to ensure that the system limitations are not exceeded at any stage. The 
values for these OS parameters should be specified based on the expected load at each implementation site.

Example:

Process Memory Limit

Max Thread Stack Size

Max Number of Threads per Process

• Sort Buffer settings: This must be set at the Essbase application level appropriate to the anticipated load.

• Shutdown and Restart: During shutdown of OFSAAI Server that has an instance of Data Services that is 
communicating with an OLAP Data Server, it is imperative to ensure that the cleanup of the old instance is 
completed on the OLAP Data Server before restarting the OFSAAI Server. Pause for a period of time based 
on the load the system was subjected to, before restarting the Data Services subsystem.

Changing IP/ Host name, Ports, Deployed Paths of the OFSAA 
Instance

For information on this section, see the OFS Analytical Applications Infrastructure Administration User Guide.

OFSAAI Setup Information Fetching Tool

Executing the SetupInfo.jar file available in the FIC_HOME path will help you retrieve the related information 
about the OFSAAI Set up such as Operating System Name and version, Database Type and Version, OFSAAI 
architecture, Log file locations and so on.

To execute SetupInfo.jar in console:

1. Navigate to the path $FIC_HOME.

2. Enter the command:

java -jar SetupInfo.jar

After execution, the output file location is displayed in the console.

Encryption Changer

This utility helps you to regenerate the new AESCryptKey.ext file and encrypt all the encrypted values of the 
OFSAAI setup according to the new key.

To execute EncryptC.jar in console:

1. Navigate to the path $FIC_HOME.

2. Enter the command:

java -jar EncryptC.jar
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3. A confirmation message is displayed after execution.

Once executed, you need to create and deploy the EAR / WAR file depending on the configured Web Application 
Server. For more information, see Creating EAR/WAR File and Deploying EAR/WAR File sections.

Infrastructure LDAP Configuration

For more information on LDAP configuration, see the OFS Analytical Applications Infrastructure Administration 
User Guide.

Configure OFSAAI Web Services

Web Services in OFSAAI is meant for exposing a web service to "asynchronously" or "synchronously" execute 
requested tasks offered by OFSAAI. The configuration steps given below are to be done only if you are using 
the Web Services feature of OFSAAI.

Configure DynamicWSConfig.xml File

For each third party web service that needs to be accessed using the OFSAAI Web services framework and the 
operations to be invoked, corresponding entries are to be made in the DynamicWSConfig.xml template file.

The variable <WebServer> denotes any one of the application server, i.e. WebSphere, WebLogic, or Tomcat.

The DynamicWSConfig.xml file will be available in the <OFSAAI Installation Directory>/EXEWebService/ 
<WebServer>/ROOT/conf directory. This file can be placed in any directory that is accessible by the application 
and this location must be specified in the web.xml file, as WSCONFIGFILE parameter.

The DynamicWSConfig.xml template file will be in <WebServer Deployment Path>/ EXEWebService.ear/
EXEWebService.war/conf directory.

This template is given below:

<XML>

<WEBSERVICES>

<WEBSERVICE CODE="$CODE"

ENDPOINT="$ENDPOINT" TARGETNAMESPACE="$TARGETNAMESPACE"

XMLNS_XSD="$XMLNS_XSD" ENCODINGSTYLE="$ENCODINGSTYLE"

SERVICENAME="$SERVICENAME" PORTTYPENAME="$PORTTYPENAME"

SESSION_MAINTAIN_PROPERTY="$SESSION_MAINTAIN_PROPERTY"

USERNAME="$USERNAME"

PASSWORD="$PASSWORD" STYLE="$WEBSERVICESTYLE"

STUBIMPLEMENTATION="$STUBIMPLEMENTATION">

<OPERATION CODE="$CODE"

NAME="$NAME"

SOAPACTION="$SOAPACTION"

STYLE="$STYLE"
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PACKAGENAME="$PACKAGENAME">

<INPUT ORDER="$ORDER"

PARAMNAME="$PARAMNAME"

ARGTYPE="$ARGTYPE"

CLASSNAME="$CLASSNAME"/>

<OUTPUT PARAMNAME="$PARAMNAME"

RETURNTYPE="$RETURNTYPE"

CLASSNAME="$CLASSNAME"/>

</OPERATION>

</WEBSERVICE>

</WEBSERVICES>

</XML>

The DynamicWSConfig.xml has the placeholders as tabulated below. These have to be updated depending on 
the web service chosen and the mode of accessing it. For each Web service to be accessed, the entire web 
service tag in the DynamicWSConfig.xml file must be repeated. The placeholders tabulated below should be set 
in accordance to the parameters published in the third party wsdl files (web-services) to be accessed. The stub 
class specified must implement the "com.iflex.Oracle Reveleus.execution.webservice.EXEWebIF" 
interface.

Attributes for WEBSERVICE tag

Placeholder Description

$CODE Unique number within the xml file and cannot be 999 or 0.

$ENDPOINT soap: address location in the wsdl: service name tag of the wsdl file.

$TARGETNAMESPACE The attribute value for the targetNamespace of the wsdl: definitions tag.

$XMLNS_XSD The attribute value for the xmlns:s of the wsdl:definitions tag.

$ENCODINGSTYLE The attribute value for the xmlns:soapenc of the wsdl:definitions tag.

$SERVICENAME Name of the service found under the wsdl:service name tag of the wsdl file.

$PORTTYPENAME wsdl port type name as mentioned in the wsdl file.

$SESSION_MAINTAIN_PROPERTY This could be given as "" also.

$USERNAME User name to access the web services. Enter "" if no user name is required.

$PASSWORD Password to access the web services. Enter "" if no password is required.

$WEBSERVICESTYLE This can take either "rpc" in case of DII mode of invoking web services or "stub" 
in case of static mode. This is a mandatory parameter.

$STUBIMPLEMENTATION Fully qualified class name (package name.classname).
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Attributes for OPERATION tag

Ensure that the "operation tag attributes" are repeated for each of the operation tags.

Attributes for INPUT tag

Attributes for OUTPUT tag

Placeholder Description

$CODE Should be unique within the Web service tag.

$NAME The name of the Function that is to be called by the wsdl file.

$SOAPACTION The URL for the Operation to access. This is associated with the Operation tag of 
the wsdl file.

$STYLE This can take "rpc" if the web services invoking is in DII mode or "stub" if it is in 
static mode. This is a mandatory parameter.

$PACKAGENAME Represents the JAXB package of input object.

Placeholder Description

$ORDER The sequential number of the INPUT tag. Should start from 0. This is in line with 
the input order of the arguments that the API accepts which is called by this 
operation.

$PARAMNAME Input parameter name to be called by the wsdl file.

$ARGTYPE Input Parameter Data Type. If the input argument type is complex object, specify 
$ARGTYPE as "xmlstring".

$CLASSNAME Represents class name of input object parameter.

Placeholder Description

$PARAMNAME Output parameter name to be returned by the web service.

$RETURNTYPE Output parameter Data Type. If the web service response is a complex object, 
then specify $RETURNTYPE as "object".

$CLASSNAME Represents class name of output object parameter.
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web.xml Entries

This step is optional and required only if the web application server used is Tomcat. In case of any other 
application server, skip and proceed with next step.

1. Navigate to $FIC_HOME/webroot/WEB-INF/ and edit the web.xml file. Set parameter value DOCSERVICEAPP 
to EXEWebServiceAXIS.

2. Navigate to <OFSAAI Installation Directory>/EXEWebService/<WebServer>/ROOT/WEB-INF/ and 
edit the web.xml file as explained below.

Note: In case of Java 7 when WebLogic is used as web application server replace following line of <OFSAAI 
Installation Directory>/EXEWebService/Weblogic/ROOT/WEB-INF/web.xml file that is

<?xml version='1.0' encoding='UTF-8'?> 

<web-app id="WebApp_ID" version="3.0" 

xmlns="http://java.sun.com/xml/ns/javaee" 

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 

xsi:schemaLocation="http://java.sun.com/xml/ns/javaee 

http://java.sun.com/xml/ns/javaee/web-app_3_0.xsd" metadata-complete="true">

with

<?xml version='1.0' encoding='UTF-8'?> 

<web-app xmlns="http://java.sun.com/xml/ns/j2ee" 

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">

Entry for WSConfig File

The WSCONFIG file (DynamicWSConfig.xml) is available in the <WebServer Deployment Path>/ 
EXEWebService.ear/EXEWebService.war/conf directory. This file can be placed in any directory that is 
accessible by the application.

The path where the WSCONFIG file is placed must be specified in place of $WSCONFIGFILELOCATION$ in the 
below block of text in web.xml.

<context-param>

<description>WebServices Configuration File</description>

<param-name>WSCONFIGFILE</param-name>

<param-value>$WSCONFIGFILELOCATION$</param-value>

<!--Specify the Location of DynamicWSConFig.xml-->

</context-param>
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Proxy Settings

Replace the following <param-value> given in bold in the following block of text in web.xml file, with appropriate 
values.

If no values are required, leave the <param-value> blank.

<context-param>

<description>http Proxy Host</description>

<param-name>http.proxyHost</param-name>

<param-value>$PROXYHOST$</param-value>

<!-- Specify the IP address or hostname of the http proxy server-->

</context-param>

<context-param>

<description>http Proxy Port</description>

<param-name>http.proxyPort</param-name>

<param-value>$PROXYPORT$</param-value>

<!--Port Number for the Proxy Server-->

</context-param>

<context-param>

<description>http proxy UserName</description>

<param-name>http.proxyUserName</param-name>

<param-value>$PROXYUSERNAME$</param-value>

<!-- User ID To get authenticated by proxy server-->

</context-param>

<context-param>

<description>http proxy Password</description>

<param-name>http.proxyPassword</param-name>

<param-value>$PROXYPASSWORD$</param-value>

<!-- User Password To get authenticated by proxy server-->

</context-param>

<context-param>

<description>http non-ProxyHosts</description>

<param-name>http.nonProxyHosts</param-name>

<param-value>$NONPROXYHOST$</param-value>

<!--Hosts for which the proxy settings should get by-passed (Note: Separate them by 

"|" symbol) -->

</context-param>
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OFSAAI Home Entry

This entry should point to the Application layer / Web layer of the OFSAAI installation and should be accessible.

Replace $FIC_HOME$ in the following block of text in web.xml with <WebServer Deployment Path>/
EXEWebService.ear/EXEWebService.war.

<context-param>

<description>OFSAAI Web Home</description>

<param-name>FIC_HOME</param-name>

<param-value>$FIC_HOME$</param-value>

<!--OFSAAI Installation Folder-->

</context-param>

<context-param>

<description>OFSAAI Web Home</description>

<param-name>FIC_PHYSICAL_HOME</param-name>

<param-value>$FIC_HOME$</param-value>

<!--OFSAAI Installation Folder-->

</context-param>

DynamicWSConfig.xml

For each third party web service that needs to be accessed using the OFSAAI Web services framework, and 
the operation to be invoked, make corresponding entries into this file. This file is to be placed in the location that 
is specified in the web.xml, as WSCONFIGFILE parameter.

Deploy OFSAAI Web Services

You can deploy OFSAAI Web Services separately if you had not configured OFSAAI Web Services as part of 
the installation.

1. Complete the manual configuration of OFSAAI Web Services.

2. Navigate to <OFSAAI Installation Directory>/EXEWebService/<WebServer> and execute the 
command:

./ant.sh

3. This will trigger the EAR/WAR file creation, which is required for the deployment. 

4. Deploy the generated EXEWebService.EAR/ EXEWebService.WAR file into the Web Server.

If you have already configured OFSAAI Web Services as part of the installation, deploy the generated 
EXEWebService.EAR/ EXEWebService.WAR file into the OFSAAI Deployment area in Web Server profile.
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Configuration to Enable Parallel Execution of DML Statements

A configuration file, OracleDB.conf has been introduced to accommodate any configurable parameter related 
to operations on oracle database. If you do not want to set a parameter to a specific value, then the respective 
parameter entry can be removed/commented off form the OracleDB.conf file which resides in the path 
$FIC_DB_HOME/conf.

As of now, the OracleDB.conf file has only one parameter namely CNF_DEGREE_OF_PARALLELISM. This 
parameter indicates the degree of parallelism to be used for a DML operation if parallel DML is explicitly enabled 
in the session with the ENABLE PARALLEL DML clause of the ALTER SESSION statement. The default mode of a 
session is DISABLE PARALLEL DML.If CNF_DEGREE_OF_PARALLELISM is not set, then the default degree, as 
decided by Oracle will be used.

Configure Message Details in Forms Designer

You can configure the Message Details in Forms Designer under Data Entry Forms and Queries module by 
updating the details of mail server in the "NotificationConfig.cfg" file which resides in the path 
$FIC_APP_HOME/common/FICServer/conf.

Ensure that the "authorized User details" for whom you need to configure the Message details are included in 
Administration > Security Management > User Administrator > User Maintenance window.

Update the following parameters in the "NotificationConfig.cfg" file:

Ensure that the authorized User details are included in Administration > Security Management > User 
Administrator > User Maintenance window.

Parameter Description

SMTP_SERVER_IP Specify the host name or IP address of SMTP Server.

SMTP_DEBUG_MODE To run SMTP service in Debug mode, set value to 'true', otherwise set value to 
'false'.

SMTP_AUTHORIZATION Set to 'true' if SMTP server requires the client to be authenticated, otherwise set 
to 'false'.

SMTP_USERNAME Username required for logging into SMTP server, if authentication is not required 
use a dummy value.

SMTP_PASSWORD Password required for logging into SMTP server, if authentication is not required 
use a dummy value.

SMTP_MAILID If the Messages has to go from a Particular ID that ID need to be added. Exchange 
server forces you set a valid ID that is there in the exchange server (Based on 
Security settings).
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Clearing Application Cache

This is applicable to all Web Servers (i.e. WebSphere, WebLogic, and Tomcat).

Prior to the deployment of Infrastructure or Application Service Packs / One-off patches, navigate to the 
following path depending on the Web Server configured and clear the cache:

• Tomcat: <Tomcat installation folder>/work/Catalina/localhost/<Application name>/org/
apache/jsp

• WebLogic: <Weblogic installation location>/domains/<Domain name>/servers/<Server name>/
tmp/_WL_user/<Application name>/qaelce/jsp_servlet

• WebSphere: <Websphere installation directory>/AppServer/profiles/<Profile name>/temp/
<Node name>/server1/<Application name>/<.war file name>

Configuring Password Changes

This section explains about how to modify the OFSAA Infrastructure Config Schema and Atomic Schema 
passwords.

OFSAA Infrastructure Config Schema Password Modification

To change the Config Schema password, perform the following steps:

1. Change the Config schema User Password in the database.

2. Delete the $FIC_HOME/conf/Reveleus.SEC file.

3. Shutdown the OFSAAI App service:

cd $FIC_APP_HOME/common/FICServer/bin

./stopofsaai.sh

4. Start the Infrastructure Server in foreground directly on the server or through X-Windows software using the 
command:

./startofsaai.sh

At the prompt, enter System Password. Enter the "new Config schema" password. The service will start and 
initialize itself if it is able to successfully connect to the DB.

5. Post successful startup of the service, if required, the Infrastructure server may be shut down and restarted 
in the background using nohup mode.

OFSAA Infrastructure Atomic Schema Password Modification

To change the Atomic Schema password, perform the following steps:

1. Change the Atomic schema User Password in the database.

2. Login to the application from the browser using SYSADMN account or any user id, which has System 
Administrator role mapped.

3. Navigate to System Configuration > Database Details window. Modify the password as explained in the 
following steps:
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 From the Database Master window, select the connection whose password you want to modify and click   
button from the tool bar.

 Click button corresponding to the Alias Name. The Alias Details window is displayed.

 Modify the password in the Auth String field.

4. If you are using Apache Tomcat as Web server, update the <Context> -> Resource tag details in Server.xml 
file from the $CATALINA_HOME/conf folder. (In case of Tomcat only Atomic <Resource> will exist).

5. If you are using WebSphere as Web server:

a. Login to the WebSphere Administration Console, from the left side menu.

b. Navigate to Resources >JDBC >Data Sources. A list of data sources will be populated on the right 
side.

c. Select the appropriate Data Source and edit the connection details. (In this case, both Config and 
Atomic data sources will need to be modified).

6. If you are using WebLogic as Web server:

a. Login to the WebLogic Administration Console, from the left side menu.

b. Under Domain Structure list box, expand the appropriate Domain and navigate to Services > JDBC 
>Data Sources. A list of data sources will be populated on the right side.

c. Select the appropriate Data Source and edit the connection details. (In this case, both Config and 
Atomic data sources need to be modified).

7. Restart the OFSAAI services.

Configuring Java Virtual Machine

While running several database intensive tasks in parallel, fetching the database connection from connection 
pool may face an error. To ensure no such error is encountered, add the line securerandom.source=file:/
dev/./urandom in the java.security configuration file available in $JAVA_HOME/jre/lib/security/ path.

This needs to be configured on all the machines or virtual machines where the OFSAAI database components 
(ficdb layer) are installed.

Configure Internal Service (Document Upload/ Download)

This step can be ignored if it has already been configured as part of any previous IR/ML installation.

The Document Upload/Download feature has undergone a change and can now be configured to use Internal 
service for document upload/ download instead of the earlier ExeWebService.

To facilitate Internal service for document upload/ download, perform the following configurations:

1. Create the folders download, upload, TempDocument and Temp in the local path of Web application server 
and provide Read/Write permission.

 To find the exact location, execute the following query in CONFIG schema:

select localpath from web_server_info

 To create folders with Read/Write permission, execute the command:

mkdir -m 777 download upload TempDocument Temp

2. Create DocStorage folder in the FTPSHARE location of APP tier and provide Read/Write permission.
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 To find the exact location, execute the query in CONFIG schema:

select ftpdrive from app_server_info

 To create folder with Read/Write permission, execute the command:

mkdir -m 775 DocStorage

By default, the parameter DOCUMENT_SERVICE_TYPE_EXTERNAL value is set to FALSE in the Configuration table 
in CONFIG schema and hence the application "ExeWebService" will not be used. It is recommended that the 
value to be set to FALSE and use the Internal service for document upload/ downloads. If you intend to continue 
using the External ExeWebService, set the value to TRUE.

Navigate to $FIC_HOME/EXEWebService/<WEBSERVER_TYPE> directory of WEB tier and type ./ant.sh. This 
triggers the creation of EAR/WAR file EXEWebService.ear/.war. The EAR/WAR file EXEWebService.ear/
.war will be created in $FIC_HOME/EXEWebService/<WEBSERVER_TYPE> directory of WEB tier. Redeploy the 
generated EAR/WAR file onto your configured web application server.
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Cloning of an OFSAA Instance
APPENDIX A - CLONING OF AN OFSAA INSTANCE

There is a consistent need for a faster and effective approach of replicating an existing OFSAA instance for 
further project developments, that is, setting up OFSAA instances that are exact copies of the current OFSAA 
instance. For more information on cloning, see OFSAA Cloning Reference Guide.
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Cloning of an OFSAA Instance
Oracle Insurance Performance Insight Application Pack Installation and Configuration Guide - 8.0.7.0.0 200



Migration for Excel Upload
APPENDIX A - MIGRATION FOR EXCEL UPLOAD

This appendix provides detailed instructions to migrate for excel upload.

Prerequisites

The following are the prerequisites for migration:

• Data model in ATOMIC schemas should be same on the source and target setups.

• OFS AAI (platform) patch level version should be same on the source and target setups.

• PL/SQL Developer to connect and query the database.

• WinSCP to connect and access server file system.

Migration for Excel Upload

To migrate, follow these steps:

1. Open PL/SQL Developer and log in to the source setup's configuration (CONFIG) schema by entering the 
appropriate username and password.

2. In a new SQL window query the data of table EXCEL_MAPPING_MASTER.

3. Open a new session in PL/SQL developer and log in to the target setup's configuration (CONFIG) schema 
by entering the appropriate username and password.

4. Insert the records from Step 1 above in to this table.

5. In V_INFODOM column of EXCEL_MAPPING_MASTER table update the infodom name with the target 
infodom name.

Note: If all the mappings can work out of the single target Infodom, update same Infodom value across all 
rows. If only few mappings will work out of the target infodom, update the infodom value for selective 
records. Excel upload mappings will work only if the target infodom has same data model entities as used 
in the mappings defined on source setup.

6. Update V_CREATED_BY column with the name of any user present in the target setup that has appropriate 
roles to perform Excel Upload tasks.

Note: It is mandatory to update values for V_INFODOM and V_CREATED_BY columns.

7. Open WinSCP and login a new session by entering the host name, port number, user name and password 
to access the source setup. 

8. Navigate to the folder referred as FTPSHARE.
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9. Copy the excel-entity mapping xml file(s) which are located in this folder according to their folder structure 
on to your desktop. For example: /ftpshare /STAGE/ExcelUpload/$SOURCE_INFODOM_NAME/
$EXCEL_FILE_NAME.xml

Note: Actual file name of Excel Sheet is mentioned in the V_EXCEL_NAME column of 
EXCEL_MAPPING_MASTER table.

10. Copy the excel templates (.xls/ .xlsx) file(s) which are located in this folder according to their folder structure 
on to your desktop. For example: /ftpshare/STAGE/ExcelUpload/TEMPLATE/*.xls or *.xlsx

Note: Ignore this step if files are not present at the location.

11. Login a new session in WinSCP by entering the host name, port number, user name and password to 
access the target setup.

12. Copy the xml file(s) from Step3 to the below location in the target setup. For example: /ftpshare/STAGE/
ExcelUpload/$TARGET_INFODOM_NAME/$EXCEL_FILE_NAME.xml

Note: $TARGET_INFODOM_NAME should be target setup infodom in which you have uploaded the 
appropriate data model and the name should be same as the V_INFODOM column value updated in 
EXCEL_MAPPING_MASTER table.

13. Copy the xls/ xlsx file(s) from Step 3 to the below location in target setup. For example: /ftpshare/STAGE/
ExcelUpload/TEMPLATE/*.xls or *.xlsx

Note: Ignore this step if files are not present at the location.
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APPENDIX A - VISIBILITY

Data Visibility

Data visibility refers to the data control established on the results fetched by reports depending on the user 
logged in.

For each user, only those accounts which are directly handled or are handled by a subordinate are visible.

If the logged in user is an RM, then only those accounts which are associated to that user's organizational 
hierarchy will be fetched. This is achieved through FSI_M_USER_MANAGER_MAP table.

If a user is Relationship Manager (RM), then the particular log in ID and the manager code from 
DIM_MANAGEMENT table have to be populated into FSI_M_USER_MANAGER_MAP table. Also, the table 
FCT_ACCOUNT_MGR_REL should have the necessary details for the relationship manager to account mapping.

A user logging in without any associated Manager code should have access to the entire data available.

The entries to FSI_M_USER_MANAGER_MAP table have to be manually inserted. It has two columns, V_USERNAME 
and V_MANAGER_CODE. The V_USERNAME has to be inserted with the login username created in OBIEE and 
V_MANGER_CODE has to be inserted with the manager code of the corresponding user from DIM_MANAGEMENT 
table. 

Example

The following diagram depicts a hierarchy of Relationship Managers:

The data visibility for each of the Relationship Managers, starting from the top of the hierarchy is as follows: 

• RM1 user has control over the data associated to that user along with the data associated to the immediate 
subordinates, that is, RM2, RM5, and their subordinates till the end of the hierarchy.

• RM2 user has control over the data associated to that user along with the data associated to the immediate 
subordinates, that is, RM3, RM4, and their subordinates till the end of the hierarchy.

• RM5 user has control over the data associated to that user along with the data associated to the immediate 
subordinate, that is, RM6 and his subordinates till the end of the hierarchy.

If the logged in user is a Sales Representative (SR), the data associated with the opportunities managed by the 
respective Sales Representatives are visible. Each Sales Representative will have unique skey values and 
accounts related to those skeys are displayed in reports.
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Report Visibility

This section describes the following sub-sections:

• Report Visibility for IPA

• Report Visibility for RPA

Report Visibility for IPA

The Report’s visibility for IPA application is restricted as per the below table:

The Reports visibility for the different roles has to be handled by setting proper catalog Permissions. The steps 
to setup these permissions are described in Setting Up Dashboard Visibility under Configure Roles and Groups 
of this document.

Note: Those users who have access to any of the above dashboards with PII columns should also be mapped 
to the ‘Data Security Group’ in OFSAA using SMS.

If PII entitlements change for a given user; then you need to either clear the cache through OBIEE admin 
or refresh the report.

Application Role Dashboard Tab PII Availability

Business Analyst Business Summary Performance Summary

Cross Sell

Product Performance

Line of Business Performance

Customer Summary

What-If Analysis

No

No

No

No

Yes

No

Customer Central Customer 360

Customer Group

Yes

Yes

Opportunities & Activities Top 10 Opportunities

Opportunities

Activities

Yes

No

Yes

Relationship 
Manager

Relationship Manager Insights Relationship Manager Insights

Top 10 Opportunities

Opportunities

Activities

Yes

Yes

No

Yes

Sales 
Representative

Opportunities & Activities Opportunities

Activities

No

Yes

Administrator All Dashboards All Tabs and Reports
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Report Visibility for RPA

The Report’s visibility for IPA application is restricted as per the below table:

The Reports visibility for the different roles has to be handled by setting proper catalog Permissions. The steps 
to setup these permissions are described in Setting Up Dashboard Visibility under Configure Roles and Groups 
of this document.

Note: Those users who have access to any of the above dashboards with PII columns should also be mapped 
to the ‘Data Security Group’ in OFSAA using SMS.

If PII entitlements change for a given user; then you need to either clear the cache through OBIEE admin 
or refresh the report.

Application Role Dashboard Tab PII Availability

Business Analyst Business Analysis Performance Summary

New Business Analysis

Revenue Analysis

Expense Analysis

Credit Loss Summary

Margin Report

Customer Summary

What-If Analysis

No

No

No

No

No

No

No

No

Customer Central Customer 360

Customer Performance

Yes

Yes

Product Summary All Products

Cards

Retail Bank

Mortgage

No

No

No

No

Relationship 
Manager

Relationship Manager Insights Relationship Manager Insights Yes

Administrator/
Super User

All Dashboards All Tabs and Reports
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Metadata Visibility

Accessibility to presentation layer objects for creating ad-hoc reports varies from user-to-user depending on the 
application role the user is allocated.

The following are the requirements for viewing the metadata in RPD:

Application Role Tables for Ad-hoc Reporting

Business Analyst role Fact-Account Summary

Fact Account Profitability

Fact Opportunity

Fact Opportunity Activity

Fact Management Forecast

Fact Customers

Relationship Manager role Fact Relationship Manager Contribution

Fact Relationship Manager Profitability

Fact Opportunity

Fact Opportunity Activity

Sales Representative role Fact Opportunity

Fact Opportunity Activity

Fact Sales Representative Compensation

Administrative role (WebLogic) All tables
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APPENDIX A - REMOVING OFSAA

This chapter includes the following sections:

• Uninstalling OFSAA Infrastructure

• Uninstalling EAR Files in WebSphere

• Uninstalling EAR Files in WebLogic

• Uninstalling WAR Files in Tomcat

Uninstalling OFSAA Infrastructure

This section will guide you through the necessary steps to uninstall the OFSAA Infrastructure product.

Before you start the uninstallation process, ensure that no open connections exist to the OFSAA Infrastructure 
Config and Atomic Schemas and Infrastructure services are brought down.

To uninstall OFSAA Infrastructure:

1. Log in to the system as non-root user.

2. Navigate to the $FIC_HOME directory and execute the command:

./Uninstall.sh

3. Enter the password for OFSAAI Configuration Schema when prompted as shown in the following figure.

Note: Uninstallation does not remove the Infrastructure application from the Web Application Server. This has 
to be done manually.

The entries in the .profile file will have to be removed manually.

The files/ folders under the file system staging area (ftpshare) have to be deleted manually.

All the Database objects from Atomic Schemas have to be dropped manually.
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Uninstalling EAR Files in WebSphere

Following are the steps to uninstall any previously deployed application:

1. Open the URL in the browser window: http://<ipaddress>:<Administrative Console Port>/ibm/console (https 
if SSL is enabled). The Login window is displayed.

2. Login with the user id that has admin rights.

3. Expand Applications > Application Types > WebSphere enterprise applications from the LHS. The 
Enterprise Applications window is displayed with all the deployed applications.

4. Select the check box adjacent to the application to be uninstalled and click Stop.

5. Click Uninstall to display the Uninstall Application window.

6. Click OK to confirm.

7. Click Save to save the master file configuration.
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Uninstalling EAR Files in WebLogic

On the machine that hosts WebLogic, perform the following steps to uninstall any previously deployed 
application:

1. Open the URL in the browser window: http://<ipaddress>:<admin server port>/console (https if SSL is 
enabled). The Login window of the WebLogic Server Administration Console is displayed.

2. Login with the WebLogic user credentials having administrator privileges.

3. From the Domain Structure LHS menu, click Deployments to display the Summary of Deployments screen.

4. Select the check box adjacent to the application to be uninstalled and click Stop > Force Stop Now.

5. Click Yes in the confirmation dialog to stop the selected deployment.

6. Select the check box adjacent to the application and click Delete to delete the selected deployment.

7. Click Yes in the confirmation dialog to remove the selected deployment from the domain configuration.
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Uninstalling WAR Files in Tomcat

On the machine that hosts Tomcat, perform the following steps to uninstall any previously deployed application:

1. Comment out Context path section from server.xml file in $CATALINA_HOME/conf directory to avoid conflict 
during undeploy and re-deploy of the WAR file.

Place comment <!-- --> in between the context path section. For example:

<!--

<Context path ="/pr2test" docBase="/home/perfuser/tomcat-7.0.19/webapps/pr2test" 
debug="0" reloadable="true" crossContext="true">

<Resource auth="Container"

name="jdbc/PR2ATM"

type="javax.sql.DataSource"

driverClassName="oracle.jdbc.driver.OracleDriver"

username="pr2atm"

password="pr2atm"

url="jdbc:oracle:thin:@10.184.74.99:1521:PERFTEST"

maxActive="100"

maxIdle="30"

maxWait="10000"/>

</Context>

-->

Restart the Tomcat service by doing the following:

a. Login to the "Unix server" through a terminal emulator.

b. Navigate to $catalina_home/bin directory.

c. Stop the tomcat services using the following command:

./shutdown.sh

d. Start the tomcat services using the following command:

./startup.sh

2. Open the URL in a browser window: http://<IP address>:<Tomcat server port>. (https if SSL is enabled). 
The Tomcat home window is displayed.

3. Click the Manager App. The Connect to window is displayed.
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4. Login with the user credentials having admin rights. The Tomcat Web Application Manager window is 
displayed with the list of all applications deployed in Tomcat.

5. Click the Undeploy link against the deployed Infrastructure application. A confirmation message is 
displayed on the application /Infrastructure being uninstalled.
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APPENDIX A - UPGRADING AN EXISTING OFSAA 8.0.X JAVA 7 
INSTANCE TO JAVA 8

This appendix explains the configurations required to upgrade an existing OFSAA 8.0.x Java 7 instance to Java 
8. It consists of the following topics:

• Prerequisites

• Steps for upgrading OFSAA 8.0.x Java 7 instance to Java 8

• Web Application Server Configurations

• OFSAA Generic Configurations

• OFSAA Configurations for New Web Application Server Installation

Prerequisites

The following are the prerequisites for upgrading OFSAA 8.0.x Java 7 instance to Java 8:

• Java 8 should be installed on the OFSAA server and Web Application Server.

• Oracle WebLogic Server should be 12.1.3.0 or above. Download and install patch 18729264 from http://
support.oracle.com/.

Note: IBM WebSphere 8.5.x (Full Profile) on Java 8 is not available.

Steps for upgrading OFSAA 8.0.x Java 7 instance to Java 8

To upgrade OFSAA 8.0.x Java 7 instance to Java 8, follow these steps:

1. Configure Web Application Server to Java 8. For more information, see Configuring Web Application Server.

2. Configure the OFSAA instance to Java 8. For more information, see OFSAA Generic Configurations. For a 
newly installed Web Application Server, see OFSAA Configurations for New Web Application Server 
Installation.

3. Restart the OFSAA services. For more information, see Start/Stop OFSAA Infrastructure Services section.

4. Generate the application EAR/WAR file and redeploy the application onto your configured web application 
server. For more information on generating and deploying EAR / WAR file, see Creating EAR/WAR File and 
Deploying EAR/WAR File sections.
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Web Application Server Configurations

This section describes the changes to be made in the Web Application Server. Following are the two options to 
perform Web Application Server Configurations which are listed as follows:

• Upgrade the existing Web Application Server installation to Java 8

• Install a new instance of the Web Application Server with Java 8

This section consists of the following topics:

• Oracle WebLogic Server Updates

• Apache Tomcat Server Updates

Oracle WebLogic Server Updates

Perform the following configurations to upgrade the existing WebLogic server instance to Java 8:

1. Navigate to <WLS_HOME>/Middleware/Oracle_Home/wlserver.

2. Edit the product.properties file. Set JAVA_HOME, WLS_JAVA_HOME, JAVAHOME properties to the new Java 
path and java.vm.version to the new Java version. For example:

JAVA_HOME=/usr/java/jre1.8.0_45

WLS_JAVA_HOME=/usr/java/jre1.8.0_45

JAVAHOME=/usr/java/jre1.8.0_45

java.vm.version=1.8.0_45

3. Navigate to <WLS_HOME>/Middleware/Oracle_Home/user_projects/domains/<domain>/bin. Update 
SUN_JAVA_HOME, DEFAULT_JAVA_HOME, JAVA_HOME in the setDomainEnv.sh file to point to the new Java 
path. For example: 

SUN_JAVA_HOME="/usr/java/jre1.8.0_45"

DEFAULT_SUN_JAVA_HOME="/usr/java/jre1.8.0_45"

JAVA_HOME="/usr/java/jre1.8.0_45"

4. Clear the Application cache. Navigate to the following path and delete the files:

<Weblogic installation location>/domains/<Domain name>/servers/<Server name>/tmp/
_WL_user/<Application name>/qaelce/jsp_servlet

If you want to install a new instance of the Oracle WebLogic Server, follow these steps:

1. Install Oracle WebLogic Server 12.1.3.x on Java 8.

2. Perform the configurations for the newly installed WebLogic server. For more information, see Configure 
Resource Reference in WebLogic Application Server.

Note: While creating WebLogic Domain, the Listen Port should be set same as that of the existing Domain. 
Note down the new Domain path to perform OFSAA Configurations.
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Apache Tomcat Server Updates

Perform the following configurations to upgrade the existing Apache Tomcat Server from Java 7 to Java 8:

1. Login to the Apache Tomcat Server as a non-root user.

2. Edit the user.profile. Update the value for JAVA_HOME from JRE 1.7 to JRE 1.8. For Example:

JAVA_HOME=/usr/java/jre1.8.0_45

3. Clear the Application cache. Navigate to the following path and delete the files:

<Tomcat installation folder>/work/Catalina/localhost/<Application name>/org/apache/jsp

If you wish to install a new instance of the Apache Tomcat Server, follow these steps:

1. Install Apache Tomcat Server 8 with Java 8.

2. Perform the configurations for the newly installed Tomcat server. For more information, see Configure 
Resource Reference in Tomcat Application Server.

Note: Update the Connector Port in /apache-tomcat-8.0.21/conf/server.xml file to that of the existing 
Tomcat instance. Note down the new deployment path to perform OFSAA Configurations.

OFSAA Generic Configurations

User .profile Settings

Perform the following configurations:

1. Login to the OFSAA Server as a non-root user.

2. Edit the user .profile. Update the value for PATH variable from JRE 1.7 to JRE 1.8. For Example,

PATH=/usr/java/jre1.8.0_45/jre

JAVA_BIN=/usr/java/jre1.8.0_45/jre/bin

LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/usr/java/jre1.8.0_45/jre/lib/amd64/server
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OFSAA Configurations for New Web Application Server Installation

This configuration is required only if you have freshly installed Oracle WebLogic 12.1.3 or Apache Tomcat 
Server 8.0. Follow these steps:

1. Modify the following parameters in the Configuration table present in the Config Schema with the new 
Domain Path in case of WebLogic or with the new deployment path in case of Tomcat:

 DeFiHome

 REV_IMG_PATH

 EMBEDDED_JSP_JS_PATH

2. Login to the OFSAA Server as a non-root user.

3. Navigate to $FIC_HOME/ficweb/webroot/WEB_INF and update the following parameters in the web.xml file 
with the new Domain path in case of WebLogic or with the new deployment path in case of Tomcat:

 FIC_PHYSICAL_HOME_LOC

 FIC_HOME

 ICC_SERVLET_LOG_FILE

4. Navigate to $FIC_HOME/ficweb/webroot/conf and update the Domain path in case of WebLogic or with the 
new deployment path in case of Tomcat:

 OFSAALogger.xml

 MDBLogger.xml

 RevLog4jConfig.xml

 RFDLogger.xml

 ExportLog4jConfig.xml

 RFDLogger.xml

 PR2Logger.xml
Oracle Insurance Performance Insight Application Pack Installation and Configuration Guide - 8.0.7.0.0 215



JDBC Jar Files
APPENDIX A - JDBC JAR FILES

The ojdbc<version>.jar file should be copied based on Database and Java version. Refer to the following table 
for details:

Oracle Database version JDK/JRE Version supported JDBC Jar files specific to the release

12.1 or 12cR1 JDK 8, JDK 7 and JDK 8 ojdbc7.jar for JDK 7/JDK 8

11.2 or 11gR2 JDK 7 supported in 11.2.0.3 and 
11.2.0.4

ojdbc6.jar for JDK 7
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APPENDIX A - CONFIGURING APPLICATION PACK XML FILES

OFS_IP_PACK.xml

The OFS_IP_PACK.xml file holds details on the various products that are packaged together in OIPI Application 
Pack.

This section details the various tags/ parameters available in the file and the values that need to be updated. 
Prior to installing the OIPI Application Pack in SILENT mode, it is mandatory to update this file.

Note: If you are installing in the GUI mode, then this file need not be updated.

Tag Name/ Attribute 
Name

Description Mandatory (Y/ 
N)

Default Value/ 
Permissible Value

Comments

APP_PACK_ID Unique Application 
Pack Identifier

Y Unique Seeded Value Do not modify this value.

APP_PACK_NAME Unique Application 
Pack Name

Y Unique Seeded Value Do not modify this value.

APP_PACK_DESCRI
PTION

Unique Application 
Pack Description

Y Unique Seeded Value Do not modify this value.

VERSION Unique release 
version

Y Unique Seeded Value Do not modify this value.

APP Unique Application 
Entries

Y Unique Seeded Value Do not remove these tags.

APP_ID Unique Application 
Identifier

Y Unique Seeded Value Do not modify this value.

APP_ID/ PREREQ Prerequisite 
Application/ Product

Y Unique Seeded Value For most applications 
Infrastructure would be the 
prerequisite set. For certain 
other applications, an 
appropriate Application ID 
would be set.

Do not modify this value.

APP_ID/ 
DEF_SEL_FLAG

Default Selected Flag Y Default - YES In all Application Packs, 
Infrastructure would have 
this value set to "YES". 

Do not modify this value.
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APP_ID/ ENABLE Enable Application/ 
Product

YES if installing 
in SILENT 
mode.

Default - YES for 
Infrastructure

NO for Others

Permissible - YES or 
NO

Set this attribute-value to 
YES against every APP_ID 
which is licensed and should 
be enabled for use.

Note: Application/ Product 

once enabled cannot be 

disabled. However, 

Application/ Product not 

enabled during installation 

can be enabled later through 

the Administration UI.

APP_NAME Unique Application/ 
Product Name

Y Unique Seeded Value Do not modify this value.

APP_DESCRIPTION Unique Application/ 
Product Name

Y Unique Seeded Value Do not modify this value.

VERSION Unique release 
version

Y Unique Seeded Value Do not modify this value.

Tag Name/ Attribute 
Name

Description Mandatory (Y/ 
N)

Default Value/ 
Permissible Value

Comments
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Configuring OFS_IP_SCHEMA_IN.xml

Creating database schemas, objects within schemas and assigning appropriate grants are the primary steps in 
the installation process of OFSAA Applications. The OFS_IP_SCHEMA_IN.xml file contains details on the various 
application schemas that should be created prior to the Application Pack installation.

Note: This file should be configured only if OIPI Application Pack installation for RDBMS ONLY target.
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The following table gives details about the various tags/ parameters available in the file and the values that need 
to be updated. Prior to executing the schema creator utility, it is mandatory to update this file.

Tag Name/ 
Attribute Name

Description Mandatory 
(Y/ N)

Default Value/ Permissible Value Comments

<APP_PACK_I
D>

Seeded unique ID 
for the OFSSAA 
Application Pack

Y Seeded Do not modify this value.

<JDBC_URL> Enter the JDBC 
URL.

Note: You can enter 
RAC/ NON-RAC 
enabled database 
connectivity URL.

Y Example:

jdbc:oracle:thin:@< 
DBSERVER IP/HOST/ 
IP>:<PORT>:<SID>

or

jdbc:oracle:thin:@//[HOS 
T][:PORT]/SERVICE

or 

jdbc:oracle:thin:@(DESCRI 
PTION=(ADDRESS_ 
LIST=(ADDRESS=(PROT 
OCOL=TCP)(HOST=[HO 
ST])(port=[PORT]))(ADD 
RESS=(PROTOCOL=TCP) 
(HOST=[HOST])(PORT=[ 
PORT]))(LOAD_ 
BALANCE=yes)(FAILOV 
ER=yes))(CONNECT_ 
DATA=(SERVICE_ 
NAME=[SERVICE])))

For example:

jdbc:oracle:thin:@//dbhos 
t.server.com:1521/service 
1

or 

jdbc:oracle:thin:@//dbsho 
st.server.com:1521/scan-1

or

jdbc:oracle:thin:@(DESCRI 
PTION=(ADDRESS_ 
LIST=(ADDRESS=(PROT 
OCOL=TCP)(HOST=dbho

st1.server.com)(port=1521)

)(ADDRESS=(PROTOCO

L=TCP)(HOST=dbhost2.s 
erver.com)(PORT=1521))( 
LOAD_ BALANCE=yes)(FAILOV 
ER=yes))(CONNECT_ 
DATA=(SERVICE_

NAME=service1)))

Ensure to add an entry (with 
SID/ SERVICE NAME) in the 
tnsnames.ora file on the 
OFSAA server. The entry 
should match with the SID/ 
SERVICE NAME

used in the JDBC URL.
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<JDBC_DRIVE
R>

By default this 
driver name is 
seeded.

Note: Do not edit 

this attribute value.

Y Example:

oracle.jdbc.driver.OracleDriver

Only JDBC Thin Driver is 
supported.

Do not modify this value.

<HOST> Enter the Host 
name/ IP Address 
of the system on 
which you are 
installing the 
OFSAA 
components.

Y Host Name/ IP Address

<SETUPINFO>/
PREFIX_SCHE
MA_NAME

Identifies if the 
value specified in 
<SETUPINFO>/
NAME attribute 
should be prefixed 
to the schema 
name.

N YES or NO Default value is YES.

<SETUPINFO>/
NAME

Enter the acronym 
for the type of 
implementation. 
This information will 
be displayed in the 
OFSAA Home 
Page.

Note: On executing 

the schema creator 

utility, this value will 

be prefixed with 

each schema 

name. For 

example: 

dev_ofsaaconf, 

uat_ofsaatm.

Y Accepts strings with a minimum 
length of two and maximum of four. 
Example: DEV, SIT, PROD

This name would appear in 
the OFSAA Landing Page as 
"Connected To: xxxx".

The schemas being created 
would get this prefix. For 
example, dev_ofsaaconf, 
uat_ofsaaconf, etc.

Tag Name/ 
Attribute Name

Description Mandatory 
(Y/ N)

Default Value/ Permissible Value Comments
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<PASSWORD>/
DEFAULT*

Enter the password 
if you want to set a 
default password 
for all schemas.

Note: You also 

need to set 

APPLYSAMEFOR

ALL attribute as Y 

to apply the default 

password for all the 

schemas.

N The maximum length allowed is 30 
characters. Special characters are 
not allowed.

<PASSWORD>/
APPLYSAMEF
ORALL

Enter as Y if you 
want to apply the 
password specified 
in DEFAULT 
attribute for all the 
schemas. 

If you enter as N, 
you need to provide 
individual 
passwords for all 
schemas.

Note: In case you 

have entered Y in 

APPLYSAMEFOR

ALL attribute and 

also have specified 

individual 

passwords for all 

the schemas, then 

the specified 

individual 

passwords will take 

precedence.

Y Default - N

Permissible - Y

Note: Setting this attribute 

value is mandatory, if 

DEFAULT attribute is set.

Tag Name/ 
Attribute Name

Description Mandatory 
(Y/ N)

Default Value/ Permissible Value Comments
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<SCHEMA>/
TYPE

The different types 
of schemas that are 
supported in this 
release are 
ATOMIC, CONFIG, 
SANDBOX, and 
ADDON.

By default, the 
schemas types are 
seeded based on 
the Application 
Pack.

Note: Do not edit 

this attribute value.

Y ATOMIC/CONFIG/SANDBOX/
ADDON

Only One CONFIG schema 
can exist in the file.

This schema identifies as the 
CONFIGURATION schema 
that holds the OFSAA setup 
detains and other Metadata 
information.

Multiple ATOMIC/
SANDBOX/ADDON 
schemas can exist in the file.

ATOMIC schema refers to 
the Information Domain 
schema. SANDBOX schema 
refers to the SANDBOX 
schema. ADDON schema 
refers to other miscellaneous 
schema (not applicable for 
this Application Pack).

<SCHEMA>/
NAME

By default, the 
schema names are 
seeded based on 
the Application 
Pack.

You can edit the 
schema names if 
required.

Note: The Schema 

Name will have a 

prefix of the 

SETUPINFO/

NAME attribute.

SCHEMA NAME 
must be same for all 
the ATOMIC 
Schemas of the 
applications within 
an Application 
Pack.

Y The permissible length is 15 
characters and only alphanumeric 
characters are allowed. No special 
characters allowed except 
underscore '_'.

SETUPOINFO/NAME 
attribute value would be 
prefixed to the schema name 
being created.

For example, if name is set 
as 'ofsaatm' and setupinfo as 
'uat', then schema being 
created would be 
'uat_ofsaatm'.

NAME should be same 
where APP_GRP=1 for all 
SCHEMA tags (Not 
applicable for this Application 
Pack).

Tag Name/ 
Attribute Name

Description Mandatory 
(Y/ N)

Default Value/ Permissible Value Comments
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<SCHEMA>/
PASSWORD

Enter the password 
of the schema to be 
created.

Note: If this 

attribute is left 

blank, then the 

password specified 

in the 

<PASSWORD>/

DEFAULT attribute 

is applied as the 

Schema Password.

N The maximum length allowed is 30 
characters. Special characters are 
not allowed.

Note: You need to 

mandatorily enter the 

password if you have set the 

<PASSWORD>/

APPLYSAMEFORALL 

attribute as N.

<SCHEMA>/
APP_ID

By default, the 
Application ID is 
seeded based on 
the Application 
Pack.

Note: Do not edit 

this attribute value.

Y Unique Seeded Value Identifies the Application/ 
Product for which the 
schema is being created.

Do not modify this value.

<SCHEMA>/
DEFAULTTABL
ESPACE

Enter the available 
default tablespace 
for DB User.

Note: If this 

attribute is left 

blank, then USERS 

is set as the default 

tablespace.

N Default - USERS

Permissible - Any existing valid 
tablespace name.

Modify this value to associate 
any valid tablespace with the 
schema.

<SCHEMA>/
TEMPTABLESP
ACE

Enter the available 
temporary 
tablespace for DB 
User.

Note: If this attribute 
is left bank, TEMP is 
set as the default 
tablespace.

N Default - TEMP

Permissible - Any existing valid 
temporary tablespace name.

Modify this value to associate 
any valid tablespace with the 
schema.

Tag Name/ 
Attribute Name

Description Mandatory 
(Y/ N)

Default Value/ Permissible Value Comments
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<SCHEMA>/
QUOTA

Enter the quota to 
be set on 
DEFAULTTABLES
PACE attribute for 
the schema/ user. 
By default, the 
quota size is set to 
500M.

Minimum: 500M or 
Unlimited on default 
Tablespace.

N Example:

600M/ m

20G/ g

UNLIMITED/ unlimited

Modify this value to grant the 
specified quota on the 
mentioned tablespace to the 
user.

<SCHEMA>/
INFODOM

Enter the name of 
the Information 
Domain to 
associate this 
schema.

The schema creator 
utility automatically 
derives an 
Information Domain 
Name based on the 
Application Pack if 
no value is specified 
for this attribute.

N Permissible length is 16 characters 
and only alphanumeric characters 
are allowed. No special characters 
are allowed.

<ADV_SEC_O
PTIONS>/

Parent tag to hold 
Advance Security 
Options. 

N Uncomment the tag and edit 
if you want to add security 
options. For example, TDE 
and Data Redact.

For details, see the example 
following the table.

<ADV_SEC_O
PTIONS>/TDE

Tag to enable/
disable TDE.

N Default is FALSE. To enable TDE, 
set this to TRUE.

Ensure this tag is not 
commented if you have 
uncommented 
<ADV_SEC_OPTIONS>

<ADV_SEC_O
PTIONS>/ 
DATA_REDACT

Tag to enable/
disable Data 
Redaction feature.

N Default is FALSE. To enable 
DATA_REDACT, set this to TRUE

Ensure this tag is not 
commented if you have 
uncommented 
<ADV_SEC_OPTIONS>

Tag Name/ 
Attribute Name

Description Mandatory 
(Y/ N)

Default Value/ Permissible Value Comments
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<TABLESPACE
S>

Parent tag to hold 
<TABLESPACE> 
elements

N NA Uncomment the tag and edit. 
ONLY if tablespaces are to 
be created as part of the 
installation.

For details, see the example 
following the table.

Note: When TDE is TRUE in 
ADV_SEC_OPTIONS, then 
it is mandatory for the 
<TABLESPACES> tag to be 
present in the xml file.

<TABLESPACE
>/ NAME

Logical Name of 
tablespace to be 
created.

Y Name if specified should be 
referred in the <SCHEMA 
DEFAULTTABLESPACE= 
"##NAME##"> attribute.

Note the ## syntax.

<TABLESPACE
>/ VALUE

Physical Name of 
the tablespace to be 
created.

Y NA Value if specified will be the 
actual name of the 
TABLESPACE.

<TABLESPACE
>/ DATAFILE

Specifies the 
location of the data 
file on the server

Y NA Enter the absolute path of the 
file to be created.

<TABLESPACE
>/ 
AUTOEXTEND

Specifies if the 
tablespace should 
be extensible or 
have a hard limit

Y ON or OFF Set to ON to ensure that the 
tablespace does not run out 
of space when full.

<TABLESPACE
>/ ENCRYPT

Specifies if the 
tablespace(s) 
should be 
encrypted using 
TDE.

Y ON or OFF Set to ON to ensure that the 
tablespaces when created 
are encrypted using TDE.

Tag Name/ 
Attribute Name

Description Mandatory 
(Y/ N)

Default Value/ Permissible Value Comments
Oracle Insurance Performance Insight Application Pack Installation and Configuration Guide - 8.0.7.0.0 227



Configuring Application Pack XML Files
Note: Encryption of tablespaces requires to enabling Transparent Data Encryption (TDE) on the Database 
Server. 

Example: (The following snippet shows that TDE is enabled and hence the tablespace has been shown with 
encryption ON.)

<ADV_SEC_OPTIONS>

<OPTION NAME="TDE" VALUE="FALSE"/>

<OPTION NAME="DATA_REDACT" VALUE="FALSE" />

</ADV_SEC_OPTIONS>

<TABLESPACES>

<TABLESPACE NAME="OFS_AAI_TBSP_1" VALUE="TS_USERS1" DATAFILE="/scratch/ora12c/app/

oracle/oradata/OFSPQA12CDB/ts_users1.dbf" SIZE="500M" AUTOEXTEND="ON" ENCRYPT="ON" /

>

<TABLESPACE NAME="OFS_AAI_TBSP_2" VALUE="TS_USERS2" DATAFILE="/scratch/ora12c/app/

oracle/oradata/OFSPQA12CDB/ts_users2.dbf" SIZE="500M" AUTOEXTEND="ON" ENCRYPT="ON" /

>

</TABLESPACES>

<SCHEMAS>

<SCHEMA TYPE="CONFIG" NAME="ofsaaconf" PASSWORD="" APP_ID="OFS_AAI" 

DEFAULTTABLESPACE="##OFS_AAI_TBSP_1##" TEMPTABLESPACE="TEMP" QUOTA="unlimited"/>

<SCHEMA TYPE="ATOMIC" NAME="ofsaaatm" PASSWORD="" APP_ID="OFS_AAAI" 

DEFAULTTABLESPACE="##OFS_AAI_TBSP_2##" TEMPTABLESPACE="TEMP" QUOTA="unlimited" 

INFODOM="OFSAAAIINFO"/>

</SCHEMAS>
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APPENDIX A - CONFIGURING OFSAAI_INSTALLCONFIG.XML 
FILE

To configure the OFS_InstallConfig.xml file:

1. Navigate to OFS_IP_PACK/OFS_AAI/conf/ folder.

2. Open the file OFSAAI_InstallConfig.xml in text editor.

3. Configure the OFSAAI_InstallConfig.xml as mentioned in the below table:

You need to manually set the InteractionVariable parameter values as mentioned in the table. If a value is 
not applicable, enter NA and ensure that the value is not entered as NULL.

InteractionVariable 
Name

Significance and Expected Value Mandatory

<Layer name="GENERAL">

InteractionGroup name=”WebServerType”

WEBAPPSERVERTYPE Identifies the web application server on which the OFSAA 
Infrastructure web components would be deployed.

The below numeric value should be set depending on the type:

Apache Tomcat = 1

IBM WebSphere Application Server = 2

Oracle WebLogic Server = 3

For example, <InteractionVariable 
name="WEBAPPSERVERTYPE">3</InteractionVari able>

Yes

InteractionGroup name=”OFSAA Infrastructure Server Detaills”

DBSERVER_IP Identifies the host name or IP address of the system on which the 
Database Engine is hosted.

Note: For RAC Database, the value should be NA.

For example, <InteractionVariable name="DBSERVER_ 
IP">14.15.16.17</InteractionVariable> or

<InteractionVariable name="DBSERVER_ 
IP">dbhost.server.com</InteractionVariable>

Yes

InteractionGroup name=”Database Details”

ORACLE_SID/
SERVICE_NAME

Identifies the Oracle DB Instance SID or SERVICE_NAME

Note: The Oracle_SID value should be exactly the same as it is 
mentioned in JDBC_URL.

For example, <InteractionVariable name="ORACLE_SID/
SERVICE_

NAME">ofsaser</InteractionVariable>

Yes
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ABS_DRIVER_PATH Identifies the directory where the JDBC driver (ojdbc<version>.jar) 
exists. This would typically be the $ORACLE_HOME/jdbc/lib

For example, <InteractionVariable name="ABS_DRIVER_ 
PATH">">/oradata6/revwb7/oracle </InteractionVariable>

Note: See JDBC Jar Files for identifying the correct 
"ojdbc<version>.jar" version to be copied.

Yes

InteractionGroup name=”OLAP Detail'

OLAP_SERVER_ 
IMPLEMENTATION

Identifies if the OFSAA Infrastructure OLAP component needs to 
be configured depending on whether you intend to use the OLAP 
feature. The below numeric value should be set depending on the 
choice:

YES - 1

NO - 0

No

Note: If value for OLAP_SERVER_IMPLEMENTATION is set to 1, it checks for following environment variables are set in 
.profile: ARBORPATH, HYPERION_HOME and ESSBASEPATH.

InteractionGroup name=”SFTP Details”

SFTP_ENABLE Identifies if the SFTP (Secure File Transfer Protocol) feature is to 
be enabled. The below numeric value should be set depending on 
the choice:

SFTP - 1

FTP - 0

Yes

Note: The default value for SFTP_ENABLE is 1, which signifies that SFTP will be used. Oracle recommends using SFTP 
instead of FTP because SFTP is considered more secure. However, a client may choose to ignore this recommendation 
and to use FTP by setting SFTP_ENABLE to 0. You can change this selection later by using the OFSAAI administration 
interface.

Set SFTP_ENABLE to -1 to configure ftpshare and weblocal path as local path mounted for OFSAAI server.

FILE_TRANSFER_POR
T

Identifies the port used for the file transfer service. The default 
value specified is 22 (SFTP). Specify value as 21 or any other 
PORT value if value for SFTP_ENABLE is 0.

For example, <InteractionVariable name="FILE_TRANSFER_ 
PORT">21</InteractionVariable>.

Yes

InteractionGroup name=”Locale Detail

LOCALE Identifies the locale information to be used during the installation. 
This release of the OFSAA Infrastructure supports only US English.

For example, <InteractionVariable name="LOCALE">en_US</
InteractionVariable>

Yes

InteractionVariable 
Name

Significance and Expected Value Mandatory
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InteractionGroup name=”OFSAA Infrastructure Communicating ports"

Note: The below ports are used internally by the various OFSAA Infrastructure services. The default values mentioned 

below are set in the installation. If you intend to specify a different value, update the parameter value accordingly and 

ensure this port value is in the range of 1025 to 65535 and the respective port is enabled.

JAVAPORT 9999 Yes

NATIVEPORT 6666 Yes

AGENTPORT 6510 Yes

ICCPORT 6507 Yes

ICCNATIVEPORT 6509 Yes

OLAPPORT 10101 Yes

MSGPORT 6501 Yes

ROUTERPORT 6500 Yes

AMPORT 6505 Yes

InteractionGroup name="Web Details"

Note: If value for HTTPS_ENABLE is set to 1, ensure you have a valid certificate available from a trusted CA and the same 

is configured on your web application server. For more details on configuring your setup for HTTPS.

HTTPS_ENABLE Identifies if the UI should be accessed using HTTP or HTTPS 
scheme. The default value set is 0. The below numeric value 
should be set depending on the choice:

YES - 1

NO - 0

For example, <InteractionVariable name="HTTPS_ENABLE">0</
InteractionVariable>

Yes

WEB_SERVER_IP Identifies the HTTP Server IP/ Host name or Web Application 
Server IP/ Host name, to be used for accessing the UI. This IP 
would typically be the HTTP Server IP.

If no separate HTTP Server is available, the value should be Web 
Application Server IP/Host name.

For example, <InteractionVariable name="WEB_SERVER_ 
IP">10.11.12.13</InteractionVariable>

or

<InteractionVariable name="WEB_SERVER_ 
IP">myweb.server.com</InteractionVariable>

No

InteractionVariable 
Name

Significance and Expected Value Mandatory
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WEB_SERVER_PORT Identifies the Web Server Port. This would typically be 80 for non 
SSL and 443 for SSL. If no separate HTTP Server exists, the value 
should be the port configured for Web Server.

Note: The port value will not be accepted as 80 if HTTPS_ENABLE 
is 1 and as 443, if HTTPS_ENABLE is 0.

For example, <InteractionVariable name="WEB_ 
SERVER_PORT">80</InteractionVariable>

No

CONTEXT_NAME Identifies the web application context name which will be used to 
build the URL to access the OFSAA applications. The context 
name can be identified from a URL as below:

<scheme>://<host>:<port>/<context-name>/lo gin.jsp

Sample URL:

https://myweb:443/ofsaadev/login.jsp

For example, <InteractionVariable name="CONTEXT_ 
NAME">ofsaadev</InteractionVariable>

Yes

WEBAPP_CONTEXT_P
ATH

Identifies the absolute path of the exploded .ear file on the web 
application server.

For Tomcat, specify the Tomcat directory path till

/webapps, such as

/oradata6/revwb7/tomcat/webapps/.

For WebSphere, enter the WebSphere path as

<WebSphere profile directory>/installedApps/

<NodeCellName>. For example,

/data2/test//WebSphere/AppServer/profiles/

<Profile_

Name>/installedApps/aix-imfNode01Cell. Where aix-imf is Host 
name.

For WebLogic, provide the WebLogic home directory path as /
<WebLogic home directory path>/bea/wlserver_10.3

Note: For WebLogic, value specified for this attribute is ignored and 
value provided against attribute WEBLOGIC_DOMAIN_HOME is 
considered.

Yes

WEB_LOCAL_PATH Identifies the absolute path to any directory on the web application 
server that can hold temporary files being uploaded as part of the 
applications usage. User can set this in FTPSHARE location to 
avoid the confusion.

Note: In case of a clustered deployment, ensure this path and 
directory is same on all the nodes.

Yes

InteractionVariable 
Name

Significance and Expected Value Mandatory
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InteractionGroup name="Weblogic Setup Details"

WEBLOGIC_DOMAIN_H
OME

Identifies the WebLogic Domain Home. Specify the value only if 
WEBSERVERTYPE is set as 3 (WebLogic).

For example, <InteractionVariable name="WEBLOGIC_DOMAIN_

HOME">/home/weblogic/bea/user_ projects/domains/mydomain

</InteractionVariable>

Yes. Specify the value 
only if 
WEBSERVERTYPE is 
set as 3 (WebLogic)

InteractionGroup name="OFSAAI FTP Details"

OFSAAI_FTPSHARE_P
ATH

Identifies the absolute path to the directory identified as file system 
stage area.

Note: The directory should exist on the same system on which the 
OFSAA Infrastructure is being installed (can be on a separate 
mount).

The user mentioned in APP_SFTP_USER_ID parameter below 
should have RWX permission on the directory.

For example, <InteractionVariable 
name="APP_FTPSHARE_PATH">">/oradata6/revwb7/ftpshare</
InteractionVariable>

Yes

OFSAAI_SFTP_USER_I
D

Identifies the user who has RWX permissions on the directory 
identified under parameter APP_FTPSHARE_PATH above.

Yes

OFSAAI_SFTP_PRIVAT
E_KEY

Identifies the SFTP private key for OFSAAI.

For example,

<InteractionVariable name="OFSAAI_SFTP_PRIVATE_KEY">/
home/ofsaapp/.ssh/id_rsa</InteractionVariable>

By default, the value is NA, which indicates password will be 
prompted for the user <OFSAAI_SFTP_USER_ ID> for 
authentication.

For more information on generating SFTP Private key, see the 
Setting Up SFTP Private Key section.

No

OFSAAI_SFTP_PASSP
HRASE

Identifies the passphrase for the SFTP private key for OFSAAI.

For example,

InteractionVariable name="OFSAAI_SFTP_PASSPHRASE">enter 
a pass phrase here</InteractionVariable>

By default, the value is NA.

If OFSAAI_SFTP_PRIVATE_KEY value is given and this is kept as 
NA, then it is assumed as empty passphrase.

No

InteractionVariable 
Name

Significance and Expected Value Mandatory
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InteractionGroup name="Hive Details"

The default value set for the interaction variables under this group is set as NA. These are required only for Hive 
Configuration.

HIVE_SERVER_PORT Identifies the port used for the file transfer service. The default 
value set is 22 (SFTP). Set this value as 21 for FTP.

For example,

InteractionVariable name="HIVE_SERVER_PORT">22</
InteractionVariable>

Yes, only for HIVE 
Configuration

HIVE_SERVER_FTPDRI
VE

Identifies the absolute path to the directory identified as file system 
stage area of HIVE server.

For example,

InteractionVariable name="HIVE_SERVER_FTPDRIVE">/scratch/
ofsaa/ftpshare</InteractionVariable>

Yes, only for HIVE 
Configuration

HIVE_SERVER_FTP_U
SERID

Identifies the user who has RWX permissions on the directory 
identified under the preceding parameter 
HIVE_SERVER_FTPDRIVE.

For example,

InteractionVariable 
name="HIVE_SERVER_FTP_USERID">ofsaa</
InteractionVariable>

Yes, only for HIVE 
Configuration

HIVE_SERVER_FTP_P
ROTOCOL

If the HIVE_SERVER_PORT is 21, then set value as FTP, else set 
it as SFTP.

For example,

InteractionVariable 
name="HIVE_SERVER_FTP_PROTOCOL">SFTP</
InteractionVariable>

Yes, only for HIVE 
Configuration

InteractionVariable 
Name

Significance and Expected Value Mandatory
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APPENDIX A - CONFIGURING RESOURCE REFERENCE IN WEB 
APPLICATION SERVERS

This appendix includes the following topics:

• Configure Resource Reference in WebSphere Application Server

• Configure Resource Reference in WebLogic Application Server

• Configure Resource Reference in Tomcat Application Server

Configure Resource Reference in WebSphere Application Server

This section is applicable only when the Web Application Server is WebSphere.

This section includes the following topics:

• Create JDBC Provider

• Create Data Source

• J2C Authentication Details

• JDBC Connection Pooling

Create JDBC Provider

1. Open the WebSphere admin console in the browser window: 

http://<ipaddress>:<administrative console port>/ibm/console. (https if SSL is enabled). The 
Login window is displayed. 

2. Login with the user ID that has admin rights.
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3. Expand the Resources option in the LHS menu and click JDBC > JDBC Providers to display the JDBC 
Providers window.

4. Select the Scope from the drop-down list. Scope specifies the level at which the resource definition is 
visible.

5. Click New to add new JDBC Provider under the Preferences section. The Create new JDBC provider 
window is displayed.
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6. Enter the following details:

 Database Type - Oracle

 Provider Type- Oracle JDBC Driver

 Implementation Type- Connection pool data source

 Name- The required display name for the resource

 Description - The optional description for the resource

7. Click Next.

8. Specify the directory location for "ojdbc<version>.jar" file. Ensure that you do not use the trailing slash file 
separators.

The Oracle JDBC driver can be downloaded from the following Oracle Download site:

 Oracle Database 11g Release 2 (11.2.0.4) JDBC Drivers

 Oracle Database 12c Release 1 (12.1.0.1) JDBC Drivers

Once downloaded, you need to copy the file in the required folder on the server.

Note: See JDBC Jar Files for identifying the correct ojdbc<version>.jar version to be copied.

After downloading, you need to place the file in the required folder in your system. While creating the JDBC 
Provider, ensure that the path to the jar file in the folder is specified in the Classpath field in the previous 
window.
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9. Click Next to display the Summary window.

10. Verify the details and click Finish to create the JDBC Provider.

11. The options to Save and Review are displayed. Click Save.

Create Data Source

The steps given below are applicable for both CONFIG and ATOMIC data source creation.

1. Open the WebSphere admin console in the browser window: 

http://<ipaddress>:<administrative console port>/ibm/console. (https if SSL is enabled). The 
Login window is displayed.

2. Login with the user id that has admin rights.

3. Expand the Resources option in the LHS menu and click JDBC > Data sources option to display the Data 
sources page.

4. Select the Scope from the drop down list. Scope specifies the level at which the resource definition is visible.
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5. Click New to display the Create a Data Source window.

6. Specify the Data Source name and JNDI name for the new "Data Source".

The JNDI and Data Source name are case sensitive. Ensure that JNDI name is same as the "Information 
Domain" name. 

7. Click Next to display the Select JDBC provider window.

8. Select the option Select an Existing JDBC Provider and select the required JDBC provider from the drop-
down list. Click Next.

9. Specify the database connection URL.

For Example: jdbc:oracle:thin:@<DB_SEREVER_IP>:<DB_SERVER_PORT>:<SID>
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10. Select Data Store Helper Class Name from the drop-down list and ensure that the checkbox Use this data 
source in container managed persistence (CMP) is selected. 

Note: For RAC configuration, provide the RAC URL specified during installation.

For Example: 
jdbc:oracle:thin:@(DESCRIPTION=(ADDRESS_LIST=(ADDRESS=(PROTOCOL=TCP)(HOST=10.11.12.13)

(port=1521))(ADDRESS=(PROTOCOL=TCP)(HOST=10.11.12.14)(PORT=1521))(LOAD_BALANCE=no)(FAI

LOVER=yes))(CONNECT_DATA=(SERVICE_NAME=pqadb)))

11. Click Next.

12. Map the J2C authentication alias, if already created. If not, you can create a new J2C authentication alias 
by accessing the link given (Global J2C authentication alias) or you can continue with the data source 
creation by clicking Next and then Finish.

You can also create and map J2C authentication alias after creating the data source.
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13. You must create another Data source by following the above procedure with jdbc/FICMASTER as JNDI 
name pointing to the "configuration schema" of Infrastructure.

J2C Authentication Details

The steps given below are applicable for creating both config and atomic J2C Authentication.

To create J2C Authentication details:

1. Select the newly created Data Source and click JAAS - J2C authentication data link under Related Items. 

2. Click New under the Preferences section.

3. Enter the Alias, User ID, Password, and Description. Ensure the following:

 User ID is the Oracle user ID created for the respective CONFIG and ATOMIC Schema for the 
"Information Domain".

 Specify the CONFIG database user ID and password information for the jdbc/FICMASTER data source, 
and specify the ATOMIC database user ID and password information for the ATOMIC schema data 
source that you created earlier.

4. Click Apply and save the details.
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JDBC Connection Pooling

To define the JDBC connection pooling ensure that you have created JDBC Provider and Data source to access 
the data from the database.

1. Expand the Resources option in the LHS menu and click JDBC > Data sources option to display the Data 
sources page.

2. Click the newly created Data Source $DATA_SOURCE$ and navigate to the path Data sources > 
$DATA_SOURCE$ > Connection pools.

3. Set the values for the following:

 Connection timeout to 0 seconds

 Maximum connections to 100 connections

 Minimum connections to 10 connections

You can also define Reap Time, Unused Timeout, and Aged Timeout as required.
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Configure Resource Reference in WebLogic Application Server

This section is applicable only when the Web Application Server is WebLogic.

This section includes the following topics:

• Create Data Source

• Create GridLink Data Source

• Configure Multi Data Sources

• Advanced Settings for Data Source

• JDBC Connection Pooling

In WebLogic, you can create "Data Source" in the following ways:

For a Non RAC Database instance, Generic Data Source has to be created. For more information, see Create 
Data Source.

For a RAC Database instance, Gridlink Data Source has to be created. For more information, see Create 
GridLink Data Source.

When Load Balancing/Fail over is required, Multi Data Source has to be created. For more information, see 
Configure Multi Data Sources.

Create Data Source

The steps given below are applicable for both config and atomic data source creation.

1. Open the WebLogic admin console in the browser window: 

http://<ipaddress>:<administrative console port>/console. (https if SSL is enabled). The Login 
window is displayed.

2. Login with the Administrator Username and Password. 
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3. From the LHS menu (Domain Structure), click Services > Data Sources to display the Summary of JDBC 
Data Sources window.

4. Click New and select Generic Data Source option to display the Create a New JDBC Data Source 
window.

You can also select GridLink Data Source or Multi Data Source while creating a Data Source. For more 
information, see Create GridLink Data Source or Configure Multi Data Sources.

5. Enter JDBC data source Name, JNDI Name, and select the Database Type from the drop-down list. Click 
Next.

Ensure the following:

 The JNDI Name field should be in the format "jdbc/informationdomain"

 Same steps needs to be followed to create a mandatory data source pointing to the "configuration 
schema" of infrastructure with jdbc/FICMASTER as JNDI name. 

 JNDI Name is the same as mentioned in web.xml file of OFSAAI Application.

 Required "Database Type" and "Database Driver" should be selected.
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6. Select the Database Driver from the drop-down list. You need to select the Database Driver depending on 
database setup, that is, with or without RAC. Click Next.

7. Select the Supports Global Transactions check box and the One-Phase Commit option.

8. Click Next to display the Connection Properties window.

9. Enter the required details such as the Database Name, Host Name, Port, Oracle User Name, and 
Password. 
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10. Click Next to display the Test Database Connection window.

11. Verify the details and click Test Configuration and test the configuration settings.

A confirmation message is displayed stating "Connection test succeeded."

12. Click Finish. The created "Data Source" is displayed in the list of Data Sources.

Note: “User ID" is the Oracle user ID that is created for the respective "Information Domain".

"User ID" to be specified for data source with "FICMASTER" as "JNDI" name should be the Oracle user ID 
created for the CONFIG schema.
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13. Select the new Data Source and click the Targets tab.

14. Select the AdminServer option and click Finish.

Create GridLink Data Source

If you have selected the option, New > GridLink Data Source while creating the "Data Source", you can directly 
specify the JDBC URL as indicated.

1. Enter Data Source Name, and JNDI Name.
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Ensure that the "JNDI Name" field is specified in the format "jdbc/infodomname" and the XA Driver 
checkbox is not selected. Click Next.

2. Specify Complete JDBC URL, Database User Name, and Password. Click Finish. The created "Data 
Source" is displayed in the list of Data Sources.

Configure Multi Data Sources

A JDBC multi data source is an abstraction around a group of data sources that provides load balancing and 
failover between data sources. As with data sources, multi data sources are also bound to the JNDI tree. 
Applications can look up a multi data source on the JNDI tree and then reserve a database connection from a 
data source. The multi data source determines from which data source to provide the connection.

When the database used is Oracle RAC (Real Application Clusters) which allows Oracle Database to run across 
a set of clustered servers, then group of data sources can be created for instances running on a set of clustered 
servers and a JDBC multi data source can be created so that applications can look up a multi data source on 
the JNDI tree to reserve database connection. If a clustered server fails, Oracle continues running on the 
remaining servers.

1. Open the WebLogic admin console in the browser window: 

http://<ipaddress>:<administrative console port>/console. (https if SSL is enabled). The Login 
window is displayed.

2. Login with the "User ID" that has admin rights.
Oracle Insurance Performance Insight Application Pack Installation and Configuration Guide - 8.0.7.0.0 248



Configuring Resource Reference in Web Application Servers
3. In the LHS menu (Domain Structure), select Services > JDBC > Multi Data Sources to display the 
Summary of JDBC Multi Data Sources window.

4. Click New to display the New JDBC Multi Data Source screen.

Note: Ensure that the Data Sources which needs to be added to new JDBC Multi Data Source has been 
created.

5. Enter the JDBC Source Name, JNDI name, and select the Algorithm Type from the drop-down list. Click 
Next.

Note: The JNDI Name has to be specified in the format jdbc/infodomname.

JNDI Name of the Data Sources that will be added to new JDBC Multi data source should be different from 
the JNDI name specified during Multi Data Source.

Same steps needs to be followed to create a mandatory data source pointing to the "configuration schema" 
of infrastructure with jdbc/FICMASTER as JNDI name for Data Source.

Same steps needs to be followed to create a mandatory data source pointing to the "configuration schema" 
of infrastructure with jdbc/FICMASTER as JNDI name for Data Source.
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JNDI Name provided in multi data source should be the same name that will be mentioned in the web.xml 
file of OFSAAI Application.

You can select the Algorithm Type as Load-Balancing.

6. Select the AdminServer check box and click Next.

7. Select the type of data source which will be added to new JDBC Multi Data Source. Click Next.

8. Map the required Data Source from the Available Data Sources. Click Finish.

The New JDBC Multi Data Source is created with added data sources.
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Advanced Settings for Data Source

1. Click the new Data Source from the Summary of JDBC Data Sources window. The Settings for <Data 
Source Name> window is displayed.

2. Select the Connection Pooling tab given under Configuration.

3. Go to the Advanced option at the bottom of the page, and check the Test Connection of Reserve 
checkbox (Enables Weblogic Server to test a connection before giving it to a client).

4. To verify if the data source is valid, select "Data Source name". For example, FICMASTER.

5. Select the server and click Test Data Source.

A message is displayed indicating that the test was successful.

6. Once the "Data Source" is created successfully, the following messages are displayed:

 All changes have been activated. No restart is necessary.

 Settings updated successfully. 

If not, follow the steps given above to recreate the data source. 

JDBC Connection Pooling

To define the JDBC connection pooling, ensure that you have created JDBC Provider and Data source to access 
the data from the database.

1. Click the newly created Data Source $DATA_SOURCE$ and navigate to the path Home >Summary of 
Services: JDBC >Summary of JDBC Data Sources >JDBC Data Source-<INFODDOM_NAME>

2. Set the values for Initial Capacity to 10, Maximum Capacity to 100, Capacity Increment by 1, Statement 
Cache Type to LRU, and Statement Cache Size to 10.

3. Click Save.
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Configure Resource Reference in Tomcat Application Server

This section is applicable only when the Web Application Server is Tomcat.

This section includes the following topics:

• Create Data Source

• JDBC Connection Pooling

• Class loader Configuration for Apache Tomcat

Copy the Oracle JDBC driver file, ojdbc<version>.jar from <Oracle Home>/jdbc/lib and place it in <Tomcat 
Home>/lib.

Note: See JDBC Jar Files for identifying the correct ojdbc<version>.jar version to be copied.

Create Data Source

To create "data source" for OFSAA application, navigate to <Tomcat Home>/conf and edit the following block of 
text by replacing the actual values in server.xml.

Note: The User-IDs for configuration/ atomic schemas have the prefix of setupinfo depending on the value set 
for PREFIX_SCHEMA_NAME in <<APP Pack>>_SCHEMA_IN.XML file of Schema Creator Utility.

For example: If the value set for PREFIX_SCHEMA_NAME is DEV and the schema name was mentioned as 
ofsaaconf, then the actual schema created in the database would be DEV_ofsaaconf.

<Context path ="/<context name>" docBase="<Tomcat Installation Directory>/webapps/<context 

name>" debug="0" reloadable="true" crossContext="true">

<Resource auth="Container" 

name="jdbc/FICMASTER"

type="javax.sql.DataSource"

driverClassName="oracle.jdbc.driver.OracleDriver"

username="<user id for the configuration schema>" 

password="<password for the above user id>" 

url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>"

maxActive="100" 

maxIdle="30"

maxWait="10000"/>

<Resource auth="Container"

name="jdbc/< INFORMATION DOMAIN NAME >"

type="javax.sql.DataSource"
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driverClassName="oracle.jdbc.driver.OracleDriver"

username="<user id for the atomic schema>"

password="<password for the above user id>"

url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>"

maxActive="100"

maxIdle="30"

maxWait="10000"/>

</Context>

The <Resource> tag must be repeated for each Information Domain created. After the above configuration, the 
"WAR" file has to be created and deployed in Tomcat.

JDBC Connection Pooling

To define the JDBC connection pooling, do the following:

1. Copy $ORACLE_HOME/jdbc/lib/ojdbc<version>.jar to the path $TOMCAT_DIRECTORY/lib/.

Note: Refer to JDBC Jar Files for identifying the correct "ojdbc<version>.jar" version to be copied.

2. Edit the server.xml present under the path $TOMCAT_DIRECTORY/conf/ with the below changes, which are 
required for connection pooling.

<Context path="/ $CONTEXTNAME$" docBase=" $APP_DEPLOYED_PATH$ " debug="0" 

reloadable="true" crossContext="true">

<Resource auth="Container"

name="jdbc/ $INFODOM_NAME$"

type="javax.sql.DataSource"

driverClassName="oracle.jdbc.driver.OracleDriver"

username=" $ATOMICSCHEMA_USERNAME$"

password="$ATOMICSCHEMA_PASSWORD$"

url="$JDBC_CONNECTION_URL"

maxActive="100"

maxIdle="30"

maxWait="10000"

removeAbandoned="true" removeAbandonedTimeout="60"

logAbandoned="true"/>

</Context>
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Note the following:

• $APP_DEPLOYED_PATH$ should be replaced by OFSAAI application deployed path.

• $INFODOM_NAME$ should be replaced by Infodom Name.

• $ATOMICSCHEMA_USERNAME$ should be replaced by Atomic schema database user name.

• $ATOMICSCHEMA_PASSWORD$ should be replaced by Atomic schema database password.

• $JDBC_CONNECTION_URL should be replaced by JDBC connection string 
jdbc:Oracle:thin:<IP>:<PORT>:<SID>. For example, jdbc:oracle:thin 10.80.50.53:1521:soluint

• The User-IDs for configuration/ atomic schemas have the prefix of setupinfo depending on the value set for 
PREFIX_SCHEMA_NAME in <<APP Pack>>_SCHEMA_IN.XML file of Schema Creator Utility.

For example: if the value set for PREFIX_SCHEMA_NAME is DEV and the schema name was mentioned as 
ofsaaconf, then the actual schema created in the database would be DEV_ofsaaconf.

Class loader Configuration for Apache Tomcat

Edit the server.xml available in $TOMCAT_HOME/conf/ folder.

Add tag <Loader delegate="true" /> within the <Context> tag, above the <Resource> tag. This is applicable 
only when the web application server is Apache Tomcat 8.

This configuration is required if Apache Tomcat version is 8.
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APPENDIX A - POST DEPLOYMENT CONFIGURATION

This chapter covers the following topics:

• Logging as System Administrator

• Creating Application Users

• Mapping Application User(s) to User Group

• Change ICC Batch Ownership

• Mapping ICC Batch Execution Rights to User

• Saving Post- Load Change Transformations
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Logging as System Administrator

Post installation, the first login into Infrastructure is possible only for a System Administrator through user id 
"sysadmn". This ID is created at the time of installation with the password provided during installation. Enter 
login id "sysadmn" and password that was provided during installation. Click Login.

System Administrator

System Administration refers to a process of managing, configuring, and maintaining confidential data in a multi-
user computing environment. System Administration in Security Management involves creating functions, roles, 
and mapping functions to specific roles. System Administration also involves maintaining segment information, 
holiday list, and restricted passwords to ensure security within the Infrastructure system.

You can access System Administrator in LHS menu of Security Management. The options available under 
System Administrator are:

• Function Maintenance

• Role Maintenance

• Segment Maintenance

• Holiday Maintenance

• Restricted Passwords

Function Maintenance

A function in the Infrastructure system defines the privileges to access modules or components and to define or 
modify Metadata information associated. Function Maintenance allows you to create functions for users to 
ensure only those functions are executed which are specific to the user's role.

You can access Function Maintenance by expanding System Administrator section within the tree structure 
of LHS menu. The Function Maintenance window displays the function details such as Function Code, Function 
Name, Description, and the number of Roles Mapped to the function. The Function Maintenance window also 
facilitates you to view, create, modify, and delete functions within the system.

You can also make use of Search and Pagination options to search for a specific function or view the list of 
existing functions within the system.

Role Maintenance

A role in the Infrastructure system is a collection of functions defined for a set of users to execute a specific task. 
You can create roles based on the group of functions to which users are mapped. 

You can access Role Maintenance by expanding System Administrator section within the tree structure of LHS 
menu. The Role Maintenance window displays the role details such as Role Code, Role Name, Role 
Description, and the number of Users Mapped to the role. The Role Maintenance window also facilitates you to 
view, create, modify, and delete roles within the system. 

You can also make use of Search and Pagination options to search for a specific role or view the list of existing 
roles within the system.
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Segment Maintenance

Segment is used to control access rights on a defined list of objects. It is mapped to an information domain. 

Segment Maintenance in the Infrastructure system facilitates you to create segments and assign access rights. 
You can have different segments for different Information Domains or same segments for different Information 
Domains. 

User scope is controlled by segment/ folder types with which the object is associated. 

• Objects contained in a public folder will be displayed irrespective of any user. 

• Objects contained in a shared folder will be displayed if user belongs to a user group which is mapped to 
an access type role with the corresponding folder. 

• Objects contained in a private folder will be displayed only to the associated owner. 

You can access Segment Maintenance by expanding System Administrator section within the tree structure of 
LHS menu. The Segment Maintenance window displays a list of available segments with details such Domain, 
Segment Code, Segment Name, Segment Description, Segment/Folder Type, Owner Code, and the number of 
Users Mapped to the segment. You can view, create, modify, and delete segments within the Segment 
Maintenance window. 

You can also make use of Search and Pagination options to search for a specific role or view the list of existing 
roles within the system.

Holiday Maintenance

Note: As part of OFSAAI 7.3.3.0.0 release, this feature will not be available if Authentication is configured to 
SSO Authentication and SMS Authorization.

Holiday Maintenance facilitates you to create and maintain a schedule of holidays or non-working days within 
the Infrastructure system. On a holiday, you can provide access to the required users and restrict all others from 
accessing the system from the User Maintenance window.

You can access Holiday Maintenance by expanding System Administrator section within the tree structure of 
LHS menu. The Holiday Maintenance window displays a list of holidays in ascending order. In the Holiday 
Maintenance window you can create and delete holidays.

Restricted Passwords

Note: As part of OFSAAI 7.3.3.0.0 release, this feature will not be available if Authentication Type is selected 
as SSO Authentication and SMS Authorization from System Configuration> Configuration.

Restricted Passwords facilitates you to add and store a list of passwords using which users are not permitted to 
access the Infrastructure system. 

You can access Restricted Passwords by expanding System Administrator section within the tree structure of 
LHS menu. The Restricted Passwords window displays a list of restricted passwords and allows you to add and 
delete passwords from the list. 
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You can also make use of Search and Pagination options to search for a specific password or view the list of 
existing passwords within the system. For more information, refer Pagination and Search & Filter.

Note: While searching for any pre-defined restricted password, you have to key in the entire password.

Creating Application Users

Create the application users in the OFSAA setup prior to use. 

Note: This step may not be required if you have already setup users in the OFSAA setup.

For more information refer user creation section from the Oracle Financial Services Analytical Applications 
Infrastructure User Guide.

Mapping Application User(s) to User Group

Starting the OFSAA 8.0 release, with installation of OIPI Application Pack, pre-configured application user 
groups are seeded. These user groups are unique to every OFSAA Application Pack and have application roles 
pre-configured.

Map the application user(s) to the respective Application User Group(s) and subsequently authorize the 
entitlements by logging in as SYSAUTH (System Authorizer) user.

For more information on seeded User Groups, refer to User Group Mapping.

Change ICC Batch Ownership

All the seeded Batches in OIPI Applications Pack will be automatically assigned to SYSADMN user during 
Installation. If one user who wants to see the Batches in Batch Maintenance Menu, He needs to execute the 
following Queries in Config Schema of the Database. 

Syntax: 

begin 

AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP ('fromUser','toUser','infodom'); 

end; 

OR 

begin 

AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP ('fromuser','touser'); 

end; 

Where from User indicates the user who currently owns the batch, to User indicated the user to which the 
ownership has to be transferred. Infodom is optional parameter, if specified the ownership of batches pertaining 
to that Infodom will be changed. 
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Example: 

begin 

AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP ('SYSADMN','OIPIOP','OFSOIPIINFO'); 

end;

Mapping ICC Batch Execution Rights to User

Login as SYSADMN and navigate to Identity Management > System Administrator > Function-Role Map. 
Map the User-Batch Execution Mapping Screen function to RLOIPIADMIN role.

Now any user who is mapped under OIPI Admin User Group will have the access to the Batch execution rights 
Menu under Operations list.
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Saving Post- Load Change Transformations

After creating users, Login to Infrastructure as any user who is mapped to OIPI Admin or OIPI Analyst group. 
Navigate to Data Management Framework >> Post Load Changes.

A New window will be displayed. Click on Each Transformation from Transformations List & Click on Stored 
Procedure in the Right Panel, Click on Edit in the Top Right Menu and Click on Finish Button in Bottom.

All the Transformation Stored Procedures are required to be edited and saved (Finish Button) once for getting 
it is available.

Instrument Table Validation

Run the Instrument Table Validation. For more information, see the Doc ID 1457511.1 and Data Model Utility 
Guide.

Check the FSI_MESSAGE_LOG file after running Instrument Table Validation to verify that tables are classified 
correctly.
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APPENDIX A - TDE, DATA REDACTION AND THE 
CORRESPONDING SETTINGS IN OFSAA
This section provides information to help enable TDE (Transparent Data Encryption), Data Redaction and its 
corresponding settings in OFSAA. For more details on TDE and Data Redaction, see the Database Advanced 
Security Guide.

The following sections provide details to enable TDE in the database and run the schema utility.

• Prerequisites

• Creating a Wallet

• Running the Schema Utility with Encryption

• Testing the Encryption

Prerequisites

1. Ensure the required Oracle Database Server versions are installed:

 Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.4.0 +) - 64 bit

RAC/Non-RAC with/ without partitioning option, Advanced Security Option

 Oracle Database Server Enterprise Edition 12c Release 1 (12.1.0.1.0 +) - 64 bit RAC/

Non-RAC with/ without partitioning option, Advanced Security Option

2. Ensure the required patches are applied for your respective Oracle DB versions:

 For Oracle DB Serve 11.2.0.4, the patch 22205607 should have been applied.

 For Oracle DB Server 12.1.0.1 and 12.1.0.2, the patches 27010930 and 22205607 should have been 
applied. 

Creating a Wallet

The environment setup for tablespace encryption is the same as that for transparent data encryption. Before 
creating an encrypted tablespace, create a wallet to hold the encryption key. The search order to find the wallet 
is described in the following list:

1. The location specified by the ENCRYPTION_WALLET_LOCATION parameter in the sqlnet.ora file.

2. The location specified by the WALLET_LOCATION parameter in the sqlnet.ora file.

Encrypted tablespaces can share the default database wallet. However, Oracle recommends that you use a 
separate wallet for transparent data encryption functionality by specifying the ENCRYPTION_WALLET_LOCATION 
parameter in the sqlnet.ora file.

1. Add the following entry into the sqlnet.ora file on the server and check if the specified directory is created:

ENCRYPTION_WALLET_LOCATION=
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(SOURCE=(METHOD=FILE)(METHOD_DATA=

(DIRECTORY=/u01/app/oracle/admin/DB11G/WALLET/)))

For RAC-DB or ASM enabled databases, use the following entry:

ENCRYPTION_WALLET_LOCATION=

(SOURCE=

(METHOD=FILE)

(METHOD_DATA=

(DIRECTORY=+DATA/PRODCDB/WALLET)

)

)

2. For ASM Diskgroup, create a relevant directory as defined by ENCRYPTION_WALLET_LOCATION using the 
following instruction:

[oracle@server ~]$ echo $ORACLE_SID

+ASM

[oracle@server ~]$ asmcmd

ASMCMD>

ASMCMD> cd +DATA/PRODCDB

ASMCMD> mkdir WALLET

ASMCMD> cd WALLET/

ASMCMD> pwd

+DATA/PRODCDB/WALLET

3. Use the following command to create and open the wallet:

CONN sys/password@serviceid AS SYSDBA

ALTER SYSTEM SET ENCRYPTION KEY IDENTIFIED BY "my Password";

4. Reopen Wallets after the instance restart and then close it to prevent access to encrypted data using the 
following command.

ALTER SYSTEM SET ENCRYPTION WALLET OPEN IDENTIFIED BY "my Password";

Note: In a CDB, open the Keystore in the ROOT (CDB$ROOT) container and in all the associated PDBs, 
where TDE is enabled. 

Alternatively, you can create an Auto-Login or Local-Login Keystore to avoid opening the Keystore manually 
every time. To enable the Keystore to open automatically, use the following command:

ADMINISTER KEY MANAGEMENT CREATE [LOCAL] AUTO_LOGIN KEYSTORE FROM KEYSTORE 
'keystore_location' IDENTIFIED BY keystore_password;
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Running the Schema Utility with Encryption

Run the schema creator utility by including the encrypt=on option in the Tablespace tag in the Schema in the 
XML file. You have to perform this procedure manually as it's not a part of the schema template originally.

<APPPACKSCHEMA>

<APP_PACK_ID>OFS_AAAI_PACK</APP_PACK_ID>

<JDBC_URL>jdbc:oracle:thin:@whf00ajn:1521:OFSPQA12CDB</JDBC_URL>

<JDBC_DRIVER>oracle.jdbc.driver.OracleDriver</JDBC_DRIVER>

<HOST><HOST_NAME></HOST>

<SETUPINFO NAME="t608" PREFIX_SCHEMA_NAME="Y"/>

<PASSWORD APPLYSAMEFORALL="Y" DEFAULT="<password>"/>

<TABLESPACES>

<TABLESPACE NAME="OFS_AAI_TBSP" VALUE="TS_USERS1" DATAFILE="<HOME_DIR>/ora12c/app/
oracle/oradata/OFSPQA12CDB/ts_users1.dbf" SIZE="500M" AUTOEXTEND="OFF" ENCRYPT="ON" 
/>

</TABLESPACES>

<SCHEMAS>

<SCHEMA TYPE="CONFIG" NAME="ofsaaconf" PASSWORD="" APP_ID="OFS_AAI" 
DEFAULTTABLESPACE="TS_USERS1" TEMPTABLESPACE="TEMP" QUOTA="unlimited"/>

<SCHEMA TYPE="ATOMIC" NAME="ofsaaatm" PASSWORD="" APP_ID="OFS_AAAI" 
DEFAULTTABLESPACE="TS_USERS1" TEMPTABLESPACE="TEMP" QUOTA="unlimited" 
INFODOM="OFSAAAIINFO"/>

<SCHEMA TYPE="ATOMIC" NAME="ofsaaatm" PASSWORD="" APP_ID="OFS_IPE" 
DEFAULTTABLESPACE="TS_USERS1" TEMPTABLESPACE="TEMP" QUOTA="unlimited" 
INFODOM="OFSAAAIINFO"/>

</SCHEMAS>

</APPPACKSCHEMA>
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Testing the Encryption

Test the encryption by checking if a tablespace is encrypted or not. Execute the following query to check:

SELECT tablespace_name, encrypted FROM dba_tablespaces;

The following result is displayed, which indicates whether the TABLESPACE is encrypted (ENCRYPTED TS - 
YES) or not (ENCRYPTED TS - NO) in the ENC column:

6 rows selected.

TABLESPACE_NAME ENC

SYSTEM NO

SYSAUX NO

UNDOTBS1 NO

TEMP NO

USERS NO

ENCRYPTED_TS YES
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APPENDIX A - DATA PROTECTION IMPLEMENTATION IN OFSAA

This chapter includes sections about Data Protection implemented in OFSAA applications and covers the 
following sections:

• Right to be Forgotten

• Data Portability

• Pseudonymization

• Notice and Consent

• Data Archival

• Data Redaction

Right to be Forgotten

This section covers the following sub-sections:

• Introduction to Right to be Forgotten

• Implementation of Right to be Forgotten by OFSAA

• Sample Queries using the AAI_DRF_QUERY_METADATA Metadata table

Introduction to Right to be Forgotten

Right to be Forgotten is the task of removing PII (Personally Identifiable Information) of a Data Subject for the 
given Party. The financial institution can delete PII for those Data Subjects who have requested this Right to be 
Forgotten functionality.

The Data Subjects may have made significant financial transactions, and/or financial information may be 
required for regulatory or compliance reporting. Deleting the complete record that consists of PII may lead to 
issues in data reconciliation. In OFSAA, the PII data will be replaced with randomized values and therefore, the 
complete Data Subject record is retained. As a result, financial information is retained; however, the associated 
Party PII is removed permanently. 

Implementation of Right to be Forgotten by OFSAA

To implement Right to be Forgotten:

1. Use the FSI_PARTY_RIGHT_TO_FORGET table to collect the input list of Party IDs for which PII must be 
removed from the system. The financial institution must source this Party ID list into the 
FSI_PARTY_RIGHT_TO_FORGET table, and then invoke the batch (<<INFODOM>>_RightToForget) or 
schedule it. 

Note: For sample query, see Sample Query for the FSI_PARTY_RIGHT_TO_FORGET table.

2. Use the AAI table  AAI_DRF_FUNCTION_COLUMN_MAP to store the PII attribute list. During the Right to 
Forget batch execution, AAI_DRF_FUNCTION_COLUMN_MAP table is referred to randomize the PII 
values. See the Data Redaction section in OFSAAI Administration Guide.
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3. Use the AAI table AAI_DRF_QUERY_METADATA to store the query metadata, which is used during the 
<<INFODOM>>_RightToForget batch execution. This is the query metadata table that can lead to two types 
of queries:

a. When the table consists of Party Identifier as an attribute, a simple record is required in the metadata 
query table.

For example:

Select v_party_id from Dim_Party where v_party_id='10'

b. When the table does not consist of Party Identifier as an attribute, an interrelated set of records are 
required in the metadata query table AAI_DRF_QUERY_METADATA. Compose these set of records in 
a systematic way such that, for the selected Party Identifier, the table join procedure can be performed 
and traversed to reach the required PII attribute.

Table definition for AAI_DRF_QUERY_METADATA

Column Name Column Type Description

ID Number This is the Primary Key field. You must enter a numerical 
value.

V_TABLE_NAME Varchar This is the source table name.

V_COLUMN_NAME Varchar This is the source column name.

V_CHILD_TABLE_NAME Varchar This is the table name, which must be linked to the 
V_TABLE_NAME. If the same table name is repeated with the 
same column name V_COLUMN_NAME, then the AND 
condition is formed with V_CHILD_TABLE_NAME. 
V_CHILD_TABLE_NAME

V_CHILD_COLUMN_NAME Varchar This the column name, which must be linked to the 
V_COLUMN_NAME.

F_QUERY_FLAG Varchar Enter Y or N, which is case sensitive. If the value is Y, then you 
must form a query from V_TABLE_NAME 
.V_COLUMN_NAME

V_COLUMN_DATA_TYPE Varchar Mention the Data Type of the V_COLUMN_NAME. This is 
required only if F_QUERY_FLAG = Y.
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For example:

Dim_Cards_Master table does not consist of n_cust_skey (n_cust_skey is the required Primary Key for the PII 
Attribute n_card_number_skey). Therefore, perform the table join procedure similar to the following query:

Select Dim_Cards_Master.n_card_number_skey from Dim_Cards_Master Dim_Cards_Master, 
Fct_Card_Acct_Mapping Fct_Card_Acct_Mapping, 

Fct_Cards_Summary Fct_Cards_Summary, Dim_Customer Dim_Customer where 
Dim_Cards_Master.n_card_number_skey=Fct_Card_Acct_Mapping.n_card_number_skey and 
Fct_Card_Acct_Mapping.n_acct_skey=Fct_Cards_Summary.n_acct_skey and 
Fct_Cards_Summary.n_cust_skey=Dim_Customer.n_cust_skey and v_d_cust_ref_code='GDPR'

Where Dim_Customer.n_cust_skey is a Number Datatype.

Note: For more sample queries generated using the query metadata table, see Sample Queries using the 
AAI_DRF_QUERY_METADATA Metadata Table.

To arrive at the above-mentioned query, follow these steps:

In first figure, the required table Dim_Cards_Master does not consist of Party Identifier. Therefore, perform 
the table join procedure using the AND condition at the table level.

i. Search for a table, which consists of the Party Identifier field. In this query, we have searched for 
the table Dim_Customer with unique identifier n_cust_skey field. This table must be joined with the 
required table Dim_Cards_Master.

ii. However, the tables Dim_Cards_Master and Dim_Customer do not consist of any common column 
name to perform the table join operation. Therefore, search for one more table 
Fct_Card_Acct_Mapping. This table (Fct_Card_Acct_Mapping) consists of common column name 
(n_card_number_skey) between Dim_Cards_Master table and itself.

iii. Join the Fct_Card_Acct_Mapping table, which consists of common column name (n_acct_skey) 
with another table Fct_Cards_Summary.

V_TARGET_COLUMN_NAME Varchar Mention the PARTY_ID column name, which is required only if 
F_QUERY_FLAG = Y.

V_QUERY_NAME Varchar Mention the same query for a set of joining tables and 
columns. The set of tables and columns under join query are 
grouped together using the same query name.

Column Name Column Type Description
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iv. Join the Fct_Cards_Summary table, which consists of common column name (n_cust_skey) with 
the final table Dim_Customer.

v. Now, the Dim_Cards_Master table is joined with the Dim_Customer table.

c. You must arrive at the skey or equivalent column in the table, which consists of the required PII 
attributes. Then the <<INFODOM>>_RightToForget batch uses this key to filter records (For example: 
Dim_Cards_Master) and randomize all the PIIs listed in the AAI_DRF_FUNCTION_COLUMN_MAP for 
that table.

4. Now, PII attributes can be queried and the values are randomized.

Sample Queries using the AAI_DRF_QUERY_METADATA Metadata table

These are the sample queries generated using the AAI_DRF_QUERY_METADATA table:

Example 1:

select DIM_MANAGEMENT.n_manager_skey from DIM_MANAGEMENT DIM_MANAGEMENT, FCT_CUSTOMER 
FCT_CUSTOMER, DIM_CUSTOMER DIM_CUSTOMER where 
DIM_MANAGEMENT.n_manager_skey=FCT_CUSTOMER.n_manager_skey and 
FCT_CUSTOMER.n_cust_skey=DIM_CUSTOMER.n_cust_skey and DIM_CUSTOMER.v_d_cust_ref_code 
in(?,?)

Example 2:

select  DIM_EMAIL.n_email_skey from DIM_EMAIL DIM_EMAIL, FCT_PARTY_EMAIL_MAP 
FCT_PARTY_EMAIL_MAP, DIM_PARTY DIM_PARTY where 
DIM_EMAIL.n_email_skey=FCT_PARTY_EMAIL_MAP.n_email_skey and 
FCT_PARTY_EMAIL_MAP.n_party_skey=DIM_PARTY.n_party_skey and DIM_PARTY.v_party_id 
in(?,?)

Example 3:

select  STG_CLAIM_DETAILS.v_claim_id from STG_CLAIM_DETAILS STG_CLAIM_DETAILS, 
STG_CLAIM_CLAIMANT STG_CLAIM_CLAIMANT where 
STG_CLAIM_DETAILS.v_claim_id=STG_CLAIM_CLAIMANT.v_claim_id and 
STG_CLAIM_CLAIMANT.v_cust_ref_code in(?,?)

Example 4:

select STG_CONTACT_MASTER.v_contact_id from STG_CONTACT_MASTER STG_CONTACT_MASTER, 
DIM_CONTACT DIM_CONTACT where STG_CONTACT_MASTER.v_contact_id=DIM_CONTACT.v_contact_id 
and DIM_CONTACT.v_customer_id in(?,?)

Example 5: 

select  DIM_CARDS_MASTER.n_card_number_skey from DIM_CARDS_MASTER DIM_CARDS_MASTER, 
FCT_CARD_ACCT_MAPPING FCT_CARD_ACCT_MAPPING, FCT_CARDS_SUMMARY FCT_CARDS_SUMMARY where 
DIM_CARDS_MASTER.n_card_number_skey=FCT_CARD_ACCT_MAPPING.n_card_number_skey and 
FCT_CARD_ACCT_MAPPING. n_acct_skey=FCT_CARDS_SUMMARY.n_acct_skey and 
FCT_CARDS_SUMMARY.v_d_cust_ref_code in(?,?)

Sample Query for the FSI_PARTY_RIGHT_TO_FORGET table

This is the sample entry for the FSI_PARTY_RIGHT_TO_FORGET table:

Insert into FSI_PARTY_RIGHT_TO_FORGET values (SYSDATE, <<PARTY_ID_FROM_Ur_ENV>>, 
'Testing Right2Forget');
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Data Portability

According to the Data Protection guidelines, a scenario may occur with a customer in which a Data Subject 
requests the financial institution to share the PII of that Data Subject stored in the application. To cater to such 
a scenario, the customer may use T2F (Table to File) functionality provided by AAI. This T2F functionality 
enables the customer to query the data warehouse and save the attributes to a file. 

Data Portability Scenario

A sample scenario to apply Data Portability:

1. The DIM_PARTY table consists of a set of PIIs for multiple Data Subjects.

A Data Subject requests the bank to share a copy of the PII data of that Data Subject stored by the bank. 
For illustration, the Data Subject with V_PAN_CARD_ID EMHPL5167K is used.

2. To make a file copy of the PII requested by the Data Subject, the User (bank) must perform T2F data 
mapping. Follow the Data Mapping procedure. See the Defining Data Mapping to File (T2F, H2F) section in 
the Data Mapping part in the OFS AAAI Application Pack Minor Release 8.0.6.0.0 User Guide to:

a. Create a T2F definition for the scenario mentioned in step 1. V_PAN_CARD_ID is the V_PARTY_ID in 
the DIM_PARTY table.
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b. Create a Batch to run the T2F.

c. Create a Task for the Batch.
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d. Execute the Batch. Verify the progress of batch execution in Batch Monitor. 

1. The output file path is:

/scratch/ofsaaapp1/ftpshare/FSDFINFO/dmt/def/<T2F_name>/<Batch_name>/<batch_run_id>/
<information_date>/<T2Fname>.dat

For example:

/scratch/ofsaaapp1/ftpshare/FSDFINFO/dmt/def/T2F_DIM_PARTY/
FSDFINFO_T2F_DIM_PARTY_20180504_1_Task1/20180504/ T2F_DIM_PARTY.dat

Note: This extracted file consists of PII of a Data Subject that must be encrypted. See the Data Mapping 
section in Data Management Tools chapter in the OFS AAAI Application Pack Minor Release 8.0.6.0.0 User 
Guide.

2. T2F output file with the PII details requested by the Data Subject.
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Pseudonymization

Overview of Pseudonymization

Pseudonymization is a process by which PII fields of a record are replaced by one or more artificial identifiers, 
or pseudonyms. There can be a single pseudonym for a collection of replaced fields or one pseudonym for each 
replaced field. Therefore, Pseudonymization is a method to substitute PII data with a reversible and consistent 
value. This decreases the linking ability of a data set with the original identity of a data subject and acts as a 
Data Security mechanism.

The mapping of pseudonyms to those PIIs that are required for lookups, to retrieve the data subject information, 
must be stored away from the data warehouse in a secure location. This involves highly restricted access 
controls and security mechanisms that are defined at the customer environment to suit customer data security 
needs.

Implementation of Pseudonymization

OFSDF data model enables its customers to implement Pseudonymization process such that the PII data is 
separated from transaction data, and this PII data is referenced only by pseudonym. For a wide range of 
analytical processes, the access to PII data is not necessary.

1. Customers can employ Pseudonymization and load the Pseudonymized data into OFSDF.

2. When analytical or modeling condition requires the availability of PII data, then care must be taken by the 
customer to load PII data into those columns that consist of additional data security controls such as 
Redaction. When the requisite attributes are not part of the seeded PII list, then the customer must:

 Extend the PII list

 Verify the completeness of the extensions

 Verify that Redaction is enabled on the extended PII fields prior to loading sensitive data attributes

To know more about Data Redaction, see OFS Analytical Applications Infrastructure Administration Guide.

Note: It is recommended that the PII values must not be added in the account dimension, party dimension, 
and customer dimension columns where redaction is not applied. For example, PII values must not be 
added in the v_account_number, v_party_id, and v_cust_id columns. Instead, they must be loaded in 
the v_original_account_number, v_orig_party_id and v_orig_cust_ref_code columns respectively, 
where redaction is applied.
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Notice and Consent

Introduction to Notice and Consent

According to the Data Protection guidelines, a clear, legal based and accessible Notice must be provided to the 
Party regarding the Personally Identifiable Information (PII), which is collected from the Party during the on-
boarding process or during any stage of the workflow where PII of the Data Subject is captured.

After providing a Notice, a clear Consent must be obtained from the Party regarding the usage and handling of 
PII by the financial institutions. This Consent must be given by the Party, and must be presented to them as their 
choice with the option of withdrawal from providing Consent at any time. After the Party gives their Consent, 
their PII can be used in the workflow.

Populating Consent Purpose Dimension Party Consent and Fact Party 
Consent

OFSAA is a back office product, and does not have direct interaction with the end user of the bank. Therefore, 
Notice, and Consent User Interfaces are not applicable. However, Data Model of Data Foundation is enhanced 
to hold Notice and Consent information as a download from source systems. The bank may further use this 
feature for the task of processing or reporting.

Procedure to Populate Consent Purpose Dimension and Fact Party Consent

This section provides information about Consent Purpose Dimension Population and Party Consent Population 
processes in the Oracle Financial Services Data Foundation application.

Overview of Consent Purpose Dimension Population and Fact Party Consent 
Population

• Overview of Consent Purpose Dimension Population

In the Consent Purpose Dimension table (DIM_CONSENT_PURPOSE), Consent content is stored. This 
table can be populated from Stage Consent Purpose Master Entity 
(STG_CONSENT_PURPOSE_MASTER) using the SCD-468 packaged in FSDF. 

• Overview of Fact Party Consent Population

Fact Party Consent is the table where Consent of the Party is stored. Table to Table seeded definitions are 
provided for loading data into the target table Fact Party Consent (FCT_PARTY_CONSENT):

Source Table Name Target Table Name T2T Definition Name

STG_PARTY_CONSENT FCT_PARTY_CONSENT T2T_FCT_PARTY_CONSENT
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Executing Consent Purpose Dimension Population and Fact Party Consent Population 
T2T 

• Executing through Batch

 From Consent Party Master, Consent Purpose Dimension SCD can be executed by executing task 
present in the SCD batch FSDFINFO_DATA_FOUNDATION_SCD.

 Fact Party Consent T2T can be executed by executing task present in the T2T batch 
FSDF_SOURCED_RUN.

Follow these steps to execute the batch:

i. Navigate to the Batch Execution screen.

ii. Select the seeded batch:

FSDFINFO_DATA_FOUNDATION_SCD for Consent Purpose Dimension

FSDF_SOURCED_RUN for Fact Party Consent

where Infodom is the information domain where application is installed.

iii. Select the AS_OF_DATE for which source customer information is required to be loaded into the 
table.

iv. Click Execute Batch.

Monitor the status of the batch in the screen of OFSAAI.

• Execution of T2T Batch through Run Management

T2T_FCT_PARTY_CONSENT is part of Financial Services Data Foundation Sourced Run. The process 
can be executed through the Seeded Run Financial Services Data Foundation Execution Run.

Note: When executing through Run, the RUNSkey is auto-generated and stamped against each record.

Error Messages

In the log file present in the:

• ftpshare/logs/<Run_Date>/FSDFINFO/RUN EXECUTABLE folder for DIM_CONSENT_PURPOSE

• ftpshare/logs/<Run_Date>/FSDFINFO/LOAD DATA folder for T2T_FCT_PARTY_CONSENT

This is the most common error message:

• Unique Constraint Violation: This occurs when attempting re-load or loading existing records for the 
already executed AS_OF_DATE.
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Checking the Execution Status for Fact Party Consent T2T

The status of execution can be monitored using the Batch Monitor screen.

Note: For a more comprehensive coverage of configuration and execution of a batch, see Oracle Financial 
Services Analytical Applications Infrastructure Release 8.0.6.0.0 User Guide.

The status messages in Batch Monitor are:

• N - Not Started

• O - On Going

• F - Failure

• S - Success

The execution log can be accessed on the application server in the directory ftpshare/logs/<Run_Date>/
FSDFINFO/LOAD DATA. The file name consists of the Batch Execution ID.

This is the error log table in atomic schema:

• FCT_PARTY_CONSENT$ for T2T_FCT_PARTY_CONSENT

Fact Party Consent T2T

T2T definition can be retrieved as an excel document for reference from the metadata browser of the Unified 
Metadata Manager (UMM) component of OFSAAI.

Data Archival

Synopsis for Data Archival

The OFSAA data model, along with the active data stores Personally Identifiable Information (PII) of Data 
Subjects who are no longer actively using the financial services, which is a liability.

Implementation of Data Archival by OFSAA

To implement this invisibility of data at row level, Oracle Database 12c has introduced a new feature called Row

Archival.

• The Row Archival feature is simple and effective to use as opposed to the traditional approach, which 
requires storage and maintenance of historical tables.

• This feature enables to archive records based on a given criteria within the account table. The criteria can 
be, for example, the Account Close Date of the Data Subject.

• This archived data can be viewed or made hidden by setting a session parameter.
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A Criteria for Data Archival

To archive Party records, which are closed for more than seven years:

1. To enable Row Archival on the DIM_PARTY table, run this command:

ALTER TABLE DIM_PARTY ROW ARCHIVAL

2. Run the Row Archival Update statement periodically, to search for the account Party records which are 
closed for more than seven years. Run this command:

UPDATE DIM_PARTY SET ora_archive_state='1' where

trunc(months_between(SYSDATE, d_closed_date)/12)>7

In the above query:

 ora_archive_state is a hidden column which is created after the ROW ARCHIVAL is set on the table.

 SET ora_archive_state='1' archives the records which meets the criteria of seven years of account 
closure.

 Hidden rows are available for Select/Update queries only after ora_archive_state is disabled.

Viewing Archived Rows

• To make hidden rows visible for a session, run this command:

ALTER SESSION SET ROW ARCHIVAL VISIBILITY=ALL;

• To make the rows invisible, run this command:

ALTER SESSION SET ROW ARCHIVAL VISIBILITY=ACTIVE;

Data Redaction

Overview of Data Redaction in OFSAA

Data Redaction is one of the Data Security features that provides protection of data against unauthorized access 
and data theft.

In OFSAA, these tables are seeded as part of Data Redaction:

• AAI_DRF_FUNCTION_MASTER

This table holds the Redaction function definitions. Generic logical functions can be address, email, card 
number, phone number etc.

• AAI_DRF_FUNCTION_COLUMN_MAP
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This table holds the Redaction Function- Column mappings. The PII columns will be redacted according to 
the Function mapping.

• AAI_DRF_TABLE_ACCESS_CD_MAP

This table holds the mapping of tables having columns marked for redaction to the Access codes. These 
access codes are SMS function codes and are expected to be mapped to the role DATASECURITY. The 
policy expression will be created based on this role and evaluated to access non-redacted data.

Note: The list of PIIs, on which Data Redaction is applied, is available at My Oracle Support.

Accessing PII Table and PII Datasheet

• AAI_DRF_FUNCTION_COLUMN_MAP is the PII table.

• PII Datasheet list can be accessed from My Oracle Support.

Data Redaction Batch

Execute the Data Redaction seeded Batch ##INFODOM##_DATA_REDACTION to execute the Data Redaction 
Utility if it is available as part of application common metadata. If the Batch is not available, you must create a 
new Batch as mentioned in the Creating Batch for Executing Data Redaction Utility section in the OFS Analytical 
Applications Infrastructure Administration Guide.

The task in the Batch ##INFODOM##_DATA_REDACTION consists of three parameters:

• dataredaction.sh

• true/false

• OFSAA User ID

For more information, see Data Redaction section in the OFS Analytical Applications Infrastructure 
Administration Guide.
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Mapping Roles to User Groups for Data Redaction

Data Controller Group is mapped to DATASECURITYADMIN role:

• Group Code: DATACONTROLLER

• Group Name: Data Controller Group

• Group Description: Data Controller Group

• Role code: DATASECURITYADMIN

• Role Name: Data Security Admin

• Role Description: Data security admin role for executing redaction policies

Mapping from individual applications to DATASECURITY role:

• Role code: DATASECURITY

• Role Name: Data Security Viewer

• Role Description: Data Security Viewer role for viewing original (non-redacted) data.

a. DATASECURITY role must be mapped to those application User Groups which have the privilege to 
view the data in its originality (un-redacted). Therefore, applications must identify the functions which 
must be mapped to the DATASECURITY role. These mappings must come as seeded data.

b. And then, map DATASECURITY role to the respective User groups. This mapping must be done 
manually from individual applications to the DATASECURITY role.

Data Redaction Batch Execution Sample

• Data before executing Data Redaction Batch:

• Data after executing Data Redaction Batch:
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